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SOSET General Information

Welcome to NamoSoft SOSET

SOSET stands for Stamp Order and (type-) Setting. A 
new and revolutionary approach to manage ordering, 
shipping, invoicing and typesetting for the rubber-stamp 
industry. This software is designed, tested and in full 
operation at our sister-company Naammo BV in Venlo 
(The Netherlands) and its subsidiary Stempeltempel BV 
in Amsterdam

Thousands of stamps are produced in this fully 
computerized and "SOSET"-ized company. All 
production is done in the 5 laser-engraver fleet.

In the Stampsterdam-shop a-ready-while-u-wait service 
is offered to the customers.

SOSET is split up into two major parts, the Typeset part 
and the Order part and is based on a powerful database 
under Microsoft Windows in an MS-DOS-operating 
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system. This SOSET version can work both in stand-
alone and multi-user version with the Windows-network 
drivers.

The SOSET for Windows program contains the following 
modules: 

●     SOSET OrderEntry for stamp order management 
including shipping and invoicing (only with the Gold 
version)

●     SOSET Typeset for high-tech typesetting and 
designing

●     the fabulous PageWizard for computerized page 
layout

●     NamoSys utilities
●     NamoKey to control licenses and users

All programs run in a Windows environment. A software 
protection key is needed to legalize the use of the 
SOSET software. NamoKey always has to run, while 
working in any SOSET application. NamoKey starts 
automatically as soon as you start a SOSET program at 
the security station. You will get the following message 
when you have not started NamoKey at the security 
station: "Unable to open the license table". Please run 
NamoKey at the security station and make sure the 
software protection key is connected.
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SOSET General Information

SOSET General Information

Welcome to NamoSoft SOSET

SOSET stands for Stamp Order and (type-) Setting. A new and revolutionary approach 
to manage ordering, shipping, invoicing and typesetting for the rubber-stamp industry. 
This software is designed, tested and in full operation at our sister-company Naammo 
BV in Venlo (The Netherlands) and its subsidiary Stempeltempel BV in Amsterdam

Thousands of stamps are produced in this fully computerized and "SOSET"-ized 
company. All production is done in the 5 laser-engraver fleet.

In the Stampsterdam-shop a-ready-while-u-wait service is offered to the customers.

SOSET is split up into two major parts, the Typeset part and the Order part and is based 
on a powerful database under Microsoft Windows in an MS-DOS-operating system. This 
SOSET version can work both in stand-alone and multi-user version with the Windows-
network drivers.

The SOSET for Windows program contains the following modules: 

●     SOSET OrderEntry for stamp order management including shipping and invoicing 
(only with the Gold version)
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●     SOSET Typeset for high-tech typesetting and designing
●     the fabulous PageWizard for computerized page layout
●     NamoSys utilities
●     NamoKey to control licenses and users

All programs run in a Windows environment. A software protection key is needed to 
legalize the use of the SOSET software. NamoKey always has to run, while working in 
any SOSET application. NamoKey starts automatically as soon as you start a SOSET 
program at the security station. You will get the following message when you have not 
started NamoKey at the security station: "Unable to open the license table". Please run 
NamoKey at the security station and make sure the software protection key is connected.
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OrderEntry Help
To get information select an item in the table of contents.

Table of Contents:

●     General OrderEntry Information
●     Setting up SOSET OrderEntry Software
●     Adding and Editing data
●     Order Status
●     OrderEntry screens
●     File Menu in OrderEntry
●     Edit Menu in OrderEntry
●     Customer/Order/Product Menu in OrderEntry
●     Maintain Menu in OrderEntry
●     Tasks Menu in OrderEntry
●     Reports Menu in OrderEntry
●     View Menu in OrderEntry
●     Window Menu in OrderEntry
●     Help Menu in OrderEntry
●     Toolbar in OrderEntry
●     Statusbar in OrderEntry
●     Shortcut Keys in OrderEntry
●     Miscellaneous OrderEntry Info
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General Information

General Information

The SOSET OrderEntry software fits in perfectly with the SOSET Typeset software. The 
SOSET-software enables one or more persons (multi-user version) to perform typesetting 
and other database-activities simultaneously. In a network any user (provided that they 
have been authorized) can view, modify and check the other user entries.

The unique combination of SOSET's order entry and typesetting software guarantees a 
smoothly progression of your order execution. For it is capable of handling both customer- 
and order information and managing your stamp production, including shipment and 
invoicing.

SOSET OrderEntry is developed for both our and your convenience. It is a highly 
advanced program, which manages apparently effortlessly the entire process: from order 
entry to invoicing. SOSET OrderEntry is easy to use. Just select the various options from 
the menu to introduce customer-, product- and order-information into the databases.

Numerous options are available, like stock-control, statistical information, export to 
financial ledger and spreadsheet. Overview options inform you about e.g. new customers 
or customers with no recent orders, say for the last 30 days. The browse option enables 
you to enter or modify your price-list, discounts, etc. During customer-data-editing you 
can select from several discount, shipping, invoicing- and production-options. There are 
e.g. options for batch-invoicing, direct-invoicing, (quantity-) discount per product- and 
customer-category, shipment and invoicing can be specified per customer and/or 
customer-group. All these default settings can be overruled during order entry. During 
order entry and typesetting you can open several order-, customer-, product- and stamp-
windows to enable customer-service and order handling at the same time.

With the order status-field for each order as well as for each separate order item, the 
SOSET OrderEntry software controls your production process.

Working with SOSET is easy and eases your professional life. The SOSET OrderEntry 
functions as any other order entry program, with the exception that it is completely tuned 
to stamp maker's needs and demands. This makes it suitable for stamp makers all over 
the world. A proven statement!

After clicking the SOSET OrderEntry-icon from the SOSET group, you enter the 
program. The main menu enables you to choose from the order, customer or product 
entry. These three are linked to each other.
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The information you enter is stored in respectively a customer, order and product 
database. You also have access to Databases with information concerning groups and 
options, applicable to customers, orders, products or all three of them. This includes 
databases with regard to customer- and product groups, discounts, print groups, colors, 
taxes, ways of shipment, etc. The contents of these databases can be added, viewed, 
edited or deleted in the appropriate menu item from the Maintain menu.

For adding a new company to the demo-ex(st)ample company, you first have to 
follow the right procedure to Add a Company (see Adding Data for more detailed 
information). 

●     First you enter a customer by selecting Customer from the Maintain menu. Simply 
enter the appropriate data in the customer document.

●     Subsequently you can assign orders to this customer. Selecting Order from the 
Maintain menu can do this. You enter the order screen. Select New from the Order 
menu. The appearing dialog prompts you to enter information, like searchname, 
etc. The OrderID is an important number, since this identifies the different orders in 
your database-table. You also define the product.

●     To view the properties of a certain product, you switch to the product document: 
click the Product option from the Maintain menu to view the Product screen. 
Entering the customer and the product together automatically set the price in 
SOSET OrderEntry.

●     To view the typeset orderitems you select Typeset from the Maintain menu. This 
will open SOSET Typeset. With this option you open Typeset, enabling you to 
maintain the typeset orders in SOSET Typeset. If you want to switch between 
SOSET OrderEntry and a Typeset document, you are advised to use the 
minimized Typeset application window in the Windows taskbar.

Switching to Typeset results in a full-page screen of your typeset stamp(s). All above-
mentioned selections can also be found as buttons on the Toolbar, once you opened 
OrderEntry.
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Maintain Menu in OrderEntry

From the Maintain menu you can select the preferred menu to work in and you can view and 
edit the different groups and options in database tables.

Company
Customer
Customer Groups
Order
Typeset
Product
Product Groups
Chart of Accounts
Shipment
Freight
Payment/Delivery Terms
Discount
Quantity Discounts
Print Groups
Mount
Color
Tax
Payment
Currency
Complaints
Reclaims
Call type
Users
Regions
Category

Company

This option might be disabled. In that case you have to close an open company.
Do this by: File, Close company and next Maintain company. 

The option displays a list of all existing companies and enables you to add, edit or delete an 
new or existing company in the following dialog.
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A company is a single organization, an accounting entity, that handles a set of accounts.  

To add a company you have to enter information concerning: 

●     Companynumber (CompanyID) (has to be unique in a multi-cmpany setup)
●     Company name
●     Address
●     Postal: enter here Zipcode    
●     City
●     Country
●     Phone
●     Fax
●     E-mail
●     Tax code

Check local production if this company will manufacture typeset-products themselves. 
Typesetting will be excluded when you run an order export. In a multi-company setup the 
order will not be shipped anymore; this has obviously been done by the local/branche 
company. This option will set the Done field in the settings of the order-item overview.
Check also host production if this company will NOT manufacture typeset-products 
themselves. Typesetting will be included when you run an order export.
In the cash-customer ID you fill out the customernumber of the customer you set up to post 
all cash-sales. When you choose the option New order, cash order SOSET will automatically 
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use this customernumber. 

Orders via the internet, using Soset-via-the-web, will automatically use the profile of the 
specified Web customer group for new registered customers via the internet.
This needs to be filled out when using SOSET-via-the-web with direct payment options.

With the Logo-option you specfiy the default header and footer to be printed on invoices and 
order documents. 

In the Multy-company section of this dialog you have to specify a few issues to let SOSET 
handle these correctly.
Check the Main-company if this company is the head of all connected companies in a multi-
company setup.
Create synchronize tables will keep synchronize data updated for use in conjunction with the 
Maintain Synchronize option.
Shipment only at this company can be used if the branche companies don't do the shipment. 
This company will ship all imported orders.

After adding a new company-profile SOSET will ask you the following question  
"Do you want a local environment with its own order databases?"  
Choose Yes in case you want to have a separate database for the new company. SOSET 
automatically creates a subdirectory, named on the basis of the entered CompanyID (in 
digits or characters) and the SOSET DataPath refers directly to this subdirectory. 
Choose No if you want to integrate the database of the new company into the one of the 
existing company (or companies).

Now you can select Open company from the File Menu to open this newly entered company.

 

Customer

Switches you to the Customer screen. In the Menubar the Customer menu will appear 

enabling you to maintain the customers. You can also click the C-button,  on the Toolbar 
to switch directly to the Customer screen.

 

Customer Groups
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Displays a list of all existing Customer groups and enables you to add, edit and delete 
customer groups from the database-table. You actually set up a customer-profile, which can 
be used for a new customer.

You enter the Customer group name, and contactperson. Concerning the shipping and 
invoicing frequency and terms, you enter the velocity of order circulation, the way of 
invoicing, freight and tax-conditions. Thereby you select the appropriate DiscountID, to 
enable automatic discounting.
Note that you can select the discount, but you cannot edit it, this is done in the Maintain, 
Disount option.

The Website filter field allows you to specify what products will be shown in SOSET-via-the-
web.
The Company ID field has become obsolete.
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Next to it, you check, if applicable:

●     Quality check: this will print an extra label during shipping and a note on the shipping 
list to catch the attention for qualitycheck

●     Quantity discount: will automatically fill out an extra discount based on quantity. The 
discount is taken from the list as specified via Maintain, Quantitydisount.

●     Invoice to file: to get all invoice-data digitally stored.
●     Order confirm: automatic printing of order-confirmation after order has been entered.
●     No price: this will avoid any pricing or disount information on forms, except invoice.
●     Frist order: not used. (only for a specific situation)
●     Advanced Shipping Notice: will generate a digital form with shipping information.
●     Summarize invoice: will print only order-totals on invoice without product-specs.
●     Proofprint: will send proof of typesetting to customer upon change of typeset-status 

into: corrected. The status will be automatically changed into: hold for answer.
●     Copy currency to customer: enables you to choose if member will use same currency 

as whole group or to use a specific currency for a specific country. (Use this for 
branche-offices abroad)

●     Copy disountID to customer: enables you to specify different discounting within same 
customer-group.

●     Invoice generation at main company: in a multi-company set up, the invoice will not be 
generated in the current company, but when the order has been exported to the main-
company.

In case of any changes, SOSET will ask you if you want to copy the new settings to all 
customers with the same customer group. You have also the option to enforce this with the 
button left below.

The First and Last order field, as well as the Sales info field show results analysed from the 
whole group.

 

Order

Switches you to the Order screen, enabling you to maintain the orders. You can also click 

the O-button,  to switch directly to the Order screen.

 

Typeset
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Opens SOSET Typeset, enabling you to maintain the typeset orders in SOSET Typeset. If 
you want to switch between SOSET OrderEntry and SOSET Typeset, you are advised to 
use the minimised Typeset application window in the Windows taskbar. You can also click 

the T-button,  to switch directly to the Typeset screen. Now you can design the stamps as 
ordered by your customers. SOSET automatically links SOSET OrderEntry and SOSET 
Typeset.

 

Product

Switches you to the Product menu, enabling you to maintain the products. You can also 

click the P-button, to switch directly to the Product screen.

 

Product Groups

Displays a list of all existing Product groups and enables you to add, edit and delete 
product groups from the database-table. The product groupno. is given in successive order. 
You enter the product group name belonging to it. In case of any made changes, SOSET 
asks you if you want to copy the new settings to all products with the same product group.

 

Chart of Accounts

Displays a list of all existing Chart of accounts and enables you to add, edit and delete 
records. You enter the accountID, the relevant description and you select the product group 
belonging to it.

 

Shipment

Displays a list of all existing Shipment options and enables you to add, edit and delete 
shipment options in the database-table. You enter the expeditor number and name, contact 
person, pre barcode, barcode and the accountID. In case you check 'freight' you can enter 
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when no freight should be charged.

Shipper specifications:

SOSET order entry can very well control shipments and in particular find the best and most efficient way to ship 
goods to your customers.
Shipments are automatically combined per order and customer. The total value, volume* and weight are calculated 
by adding all product-item information together.

In the Shipper-dialog you can select and enter the criterions and shipper-specifications.
Click on Maintain, Shipper from the SOSET Order Entry main-menu and choose Add from the selection dialog. The 
Shipper-dialog appears.

The Shipper-ID number is automatically set and you are prompted to enter the Shipper name and Contact. To 
enable printing of the shippers-tracking number on the shipping-label you enter the next available bar code number 
as provided by your shipper.

http://www.namosoft.nl/help/oe_maintain.htm (7 of 14) [10-Jul-2002 11:50:52 AM]



Maintain Menu in OrderEntry

Attention:
These bar codes are mostly a combination of text and a sequential number, enter the text-part in the Pre barcode 
field and the number part in the Barcode field.

In the AccountId field you select the GL-account for the shipping cost charges, in this way the charges will be posted 
to the correct account in the GL-accounting software.
If the Calculate freight checkbox SOSET Order Entry will automatically add an order item to the order with the 
shipping charges. If the shipment for this customers has more than one order, the shipping charges will appear on 
the last order.

Before we describe how the shipping charges are calculated, we will continue with the Shipper-dialog information.

Automatic shipment control:
If you check for Automatic shipping, you instruct SOSET to find the best and most efficient way to ship. In the 
Priority-field you enter a number, where 0 (zero) is the default and highest priority. This means that SOSET will take 
this option, in case other ways to ship give same efficiency or cost-results.
If you check the Calculate minimum value checkbox, you will be prompted to enter a Minimum required value. 
SOSET will not use this shipment-way if the total value is below this criterion.
This is also done for the Minimum volume* and Minimum Weight fields.

The Change shipping address to main address checkbox is to avoid situations, where SOSET finds as best way e.g. 
a courier as shipper company and the P.O. box address is chosen as ship to address. The shipper can not handle 
P.O. boxes and requires street and city information instead.
SOSET will automatically change the chosen option into main address. (This is only done in case both P.O. box and 
Street information in the customer-data file are available; with a ship to address entered during order entry this can 
not be changed, as SOSET does not have more information about the ship to address.)

Calculation of shipping charges:
During a shipment run SOSET order entry will combine all order-items and orders per customer and calculate the 
total value, weight and volume*. However this is only done for products that have the charge freight flag. In the 
customer-data-screen you can also specify whether freight costs should be charged for or not.

In the Freight options table (Maintain, Freight) you enter the charge per From,to weight range. These freight 
charges are used for all shipment ways.
The weight field in the product table is in (European) grams. This can be easily converted to ounces, by using the 
Weight2US option in the NamoUtil, Tools program.

The ‘Save info’ option saves all shipping data to file, actually creating an interface option. This enables you to 
digitally direct such info to your carrier. Please contact us for options to customize this export.

Special situations in relation with SOSET-via-the-web orders:
SOSET-via-the-web charges shipping and packingcosts for customers with a status: Internet-
Customer
Therefore it will not calculate the costs again during the shipping-procedure in SOSET order-
entry!

Language: based on the chosen language during a SOSET-via-the-web session and thus the language-setting field 
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in the customer-table, the shipping and other documents are printed in the chosen language.

* not yet implemented.

More information: 

-Shipment procedure

-Advanced Shipping Notice in SOSET Order Entry

-Shipping interface

-Pre Assigned Box-number

-How do we ship and print delivery notes?

-What does "Check shipment" on an order mean?

-In Order Entry, how do we put jobs in boxes?

-In Order Entry, how do we ship and print delivery notes?

 

Freight

Displays a list of all existing Freight options and enables you to add, edit and delete freight 
options. You can enter the amount of freight that is charged within certain ranges.

 

Payment/Delivery Terms

Displays a list of all existing Payment/Delivery terms and enables you add, edit and delete 
records in the Payment/Delivery terms database-table. The termID. is given in successive 
order. You enter the term, financial export code and check whether it is a delivery or a 
payment term.

 

Discount
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Displays a list of all existing Discount option and enables you to add, edit and delete 
discount records. You enter the discountID, description and select the relevant 
productgroups and the discounts.

 

Quantity Discounts

Displays a list of all existing Quantity discounts and enables you to add, edit and delete 
Quantity discount records. You can enter what discount a customer receives in case they 
order from a certain amount to amount.

 

Print Groups

Displays a list of all existing Print Groups and enables you to add, edit and delete printgroup 
options. The printgroup number is given in successive order. You can attach a printgroup to 
it.

 

Mount

Displays a list of all existing Mounts and enables you to add, edit and delete mount records 
from the Mount-table. The mount number is given in successive order. You can attach the 
appropriate mount to it.

 

Color

Displays a list of all existing Colors and enables you to add, edit and delete Color options 
as records from the Color-table. The color number is given in successive order. You can 
attach a color to it.

 

Tax
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Displays a list of all possible Tax options and enables you add, edit and delete Tax 
options. The tax number is given in successive order. You have to attach a name to it. Next 
to it you enter the appropriate rate and an accountID. 
In case you are not sure of the accountID, you select the Question mark to view all existing 
accountID's.

HOW DOES SOSET HANDLE TAX-OPTIONS FOR VARIOUS SITUATIONS, LIKE 
SHIPPING ABROAD?
In order to handle tax-options within various countries, but also to use correct tax-charge for 
shipment to various countries, states and provinces, SOSET has a few special procedures. 
These procedures are mainly driven by just specifying tax-options for a specific area or 
customer or customergroup. 
From there SOSET internally understands and controls the whole tax-handling in the 
appropriate way. 

SETTING UP TAX SPECIFICATIONS
From the main menu in SOSET Order entry choose Maintain, Chart of Accounts. 
Here you should specify one or more accounts for the various tax-specifications you need for 
your accounting. 
It is (obviously) advised to use the same numbers as you are using in your accounting 
system. 
(You have to specify the fields account ID and description, the other fields are only for 
special situations and not necessary for a basic set-up) 

From the main menu inSOSET Order entry choose Maintain, Tax options. 
If there are no tax-options specified you can add a new option by clicking on Add. 
As there are always situations that you may not or don't have to charge tax, we recommend 
to start specifying an option with description No tax. In this case you specify a rate of 0%. 
Now you can add as many tax-option as you want. 
Note that an ID-number is generated automatically by SOSET. 
Make sure to select the correct accountid for the newly created or edited tax-option. 

In some situations where there are more than one tax applicable, government requires that 
you calculate tax over tax. In that case you check the Calculate tax over tax box. 

TAX SPECIFICATION FOR CUSTOMERS 
In the customer-group table and also in the customer-table you can specify up to 3 different 
tax-options. 
These will be automatically applied for each order you enter for this customer. 

Change the tax-options for a customer group with the option Maintain, Customer group. 
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Make sure that you copy these settings to all customers within that customer group. 
In the same way you can change the tax-options for a customer with the option Maintain, 
Customer. 

TAX DEPENDING ON LOCATION IN CASE OF DIFFERENT INVOICE-TO ADDRESS 
In order to make the option for batch-invoicing in combination with the option for invoice to 
different address (like batch-invoice for multiple branches to head-office) handle tax-options 
correctly, you need to consider the following. 

It is recommended to not combine all branches/customers with different tax regimes 
together, instead you should create multiple customer-groups for each of the various tax-
regimes. 

The reason for this is that in case you specify invoice to another customer, SOSET will take 
the tax-specs of that other customer. That could be incorrect if that customer has different 
tax-specs then the ones applicable for the address where the goods are shipped. 

For this situation a special option, in the Invoice address dialog: Post invoice to CustomerID:, 
has been added to let SOSET overwrite the customerID in the posting to accounting with a 
different customernumber. 

This will make that the final posting in your accounting for all these customer-groups will be 
on the same customerID (the one of the head-office) 

TAX ON ORDERS
There are 2 way orders can be entered into the SOSET order entry. 

1.  Order directly entered in house 
In this case the customer and its location and tax-specs are known. 
SOSET simply takes the tax-options as specified in the customer-settings. 
Only if you specify that the invoice for this order should be send to another customer 
(e.g. head-office), SOSET takes the tax-options as specified in that other customer. 

Note that for each order-item you have the option to unddo the charge for tax by 
unchecking the Tax-option in the Settings-menu in the order-item. This should only be 
done in very specific situations in accordance to the tax-regulations.

2.  Order via web-site
In this case the customer and its location and tax-specs are NOT known! SOSET 
needs to determine what tax(es) need to be charged for that order.Therefore the 
customer is forced to specify country, region, province, state etc. 

SOSET will search for the best-fit address-combination in the customer-group table to 
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find the customer-group with the applicable tax-charges. 

Note that you might need to set-up various customer-groups if you expect orders on 
the web-site from regions with different tax-regimes! You should enter address-
specifications in the new address-dialog in the customer-group.
If the customer-group specs are appliccable for a whole country, you only need to fill 
out the country in the dialog. 
If you have several tax-regimes for various states or provinces you need to enter both 
country and province or state-fields.

 

Payment

 

 

Currency

Note: the values of the various currencies can be automatically uploaded with a special 
procedure in NamoUtil.exe.  
Click here for more information.

Complaints

Reclaims
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Call type

Users

Regions

Category

 

Tables

Displays the NamoSoft FoxPro database-engine which enables you to view and edit the 
SOSET Database Tables. After clicking this menu-item, you enter the 'Open' dialog. In this 
dialog you can open any existing database-file by clicking on its file name here. In that file 
you can view the data, clearly structured, divided in fields, over columns and rows. You can 
seek for a specific item by clicking the Seek-button. Make sure you select an index first, 
before you can start seeking the data fields. You can append information too (if you are not 
in read-only mode). The indexorder of the different fields can be changed. The scroll-down 
bar next to the file name in the Browse dialog shows the various tags, or index fields.

In case you want to browse other tables, you click on the Browse button. That gives you the 
opportunity to view other database-tables at request. The 'Open' dialog appears again. 
Pressing the Close-button returns you to the active working screen.
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File Menu in OrderEntry

Here you find usual Windows-options. However you will NOT find descriptions of options to 
Open, Save or Save as files, as these database (file) management issues are completely 
performed by the SOSET system. New records are automatically sorted into the database. You 
can find them in the database-tables immediately after updating the newly entered or corrected 
orders in the Customer/Order/Product menu.

Open Company
Close Company
Import
Export
Backup
Restore
Print
Print Setup
Preferences
Hotkeys
Send Message

 

Open Company

You select Open Company to open an existing company in your OrderEntry. Once a 
company is opened, you can start viewing, entering and editing data.

This command is only available in the General screen.

More information

 

Close Company

Closes the open company and returns you to the General screen in which no companies are 
open. You do not exit SOSET OrderEntry, you just close the active company, including all 
opened customers, products and orders. If you want to close only the active document (e.g. 
customer, order, product), you click the X-button at the right top of the Order/Customer/Product 
screen (not the upper right of the full OrderEntry screen: you would exit SOSET OrderEntry!).
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More information

 

Import

Allows you to import a file which was created by using Export > SOSET command in the File 
menu.

Important: This options is only available in the OrderEntry Plus version.

 

Export

SOSET can be easily interfaced with other SOSET applications (e.g. at remote locations) and 
also with external order entry and external accounting software. The Export command 
enables the export of order and typeset data for remote ordering and customer invoice data for 
accounting.

These commands are only available when you are available in the Order screen.

SOSET.
Exports a datafile in the Soset-format. Files created this way can be imported with the Import 
command. See OrderEntry Export Filters for more information.

Financial Export.
Exports data in the format you specified in the General Preferences. A dialog will display which 
export format will be used. See Preferences for more information about the export formats.

 

Backup

This command has not yet been implemented.

 

Restore
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Displays the Restore submenu which allows you to restore the last invoice run and the last 
shipment run. Restoring here means that you set everything back exactly the way it was before 
invoicing or shipping.

This command is only available when you work in the Order screen.

Invoice run.
Restores the last invoice run.

Shipment run.
Restores the last shipment run. This command should be used only in exceptional situations, 
when something goes wrong during shipment, like a power outage or a printer fault. Selecting 
the option Restore shipment run results in a set back of order status (from Shipped to Ready 
to ship), freight costs that are removed again. In short: everything will be exactly the way it 
was before the shipment run was started.

Financial data.
When you use the Export command the data files (Invdata.dbf and Custdata.dbf) are removed 
from the Soset-directory and placed in the Backup-dir. This command restores the last invoice 
and customer data (copies the Invdata.dbf and Custdata.dbf back from the Soset\backup-
directory to the Soset-directory. You cannot restore the Financial data after you made new 
invoices (a error message will occur).

 

Print

Displays the Print dialog box, which lets you print the current customer, order or product. In 
case you print an order, the order will automatically receive the status Processed. This 
command enables you to print the current screen, a run card and an order confirmation (in 

case this option is part of the customer data). Shortcut: , CTRL +P

 

Print Setup

Displays the Print Setup dialog box, which lets you set the default printer, papersize and paper 
orientation (landscape or portrait). Refer to your Windows documentation for more information 
about printer settings.
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Preferences

Displays the Preferences submenu in which you can change the default settings in SOSET 
OrderEntry. Select and set the standard attributes of all future orders to customize OrderEntry 
your own requirements. Each time you enter a new order SOSET OrderEntry will start with 
these settings. However you can always change these settings for each separate order.

Printers.
Displays the Printers dialog box which enables you to can set the standard attributes of all 
future print actions. Each time you print some data SOSET OrderEntry will start with these 
settings. However you can always change these settings. You can select which printer you 
want to print your order, run cards, packing lists, labels and overviews. 
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●     Use printerfont Font you want to use the standard settings of your printer.
●     Show Printbox should be unchecked with e.g. the overview printer to avoid that you 

have to click OK for each page ready for printing.
●     Portrait or landscape refers to the page orientation. Portrait is a term used to refer to 

vertical page orientation. Landscape refers to horizontal page orientation.
●     Overview Printer allows you to set the text compression in the Printer preferences, in 

order to make space for all text. The default compression factor is 80%. You can change 
this percentage in case you need no or more compression. Remember that when you 
turn the text compression off, this means that texts that do not fit on one textline, might 
be divided over more textlines.

●     Order Printer allows you to select whether you want to print on Preprinted paper or 
what kind of Header and Footer you prefer. A header appears at the top of every page. 
A footer appears at the end of every page. You enter a logo as header or footer. Simple 
browse the options in your logo-subdirectory. With the values for Position X and 
Position Y you enter the start position of the header or footer.

●     For the Run card printer, you also have to decide how many run cards you want to print 
per page.

●     In the Label printer sets additional information concerning the positioning, sizing and 
margins of the labels on page, you click the More button in the Label printer dialog. The 
number of Columns refers to the number of labels you want to print next to each other. 
The number of Rows refers to the number of labels you want to print vertically on a 
page. With the value for Start X and Start Y you enter the start position of the 
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labelprinting (from the upper left of the page). The left margin indicates where to start 
printing from the left side of the label.
With the value for Delta X you set the horizontal whitespace between the labels to print. 
With the value for Delta Y you set the vertical whitespace between the labels to print.

●     OPOS printer is for special form layout when you use a so-called thermal printer for 
printing small and endless paper.

Remote/Host.
Displays the Remote/Host dialog box which enables you to set block ranges of ordernumbers 
for remote customers to avoid double ordernumbers.

Just enter the Range of numbers, by filling out the lowest (minimum) number and the highest 
(maximum) number. Remote customers will automatically receive a number between the two 
entered numbers. However you can always change the number for each separate remote 
order.

Internal.
Display the Internal Preferences dialog box in which you can set the last used invoice number 
taken into account the importance of this data. This option is pincode protected.

General.
Displays the General dialog box in which you can set the standard attributes of all future orders 
to your own requirements. Each time you enter a new customer or order SOSET OrderEntry 
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will start with these settings. However you can always change these settings for each separate 
order. The following options are available:

 

●     DataPath displays where all stamp-data is stored in your system. Make sure that in a 
network all SOSET users have the same setting shown here. This path cannot be 
changed here, it is the first parameter of each SOSET program command-line

●     Ruler units enables you to select inches or millimetres.
●     Days in sets the standard speed of the order flow. The shipping date is the order date 

plus days in. On creating a new customer, the speed of the orderflow entered in this 
General Preferences-option, will automatically be the standard days in, before an order is 
shipped.

●     Mount sets the standard color of the products. On creating a new customer, the mount 
entered in this General Preferences-option will automatically be the default mount.

●     Color sets the standard color of the products. On creating a new customer, the color 
entered in this General Preferences-option will automatically be the default color.

●     Shipment sets the default way of shipment of the orders.
●     Embargo sets limits to the number of days an orders is outstanding but the credibility 
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status of a customer remains OK. In case of customers that have orders outstanding, for 
as long as e.g. 60 days, the status of those customers changes from OK to Embargo.

●     Tax 1-3 are the default tax-options for each new entered customer.
●     AccountID will be allocated to those sales, in case of products that have no attached 

accountID. You can set here the default AccountID of debtors. In case of customers with 
a discount on the total invoice amount, this discount total stands in the books at a value 
of the here entered Account ID of invoice discount.

●     No freight above sets the order amount be which you no longer charge freight.
●     C.O.D.-charge costs you charge when you send goods cash on delivery.
●     Financial Export Filter enable you to use OrderEntry data for the use in order progams. 

The following export filters are available
❍     General

Exports data in a General Ledger format. The datafile is written in a so called CSV-
form via a SOSET-GL-filter.
Customers are per definition exported to: 
Drive\DATA\SOSET\EXPORT\CUSTDATA.TXT. This file is a data dump of the 
Custdata.dbf table.
Invoice data are per definition exported to: 
Drive\DATA\SOSET\EXPORT\INVDATA.TXT. This file is a data dump of the 
Invdata.dbf table.

❍     KHK
Enables you to export financial data via a GL-KHK filter. Customer-data is 
automatically exported to Drive\DATA\SOSET\EXPORT\FIN_CUST.DIF. Invoice 
data is exported to Drive\DATA\SOSET\EXPORT\FIN_INV.DIF.

❍     AFAS
Enables you to export financial data via a GL-AFAS filter.
This option is not available for all SOSET customers.

❍     HS
Enables you to export financial data via a HS- Hamburger Software filter.

❍     SAGE
Enables you to export financial data via a GL-SAGE filter.

❍     AccPac
Enables you to export financial data via a GL-AccPac filter.

❍     Carat
Enables you to export financial data via a GL-Carat filter.

❍     Sigec
Enables you to export financial data via a GL-Sigec filter.

❍     QuickBooks
Enables you to export financial data via a GL-QuickBooks filter.

Note: CSV stands for Comma Separated Value. A CSV file, is a file where the different 
fields, or identification keys of an order or customer, are separated by commas. This 
enables the import of these data into most database, spreadsheets or accounting 
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software.

Next to these export files (invoice data and customer data) you will get a bookkeeping 
report (The columns are respectively: Invoice runno., Date, Invoice no., Customer no., 
Account GL, Description, Debet, Credit). You also get a list of invoicable orders 
(Columns are respectively: Orderno., Customer, Invoice to, Shipping date, Order status, 
Reference, Netto -Total-.) and a tax-report.

All default settings can be overruled during OrderEntry.

 

Hotkeys

Not yet implemented.

Makes data entry easy and quick. When you select this option a list with pre-defined Hotkeys 
appears. You can add, edit and delete hotkeys in this dialog box. You simply enter often used 
words and texts, in combination with a key or key-combination. This way you can define text by 
default.

During text-edit you can enter the pre-defined key or key-combination plus a space and 
SOSET will replace this entry with the pre-defined text. When you select this option a list with 
pre-defined Hotkeys appears, you can add, edit and delete hotkeys.

Be advised to use combinations of keys e.g.: @w for Washington, so unintentional use of the 
hotkeys is limited.

 

Send Message

Not yet enabled.

Communication is very important in the rubber stamp industry. In SOSET it is possible to send 
messages to users in the network. SOSET offers a very easy and efficient way to mail users, 
known in the SOSET user-table. Just click the Send Message command, select the user(s) in 
the network you want to mail and enter the message.

All SOSET software checks the mailbox and warns the logged user(s) when there is mail. 
When the user is not logged in, the mail remains in the box and will appear during next login of 
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this user. Mail in the mailbox can only be deleted by its user. This function is similar to the 
Send Message command in SOSET Typeset and SOSET PageWizard.
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Adding and Editing data

Add or Edit a Company
Enter or Edit Customer data
Enter or Edit Product data
Enter or Edit orders
Typeset a stamp
Shipping orders
Invoice orders
Invoice
View reports
Building a query
Printing data
Working with Barcodes
Archive orders
Typeset Information

 

Add or Edit a Company

After selecting the Company option from the Maintain menu, you view the existing 
companies in a dialog. You can choose to add, edit or delete a company.

To create a new company, you click Add, in case you want to edit company data, select a 
company and click the Edit button. The company dialog box will appear.

http://www.namosoft.nl/help/oe_enter_data.htm (1 of 22) [10-Jul-2002 11:50:57 AM]



Adding and Editing data

Most of the data fields are self-explanatory.

CustomerID cash order.
When you add an order-item to an order and you are not in the order edit mode the customer 
you specify here is selected. If you leave this field blank you first have to enter the customer 
before entering an order-item.

Enter company data and close the new company. On closing, SOSET will ask you the 
following question "Do you want a local environment with its own order databases?" 
Choose Yes in case you want to have a separate database for the new company. SOSET 
automatically creates a subdirectory on the basis of the entered CompanyID (in digits) and 
the SOSET DataPath refers directly to this subdirectory. Choose No if you want to integrate 
the database of the new company into the one of the existing company (or companies).

You can delete a company. However, this option should be used with care! In case you 
delete an existing company, you only delete the company data, not the customers, orders or 
products.

After adding a new company to the SOSET OrderEntry system, you can select Open 
Company from the File menu and open this newly entered company (when you use more 
than one company, you have to select a company when you start OrderEntry).

Note: You can only open one company at the time so if you want to open a new company, 
you have to close the active company first.

The SOSET software comes with product databases with necessary basic information. There 
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is no need to change this information. However if you want to add products, make sure you 
have created product groups and account ID's to enable updating your new product. So 
basically the first thing to do is to enter customers. However, before you can do so, you have 
to enter some basic information.

First you have to create (that is: enter) customer groups, discount options, product groups, 
account ID's, way of shipment options, tax options, and term options. These options are all 
very specific to your company. You will see that NamoSoft SOSET already provides several 
common and general mount options, color options and printgroups.

Select the appropriate option from the Maintain menu in SOSET OrderEntry and click Add 
to add new records. The File menu has import- and export options, to enable you to import 
data from the databases of the existing Demo Company or any other database.

After this, you switch to the Customer screen. Now you can select the New command from 
the Customer menu.

 

Enter or Edit Customer data

After selecting Customer from the Maintain menu or click the C-button,  on the Toolbar 
you enter the Customer screen. 

Data entry in the Customer screen.
The browse arrows on the Toolbar enable you to view all entered customers that have been 
saved in the SOSET database. To create a new customer select the New command in the 

Customer menu(shortcut: , Ctrl + F8). The following question appears on screen: "Do 
you want to add a new customer?" If so, choose Yes.

SOSET provides you with a successive customerID. You are prompted to enter a 
customergroup (these groups and its settings can be viewed, edited and deleted with the 
customergroup command in the Maintain menu).

You assign a customer group to the new customer, by selecting one of the existing customer 
groups. In case you want to copy customer group data to the current customer, choose yes 
on the question "Copy customer group settings?"

While editing a customer you can search for another customer by clicking the C-button,  
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on the Toolbar. Now, you can edit one customer and view another one. Switching between 
them is possible by using the cascade or tile options from the Windows menu. The number 
of customers to view is kept limited on purpose, to avoid confusion.

In case you want to close a customer, you click the X-button on the right of the customer 
screen (not on the upper right of the SOSET OrderEntry screen, which will close OrderEntry 
completely!).

You can go to the other fields in the screen by using the Tab-key.

The customer information contains information about: 

●     Customer name
●     Main address and Mail address (both consisting of address, postal, city, state and 

country) After entering the main address you can go with the Tab-key to the mail 
address. In case this is the same: simply Tab through the fields. The same address as 
filled in as main address, will appear.

●     Telephone number
●     Fax number
●     E-mail number.
●     Next to the customer name and customer group, you can enter one more name for 

your customer: Customer name 2.
●     Contactperson, which is valuable information to enhance your customer service in 

case of questions or problems.
●     Salesman (by default the name of the person who enters the customer in the 

computer, but all registered usernames can be filled in here).
●     Searchname is the same as the first six positions of the entered Customer name.
●     Search city is the same as the first six positions of the entered Customer city. 

You can check the following options: quality control, no price on forms, order confirmation, 
quantity discount and invoice to file.

The (credibility) status of a customer can be viewed and adjusted when necessary. Enter the 
appropriate discountID (with its belonging properties), you subsequently can view after 
pressing the More-button. The preferred freight option has to be entered here. 

On updating your customer, SOSET asks you to verify the discountID.

Now you can assign an order to this customer, by clicking Order from the Maintain menu).

More button.
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This button opens a dialog box in which you can enter or view information concerning Terms, 
Typeset, DiscountID groups, SalesInfo (including order entry history) and when order will be 
shipped (Shipping every ...-day)

You can view the various payment/delivery terms, like the Chamber of Commerce number, 
the taxes, the credit terms and credit limit. You also can view the various discounts, per 
product group.

Next to it, you can enter some default typeset information, concerning what mount and what 
color the customer prefers. Information is given concerning the total sales (history and 
present) and the first and last order until now. You also have to enter the shipping frequency 
here by checking the shipment days in the 'Shipping every' section. You can enter here 
information about: the way of shipment, and the way of invoicing to ensure a smooth order 
flow.

Invoicing button.
This button opens a dialog box in which you can enter information concerning the way of 
invoicing. You can select the preferred Invoice address. You have the option to send the 
invoices to the mail address of your customer, to the mail address of an other customer, or 
you can enter the invoice address here. Furthermore you can select from different Invoicing 
options and you can determine the Invoice frequency.

 

Enter or Edit Product data

SOSET is standard being supplied with a great number of pre-defined products, that can be 
viewed as single records, one by one, with the Browse arrows on the Toolbar in the Product 
screen (select Product from the Maintain menu). This means SOSET provides examples 
and database-files with a basic setup and a lot of product information about selfinkers, pre-
inked stamps and other stamp products.

In case you want to edit, add or delete products or its properties, you are free to do so. 
However, make sure that your information is correct and consistent to avoid confusion! The 
data-entry will be considerably facilitated in case you decide to let SOSET copy all product 
group settings to your new product.

To enter a product, you must be in the product screen. To get there select Product from the 

Maintain menu. Another option is that you push the P-button,  on the toolbar.
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Data-entry in the Product screen.
The browse arrows on the Toolbar enable you to view all entered products. You can enter a 
product by using the keyboard shortcut CTRL +F8 from the Product screen. You can also 
select the New option from the Product menu or the New Product button on the Toolbar.

While editing a product you can search for another product by clicking the P-button. Now, 
you can edit one product and view another one. Switches between them can be achieved 
made by using the Window options to cascade or tile the open windows. The number of 
products to view is kept limited on purpose, to avoid confusion.

In case you want to close a product, you click the X-button on the right of the Product 
screen (not on the upper right of the SOSET OrderEntry screen!). The Product screen gives 
you a full screen view of all product info. You can go to the other fields in the screen by using 
the Tab-key.

You are prompted to enter the ProductID first. Next to the productID, you enter the product 
description. Defining a product searchkey facilitates retrieving the product from the database-
table. Assigning a customer group to a certain product enables you to adjust the settings of a 
product to the special wishes of your customer.

You assign a product group to the new product, by selecting one of the existing product 
groups. In case you want to copy the product group data to the current product, choose yes 
on the question "Copy product group settings?". The print group has to be entered here.

The following options have to be checked, if applicable: Typeset property, charge freight, pad 
color, mount, discount, quantity discount and discontinue.

You also have to enter the following numbers: the supplierID, the purchaseID, the 
warehouseID, and the statisticsID.

You can search for and subsequently enter the appropriate accountID and its description.

The number of products in stock and the total amount ordered is given. The reorderlevel is 
being displayed. This refers to the following. As soon as this entered number of products in 
stock is touched you have to reorder. You can also enter the pagenumber of your catalog the 
product can be found.

Based on the fact that it is very difficult to keep inventory information in most rubber-stamp 
companies up to date, we have implemented the Cycle Count option. In the Cycle Count 
field in the product-data-screen you enter the date on which you counted the inventory of this 
product. It is advised to count critical products more often.
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On a regular base you can create a query, which filters products counted before X date e.g. 
In that way you keep the inventory information in SOSET's order entry screen on a very 
reliable level.

Important: When the reorder level is set to zero (0) the number of products in stock is NOT 
being updated when this poducted is ordered

Pricing can vary from price 1 till price 5; in other words there are five pricelists to choose 
from. The product width and height, as well as its shape, its thickness and its weight 
complete the product information.

The More button shows the total sales information of the active product (history and present), 
the total amount of products sold last year and this year, and the first and last order.

The Date area button informs you about whether or not the active product has a date area 
and its height and width and it gives the coordinates of the default position in the stamp.

 

Enter or Edit orders

After selecting Order from the Maintain menu, you enter the Order screen. You can also 

click the O-button,  on the Toolbar.

The browse arrows on the Toolbar enables you to view all entered orders. You can press 
CTRL + F8 to create a new order, select the New option from the Order menu or click the 

appropriate New Order button, .

While editing an order you can search for another order by clicking the O-button,  on the 
toolbar. Now you can edit one order and view another one. Switches between them can be 
achieved by using the Window options to cascade or tile the open windows. The number of 
orders to view is kept limited on purpose, to avoid confusion. In case you want to close an 
order, you click the X-button on the right of the Order screen (not on the upper right of the 
SOSET OrderEntry screen!).

To enter an order select CTRL + F8, from the Order screen in SOSET OrderEntry (this 
screen appears after selecting Order from the Maintain menu. Another option is that you 

push the O-button,  on the toolbar. You can select the New option from the Order menu 
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to assign a new order to a customer or the New Order,  button on the toolbar. On your 
screen the SOSET New Order dialog box appears.

In here you can enter the Customer number, that you want to assign a new order to and view 
the Customer name (and its credibility), the telephone number and the fax number. In case 
the displayed customer is not the appropriate one, you can select the last or the next 
customer in your database. You can also click the question-mark. Now you can start a 
multiple search on customer number, customer searchname, customer city, postal code and 
customer group. Next, you enter the order.

A number of options are set in the Customer screen or Product screen. However in the Order 
screen, you can overrule all these options. Check the following boxes on screen if they are 
applicable: No price on form, Order confirmation and Quality check.

You can select the field in the Order screen using the TAB-key.

You need to specify information about the order. You are prompted to enter the ordernumber 
first. At that position you can also leave the ordernumber SOSET provides you with. 

Next you may enter references to ease tracking of the order during production. In the 
Reference field you can enter precise information, regarding: reference 1 and reference 2, 
order number, productID, Department, WarehouseID, and by whom the order (product) has 
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been purchased. Reference 1 and reference 2 will be displayed on the printed order forms.

Order date and Shipping date are automatically filled in. The order date is the present-day 
and the Shipping date depends on the settings, set in the Preferences from the File menu. In 
case you enter a different date, indicating that the order should be rushed, SOSET 
automatically changes the rush code into the appropriate code. In Typeset rush stamps have 
either a red (rush 24 hours), an orange (rush 48 hours) or a yellow (rush) border on screen.

The information entered in the internal memo field is for internal use only. You can enter 
important messages concerning the current order to other SOSET users, for instance to 
draw extra attention to certain order(item)s. The information entered in the external memo 
field will be displayed on the run cards as info.

You add orderitems to the current order by pressing CTRL + A. The orderitem box shows 
from left to right: the orderitem number, the productID, the quantity, the product description, 
the price, the discounts and the net price.

You enter the ProductID (defined in the Product entry screen and saved in the Product 
database table). If you do not know the appropriate code you select the question-mark next 
to the ProductIDfield. The product-information of all products is subsequently being displayed 
in a dialog. Just enter a productID in the appearing box. You can also browse through the 
Product table with the Browse buttons, under the ProductID field.

If the required product is not listed, you can enter new product-information via the Browse 
Tables option from the File menu in the SOSET Namosys program or in the Tables option 
from the Maintain menu in the OrderEntry program. This list with product-information 
specifies your order information as well as your stamp-design. Once filled out, you leave the 
box by clicking the OK-button.

When you later decide to change the ProductID in SOSET Typeset, SOSET Typeset asks 
you explicitly whether you want to replace the current size with the size of the product 
chosen. This in order to avoid unintentional changes of the text features. You have to take 
notice of the fact that the productID is the same in the OrderEntry and Typeset.

After your selection, the properties of the product appear in the dialog and become the basic 
properties for your current stamp design. Some of these settings may be modified or require 
your choice from e.g. available colors. Enter the required quantity. In the dialog you can 
select the color and the type of mount of the stamp you want to design. You can check 
Freight (in case freight costs have to be charged) and Typeset (in case it is a Typeset 
product, but the latter is already done automatically. The Discounts are numbered from 1 
through 3: %1 = the discount dependent on customer, %2 = for additional discount options 
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and %3 = Quantity discount.

Save and update the order by pressing CTRL + F10 or pushing the update button,  on 
the toolbar. This will store all data in the database-table.

After entering (a number or all of the) orders, you select the option Process entered orders 
from the Tasks menu in the Order screen to start the order/production process. Note that the 
orderstatus changes from Entered to Processed.

If you want a hard copy of the current order, select from the File menu the Print-option. This 
print option enables you also to print an order confirmation and a packing list for the active 
order.

 

Typeset a stamp

In case you have entered an order that has typeset orderitems, you can switch directly to 
SOSET Typeset to design the stamp(s). SOSET OrderEntry is directly linked to SOSET 
Typeset. Immediately after updating an entered order with typeset items in SOSET 
OrderEntry, you can find this order in Typeset. By pressing the Typeset button on the 
toolbar, you open SOSET Typeset. If you want to switch between. OrderEntry and a Typeset 
document, you are advised to use the minimised Typeset application window in the Windows 
taskbar.

With CTRL + F3 you can find an order on ordernumber. The stamp will be displayed on 
screen as defined during order entry.

In Typeset you can choose between editing the stamp from scratch or designing the stamp 
with the DesignWizard. To edit a blank stamp: press CTRL + F9. This will allow you to 
typeset the stamp using all the parameters you have first entered along with default 
typographical settings. You can modify the size (read net design-area) of the stamp. During 
page-design (for final output). In case you want to modify the size of a stamp, you should 
consider whether the selected product offers enough space for the desired size. A selfinker, 
of course has limitations to the size of the stamp. You can also decide to let the 
DesignWizard design your stamp. In that case select the DesignWizard button on the 
toolbar.

In case of an attachment, that means a customer has send you for instance a mount 
together with the order, you have to mark Attachment in the Order item dialogbox in 

http://www.namosoft.nl/help/oe_enter_data.htm (10 of 22) [10-Jul-2002 11:50:57 AM]



Adding and Editing data

SOSET Order Entry. In SOSET Typeset the 'attachment' property will be checked as well. 
SOSET will notify you by printing 'attachment' on the run cards.

The typeset status can be viewed in the orderitem box in the SOSET OrderEntry. Each 
typeset partnumber has its own typeset status.

After designing and updating a stamp in SOSET Typeset, the status of the stamp becomes 
Entered. After designing several stamps, you start the SOSET PageWizard and select the 
Get all entered stamps option from the File menu in PageWizard. All stamps subsequently 
are laid out on a page on screen. You can view the contours only, or view a stamp or all 
stamps with its text and design.

After printing the stamps, the status Proofreading will be assigned to all printed stamps. 
Next you return to SOSET Typeset and correct (if necessary) the stamps with the status 
Proofreading. After manually attaching the Corrected status to these stamps in SOSET 
Typeset, you switch to SOSET PageWizard again. Now you select Get corrected stamps 
from the File menu in PageWizard. Again the stamps are laid out on page. You can change 
this layout, but this is not necessary, since SOSET PageWizard is designed especially to 
make page layout as efficient but also as simple and time saving as possible. SOSET asks 
you to change the status from Corrected to In production. Production can start now by 
printing or laserengraving the page(s) with stamps. Run cards or a production-list can be 
printed to ensure an efficient orderflow.

Refer to the SOSET Typeset manual or on-line help for more elaborated and detailed 
instructions concerning the usage of SOSET Typeset.

 

Shipping orders

For efficient shipping you are advised to store ready stamps in bar coded boxes along with 
the run cards.

In the Customer screen you can enter the preferred way of shipment. Behind the More 
button you can enter the shipping days and the delivery/payment terms.

In the Order screen you select the button Shipment: This button opens a dialog box in which 
you can select the Shipping address (name, address, postal, city and country). You have to 
check whether this address is the mail or main address of the customer or the mail or main 
address of another customer. You can also enter a shipping address. Furthermore you have 
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to enter the Way of shipment and the Shipping tracking number. The option 'Best way' as 
way of shipment, lets SOSET decide what way of shipment is the best way, depending on 
weight, order amount, etc.

With the General preferences from the File menu you open the General Dialog box in which 
you can set the following shipment defaults. You can enter the days in, referring to the 
standard number of days between entering an order and shipping it. Enter the preferred way 
of shipment. You can set at what order amount you no longer charge freight. The C.O.D.-
charge refers to the costs you charge when you send goods cash on delivery. 

All settings can be overruled per customer or order.

Shipment.
The Change Status into In Box option from the Tasks menu enables you to change the 
status of order-items into In Box and will print a list of all items.

You enter the OrderID and partnumber and the Box number As soon as all order items are 
reported In box, the order is ready to ship. Simply scan (or manually enter) both barcode on 
the box and the run card. The status in the computer now reads In box and if the entire order 
is completed (including all orderitems): Ready to ship.

Use this option even when you do not use bar-coded boxes. The shipping list will not only 
show customer and orderinformation, but also the boxnumber in which the products are 
stored.

With the Change Status into Ready to Ship option, you can change the status of order-items 
from In box into Ready to Ship. A list will be printed of all relevant items. In the appearing box 
you enter the shipping date and whether you want information about the large shipmentrun 
or the small shipmentrun. The large shipmentrun includes all orders that have been entered 
and should be shipped at one time or the other. Last mentioned list will include all rush 
orders. A list of forgotten rush orders is printed as well. The small shipmentrun includes only 
the orders that are ready to ship.

In other words: the first refers to the orders that have to be shipped. The latter refers to the 
orders that can be shipped (are ready for shipment).

The shipping list will not only show customer and orderinformation, but also the boxnumber 
in which the products are stored.

With the Change Status into Shipped option from the Tasks menu, you can change the 
status of order-items from Ready to Ship into Shipped and a list of all relevant items will be 

http://www.namosoft.nl/help/oe_enter_data.htm (12 of 22) [10-Jul-2002 11:50:57 AM]

http://www.namosoft.nl/help/oe_tasks.htm


Adding and Editing data

printed.

The shipping list will not only show customer and orderinformation, but also the boxnumber 
in which the products are stored.

With the File menu Restore option Redo Shipment run, you can redo a shipment run. this 
option should be used with care and only in those situations were something went wrong 
with the shipment. Examples are a power outage or a printer fault, so that the shipping list 
could not be printed

Selecting the File menu Restore option Redo shipment run results in a set back of order 
status (from Shipped to Ready to ship), freight costs that are removed again. In short: 
everything will be exactly the way it was before the shipment run was started.

All stamps are sorted per order and per customer-number. If the stamp is only part of an 
order, SOSET waits for the order to be completed, before listing it as In box. It is only then 
that these orders are labeled with the Ready to ship status.

Now you can start packing with help of the shipping list. Selecting the option Print shipping 
list will produce a list with shipping information, including the scanned box numbers, weights 
and other key production information.

Once the orders are packed and ready to ship, you can change the status of all Ready to 
ship orders to Shipped. In order to do so, select the Change Status from Ready to ship into 
Shipped option from the Tasks menu in the Order screen. Now invoicing can begin.

In case the shipping/invoice address is unknown, SOSET will print 'Address unknown' on all 
documents (packing lists, invoices, run cards, etc.) to alert you to this situation.

Special situations in relation with SOSET-via-the-web orders:
SOSET-via-the-web charges shipping and packingcosts for customers with a status: Internet-
Customer
Therefore it will not calculate the costs again during the shipping-procedure in SOSET order-
entry!

Language: based on the chosen language during a SOSET-via-the-web session and thus the language-setting field 
in the customer-table, the shipping and other documents are printed in the chosen language.

More information.
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Invoice orders

In the Customer screen you can determine the default invoicing procedures per customer. Choose one of the 
invoicing options. You can select between 'Batch invoicing' and 'Direct invoicing'. Both options enable you to choose 
between '1 order per invoice' and 'All orders on the same invoice'. You can also select 'Shipment invoicing'. That 
means you want the invoice to accompany your shipment. Here you can choose between: '1 order per invoice', 'All 
orders on the same invoice' and 'Cash on delivery'. Finally you can select 'Cash order' as invoice procedure.

You have to enter the invoicing frequency yourself. You can choose between '1 day', '5 days', '10 days', '15 days', 
'30 days', '45 days' and '60 days'. The frequency number is merely a way of grouping orders for invoicing and 
doesn't have anything to do with a daily, weekly or monthly invoice routine (thus the frequency numbers does NOT 
specify "end of the week" or "end of the month" invoicing). Every time you start an invoicing session, SOSET 
invoices orders with the same invoice frequency altogether.

The financial status of a customer can be viewed in the Customer screen. You can choose between OK, Embargo, 
Credit hold, Shipping block, Order block, Check with accounting, and Closed.

Behind the More button you should select the payment/delivery and credit terms. The button Invoicing opens a 
dialog box in which you can enter information concerning the preferred invoice address. You have the option to send 
the invoices to the mail address of your customer, to the mail address of another customer, or you can enter the 
invoice address here.

In the General preferences from the File menu, you can set the following standard information. The C.O.D.-charge 
refers to the costs you charge when you send goods cash on delivery. With the number of days you enter behind 
Embargo you set limits to the number of days an invoice is unpaid, but the credibility status of a customer remains 
OK. In case of customers that have orders outstanding, for as long as e.g. 60 days, the status of those customers 
changes from OK to Embargo. The default Account ID will be allocated to those sales, in case of products that have 
no attached account ID. You can set here the default Account ID of debtors.

In case of customers with a discount on the total invoice amount, this discount total stands in the books at a value of 
the here entered Account ID of invoice discount. All defaults can be overruled per customer or order.

In the Order screen you click the Invoice button to enter the invoice address and invoicing procedure and you can 
determine the invoice frequency in case of any differences from the default invoice information of your customer.

In case the invoice address is unknown, SOSET will print 'Address unknown' on all documents (invoices, packing 
lists, run cards, etc.) to alert you to this situation.

Invoicing
You have entered the preferred invoicing procedure in the Customer menu.

In general it goes that, once the orders have the production status Shipped, they then have the invoice status 
'Ready to bill', using one of the Invoice options from the Tasks menu in the Order screen from your OrderEntry.

As mentioned above you can choose from several invoicing options. You can start invoicing even as soon as the 
orders are Ready to ship. In order to do so, you have to select Shipment invoicing as preferred invoicing option in 
the Customer screen. In case you want to ship an invoice next to a packing list with the stamps/order to your 
customer.
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In the Tasks menu you can select an invoicing option to invoice your orders and receive printed proof of it at the 
same time.

You can invoice only the current order, or you can invoice all orders.

When you invoice the current order or all orders (with the Invoice status 'Ready to bill'), the orders receive the 
invoice status 'Invoiced'. An invoice will be printed next to the SOSET OrderEntry invoicable orderlist and the 
SOSET OrderEntry Sales journal. The SOSET invoicable orderlist gives an overview of all orders to be invoiced. 
The SOSET OrderEntry Sales journal is the report you use for your accounting system.

In case you invoice all orders you can choose between batch invoicing and direct invoicing. With the Batch invoices 
option you can choose to invoice and print only the batch invoices. In the dialog you select the invoice frequency. 
This is the preferred number of days between invoices can be sent to your customer.

Every time the bookkeeper starts an invoicing session, SOSET OrderEntry will involve only those orders with an 
invoicing frequency between the time interval of the actual invoicing.

With the Direct invoices option you can select to invoice and print the direct invoices. Now you choose to have all 
orders invoiced and printed with the label Direct invoicing, that means invoicing procedures are done every time an 
invoicerun is performed.

You also can invoice and print the invoices of either all customers or on CustomerID or on Customer group. You can 
search on customer(group) and customer(group) ID. Clicking the OK-button, starts the invoicing and printing 
process.

In case you want to start batch invoicing, but there are also orders that acquire direct invoicing SOSET gives the 
following message: "There are invoices to invoice direct. Please invoice these first."

With the Print Invoices option from the Tasks menu in the Order screen, you can print invoices On Invoice run or 
On Invoicenumber. For information concerning the contents of an invoice

The option Update history is to be used after an invoice run to keep all sales information up-to-date.

In case you need to Restore an invoice run, you select the General File menu Restore option (only available in the 
Order screen). Selecting this option will put everything back exactly to the way it was before you started invoicing.

 

Invoice

Your invoice contains the following information:

Invoice address, if known to SOSET, otherwise you will find here 'Address unknown'.

Invoice number, the customer number, and the date of invoice.

http://www.namosoft.nl/help/oe_enter_data.htm (15 of 22) [10-Jul-2002 11:50:57 AM]

http://www.namosoft.nl/help/oe_tasks.htm


Adding and Editing data

Products, the Number of ordered products, Poduct description, the price, discounts, and the amount per order line. 
These are given per ordernumber, with the charged freight costs.

Subamount (exclusive taxes) is calculated as well as of course the total amount (including taxes).

Finally, the applicable terms are stated.

In case of more than one page, the total amount will be automatically transported to the next page.

 

View reports

SOSET OrderEntry enables you to take a (over)view of your orderflow through extensive report options. SOSET 
reports on your customers and your orders.

There are options to get a full report of your customers and your orders.

In the Reports menu in the Order Screen you have the following order report options.

Rush Orders.
Prints a report of rush orders. In the Overview rush orders dialog box that appears after selecting this option you 
are prompted to enter information. You have to specify the range concerning: CustomerID, Date, AccountID and 
ProductgroupID. This includes the length of time. Furthermore you have to decide whether you want to print all 
orders or only the rush orders and if you want to have a full or brief type of list.

Production control.
Prints a report of the production control. In the Overview production control dialog box that appears after selecting 
this option you are prompted to enter information. You have to specify the range concerning: CustomerID, Date, 
AccountID and ProductgroupID. Furthermore you have to decide whether you want to print all orders or only the 
rush orders and if you want to have a full or brief type of list.

Shipped orders.
Prints a report of shipped orders. In the Overview shipped orders dialog box that appears after selecting this 
option you are prompted to enter information. You have to specify the range concerning: CustomerID, Date, 
AccountID and ProductgroupID. Furthermore you have to decide whether you want to print all orders or only the 
rush orders and if you want to have a full or brief type of list.

Entered orders.
Prints a report of entered orders. In the Overview entered orders dialog box that appears after selecting this option 
you are prompted to enter information. You have to specify the range concerning: CustomerID, Date, AccountID and 
ProductgroupID. Furthermore you have to decide whether you want to print all orders or only the rush orders and if 
you want to have a full or brief type of list.

Outstanding orders.
Prints a report of outstanding orders. In the Overview outstanding orders dialog box that appears after selecting 
this option you are prompted to enter information. You have to specify the range concerning: CustomerID, Date, 
AccountID and ProductgroupID. Furthermore you have to decide whether you want to print all orders or only the 

http://www.namosoft.nl/help/oe_enter_data.htm (16 of 22) [10-Jul-2002 11:50:57 AM]

http://www.namosoft.nl/help/oe_reports.htm


Adding and Editing data

rush orders and if you want to have a full or brief type of list.

Invoicable orders.
Prints a report of invoicable orders. In the Overview shipped orders dialog box that appears after selecting this 
option you are prompted to enter information. You have to specify the range concerning: CustomerID, Date, 
AccountID and ProductgroupID. Furthermore you have to decide whether you want to print all orders or only the 
rush orders and if you want to have a full or brief type of list.

In the Reports menu in the Customer screen you have the following customer report options.

Customer Info.
Prints an overview of entered customer info. With the New customer option in Customer menu you can print a 
report of the customer info of new customers.

With the Non-ordering customers option you can print a report customer info of non-ordering customers.

In other words, you can have a list printed of all new and non-ordering customers. You simply specify the time range 
you want to view, by entering the appropriate range in the from ... to ... field in the date selection dialog box.

History.
This option offers you a printed report of the sales history of your customers. Make sure you have an up-to-date 
sales history report. Select the Update history option from the Tasks menu in the Order screen to have the latest 
sales information shown here.

With the Total sales option you can print a report of total sales.

With the Total sales option you can print a report of total sales.

In the appearing dialog box, you have to make the following History Selection: select (either) the customerID, the 
Date, the CustomergroupID, the ProductgroupID and the SalesmanID.

You are also prompted to specify the range you want to view: enter the relevant information in the from ... to ... 
fields.

With the Sales per productgroup option you can print a report of sales per productgroup.

In the appearing dialog box, you have to make the following History Selection: select (either) the customerID, the 
Date, the CustomergroupID, the ProductgroupID and the SalesmanID.

You are also prompted to specify the range you want to view: enter information in the from ... to ... fields.

With the Sales per customer option you can print a report of sales per customer.

In the appearing dialog box, you have to make the following History Selection: select (either) the customerID, the 
Date, the CustomergroupID, the ProductgroupID and the SalesmanID.

You are also prompted to specify the range you want to view: enter information in the from ... to ... fields.
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With the Sales per customergroup option you can print a report of sales per customergroup.

In the appearing dialog box, you have to make the following History Selection: select (either) the customerID, the 
Date, the CustomergroupID, the ProductgroupID and the SalesmanID.

You are also prompted to specify the range you want to view: enter information in the from ... to ... fields.

With the Sales per salesman option you can print a report of sales per salesman.

In the appearing dialog box, you have to make the following History Selection: select (either) the customerID, the 
Date, the CustomergroupID, the ProductgroupID and the SalesmanID.

You are also prompted to specify the range you want to view: enter information in the from ... to ... fields.

In case you need more or different information, you yourself can make a report by building a query (please refer to 
the appropriate section for instructions).

 

Building a query

To obtain more detailed and specific information concerning your orderflow, processing, you can build a query. 
With a query you can use the power of your database-system and get all information out of it. Create a new query or 
use one of the pre-defined queries.

Select the Query option from the File menu in SOSET Namosys.

Select the table to analyze and list with all fields of that table appears. First you select one or more fields to view by 
double-click or click one of the arrows. If you do not set a filter you will get a list of all records in the selected 
database-table.

To set a filter highlight one of the fields on the right side of the query dialog and click the filter-key. You will be 
prompted to enter a start- and end-value for this field. It is possible to set more than one filter.

SOSET will produce a list on your printer with the specified data. At the same time numeric and data fields are 
summed and averaged. You can save a query for later use. In the Overviews menu in NamoSys you will find a user 
activity query.

 

Printing data

You can get a printed output of almost all SOSET processes, to give you a full view of your SOSET OrderEntry 
management.
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Print bar-code labels for boxes.
In case the bar-coded sheets SOSET provides you with are insufficient or otherwise not applicable, you can print 
your own bar-codes on pre-adhesive sheets. Select the Print barcode labels option from the File menu in Namosys. 
Enter a start and an end value.

Print bar-code labels for order forms.
This option from the Tasks menu (in the Order screen) enables you to print bar-code labels for Internal use only or 
On customer, for external use by your customers. In case you choose 'Internal use', SOSET will print order numbers 
with bar-codes in successive order. In case you select 'On customer' you have to enter the customer number. 
Labels will be printed with the customerID and the successive order numbers. Make sure the print settings are set 
correctly with the Preferences, Printers from the File menu.

Print current screen.
CTRL + P is the keyboard shortcut for the Print option from the File menu. This will print the current (or all entered) 
orders, the order confirmation (if checked) and the packing list of the order (in case you are in the Order screen). In 
the Product screen CTRL + P will print the current product.

Print packing list.
Processing the entered orders (an option from the Tasks menu in the Order screen) will print the packing lists of all 
entered orders, including order confirmations (if checked).

Print run cards.
You can print run cards with the option Process entered orders from the Tasks menu, which next to processing the 
entered orders automatically prints run cards for stock items. A run card for typeset items will be printed by 
PageWizard, after the Get corrected stamps run.

Print shipping lists.
With the Shipment options from the Tasks menu (available in the Order screen), you not only change the status of 
your orders, but you print a shipping list as well. Selecting Ready to ship from the Shipment options gives you the 
choice between a large or a small shipment run. Next to a shipment list and a packing list, SOSET prints a label with 
the shipping address and a forgotten rush order list.

Selecting the option Shipped prints a shipped order list of the orders that are ready to ship. The status is 
automatically changed from Ready to ship into Shipped.

Print reports/overviews.
You can print order overviews from the Reports menu (available in the Order screen) of rush orders, production 
control, invoicable orders, shipped orders, entered orders, and outstanding orders.

You can print customer overviews from the Reports menu (available in the Customer screen) of new and non-
ordering customers and reports of total sales and sales per product group, per customer, per customergroup, and 
per salesman.

Print invoices.
With the Invoice options from the Tasks menu (available in the Order screen), you can print your invoices on invoice 
number, on invoice run, etc. 

Printer Settings.
With the printer settings option from the File menu, you can change your printer devices. Select and set the 
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standard attributes of all future orders to your own requirements. Each time you enter a new order SOSET Order 
Entry will start with these settings. However you can always change these settings for each separate order. You can 
select which default printer you want to print your orders, invoices, run cards, packing lists, labels and overviews.

Selecting Printerfont means, you want to use the standard settings of your printer. Selecting portrait or landscape 
refers to the page orientation. Portrait is a term used to refer to vertical page orientation. Landscape refers to 
horizontal page orientation.

For the Overview printer, you can set the text compression in the Printer preferences. The default compression 
factor is 80%. You can change this percentage in case you need no or more compression. Remember that when 
you turn the text compression off, this means that texts that do not fit on one textline, might be divided over more 
textlines.

Furthermore for the Order/Invoice printer, you can select whether you want to print on Preprinted paper or what kind 
of Header and Footer you prefer. A header appears at the top of every page. A footer appears at the bottom of 
every page. You enter a logo as header or footer. Simple browse the options in your logo-subdirectory. With the 
values for Position X and Position Y you enter the start position of the header or footer. Thereby you can enter the 
positioning of the order data on a page. This means decide the nonprinted height on top and on bottom and the X 
position of the mail and the non-mail address.

For the Run card printer, you have to decide how many run cards you want to print per page (you can have up to six 
on a page). To ensures that six run cards fit together on one page, you have to make sure that not only the page 
orientation in the printer options in SOSET PageWizard is set to Landscape (You should also make sure that the 
paper orientation of the default notes printer is set to landscape. Select Settings, Control panel (accessible from the 
Start button in Windows 95) and point to Printers. Then you select Properties from the File menu. There your default 
notes printer should have landscape as standard paper orientation.

To enter additional information concerning the positioning, sizing and margins of the labels on page, you click the 
More button in the Label printer dialog. The top settings refer to the bar-coded ordernumbers you want to have 
printed. The settings underneath refer to the bar-coded customernumber of a customer in combination with 
successive ordernumbers (CustomerID and OrderID are considered together here, as one column).

The number of Columns refers to the number of labels you want to print next to each other. The number of Rows 
refers to the number of labels you want to print vertically on a page. With the value for Start X and Start Y you enter 
the start position of the labelprinting (from the upper left of the page). The left margin indicates where to start 
printing from the left side of the label. With the value for Delta X you set the horizontal whitespace between the 
labels to print. With the value for Delta Y you set the vertical whitespace between the labels to print.

 

Working with Barcodes

The SOSET software includes helpful shipping and invoicing procedures. For shipping and handling procedures, 
you can use the bar-coded-notes instead of (or next to) the shipping-lists provided by SOSET. The availability of 
Status control, which drives your production, proof-reading and printing, as well as automatic laser engraving and 
lasercutting.

Barcodes facilitate storage and retrieval. They also help you in an easy way to keep all data updated and available 
to all users. If you use the bar-coded notes we advise you to store products that are ready to ship in boxes. You will 
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probably need 50-250 boxes. The more stamps you produce, the more boxes you need. If you e.g. produce 500-
600 stamps a day, you will need somewhere around 300 boxes. You can deduce the number of boxes not only from 
the total number of stamps/orders. These boxes must be labeled with the numbered barcodes. These labels are 
included in your software package.

On entering the orders, you assign a bar-coded ordernumber to each original customer order form. In other words: 
you label the orders/stamps by assigning a barcode to them.

The fact that each original order form (and order number) has its own bar-code enables tracking your order during 
the entire production process. After entering the orders you select the Process entered orders option from the 
Tasks menu in the Order screen. This option will change the order status from Entered to Processed and will print 
the stock run cards. As soon as an order (completely or partly) is produced, you select Change status from In 
production to In box from the Tasks menu in the Order screen. You scan the bar-coded ordernumber including the 
partnumber on the run card and you scan a bar-coded box. You keep the run card with the corresponding bar-coded 
box. The ready-made stamp(s) are put in the appropriate box. The order status automatically changes from In 
production to In box (or Partly in box dependent on the order amount).

You repeat this procedure until the order is complete. The box number can be viewed in the orderitem box in the 
SOSET OrderEntry. Each order partnumber shows whether or not it is boxed and if so in what boxnumber.

It is not until all order items/stamps are in box , that the order reads In box.

Selecting the option Change status from In box into Ready to ship from the Tasks menu in the Order screen, will 
attach the status Ready to ship to the In box scanned orders. Next to this status change a shipping list will be 
printed. With help of the shipping list and the bar-coded run cards you can start packing.

At the end of the day you collect the run cards from the orders and you keep them in a plastic bag or so (store them 
in your archive for a given period). The option Change status from Ready to ship into Shipped from the Tasks menu 
in the Order screen gives you the option to report all orders with the status Ready to ship into Shipped.

The following situation can occur. During the production process some faults may have happened, as a result of 
which some orders went wrong (or so) and therefore cannot be shipped. However they (falsely) do have the status 
Ready to ship but they are not allowed to be shipped to your customers. Here's what you do in situations like these:

You first report these orders back to In production and you make sure that they will be shipped tomorrow (e.g. by 
assigning a rush code to them). Then you report the remaining orders from Ready to ship into Shipped.

The original order forms, provided by your customer, with the bar-coded ordernumbers are archived (with the 
Archive orders option from the Tasks menu in the Order screen) and stored in an archive location in the SOSET 
OrderEntry system. This way you can easily retrieve them. To facilitate actual finding of the order forms, you can 
e.g. keep all (archived) orders of one day or one week together in a box in your archive. Mention the day of 
archiving and the range of archive locations on the cover.

If you want to search for the correct archive location of the archived orders in SOSET OrderEntry, you have to use 
the Archive orders option from the File menu to retrieve them and to view them on your screen.
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Archive orders

After the working day is done, you can archive the customer order forms that have the status Corrected (in SOSET 
Typeset) or that have been classified as stock orderitems. This can be done by scanning or manually entering the 
various bar-code labeled order(number)s. This way you can easily retrieve old orders to improve your service to 
your customers, in case there are questions or remarks on receiving the ordered products.

With the Archive Orders Option in the Tasks menu (this option is only available in the order screen) you can 
archive your original customer order forms with the bar-coded ordernumbers. You enter an ordernumber (either 
manually or with a guntype scanner) and SOSET will put this in an archive location (the latter consists of month + 
day + serial number). The dialog shows the last ordernumber that has been archived and the archive location 
belonging to it. The 'Reset' button enables you to start afresh at the beginning of a (new) filing session. The archive 
location can be viewed at the left bottom of each archived order in the Order screen.

You can easily retrieve them afterwards in the SOSET OrderEntry system. To facilitate actual finding of the orders, 
you can e.g. keep all (archived) orders of one day or one week together in a box in your archive. Mention the day of 
archiving and the range of archive locations at the box.

The Archive Orders option from the General File menu enables you to search for archived orders.

 

Typeset Information

SOSET Typeset works in perfect harmony with SOSET OrderEntry. Each order entered in SOSET OrderEntry with 
the status 'typeset' will be designed in Typeset. Advanced designing tools and techniques are available. Designing 
stamps can be easy. SOSET-users all over the world will gladly verify that statement! The stamp-production with 
SOSET Typeset is based on different typeset status of stamps.

The direct link between SOSET Typeset and SOSET OrderEntry enables you to enter the order in SOSET 
OrderEntry, while viewing it in SOSET Typeset (after updating the order!). Just click the Typeset button on the 
Order screen.

Starting SOSET Typeset automatically opens the SOSET stamp-database table. This gives you a screen view at 
one stamp at a time. In case you want to work with more than one stamp at a time, you click the New option on the 
File menu in SOSET Typeset for every stamp you want to view. In the field order number you must enter the 
complete order number, including the item-number, in total 12 digits (no dash!). You will find these complete 
numbers on all notes or forms provided by the SOSET system.
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OrderEntry screen 

Menubar in OrderEntry
Data screen
General screen
Customer Screen
Order Screen
Product Screen

 

Menubar in OrderEntry

You can get access to the applicable menu options in many different ways. You can use the 
Menubar and Keyboard Shortcuts.

The Menubar contains so-called pop-up menus for SOSET OrderEntry commands. Use the 
mouse to point at a top-level menu item in the Menubar, click it to open, and then click a 
command to select the requested sub menu.

The Menubar can also be activated by holding down the ALT key and use the arrow buttons on 
the keyboard to go to the various menu-items, finally pushing the Enter key to select the 
appropriate menu. Commands shown in gray do not apply to the operation you are trying to 
perform.

The Menubar enables you to switch easily between the Order screen, Product screen and 
Customer screen. Every screen has its own capabilities concerning menu options.

 

Data screen

The SOSET OrderEntry screen gives access to all available functions. In the data area you find 
the properties of the order, customer or product in the current screen. These properties are set 
during entering or editing a record. At a glance, you can view all information concerning a 
customer, order or product.

The menubar provides access to all options of SOSET OrderEntry. As it is a combination of 
order managing and database techniques, you will find several special and unique options to 
work efficiently with your databases, next to several common and typical data-entry options.

http://www.namosoft.nl/help/oe_screens.htm (1 of 6) [10-Jul-2002 11:50:58 AM]



OrderEntry screen

When you open a menu option, a window appears into which you can enter information. You can 
communicate with SOSET OrderEntry, since you both provide and receive information through 
these dialog boxes.

After entering your pincode SOSET displays a dialog in which you select the company to open. 
Afterwards SOSET displays the Order screen. You can start assigning orders to customers 
known to the system.

In case of a new customer or a new product, you have to switch to either the Customer screen or 
the Product screen.

If you close the company, you are in the General screen. In this menu, you can perform all kinds 
of operations that require exclusive use of the database files so all the existing files have to by 
closed, e.g. for reindexing database tables.

At any time you can decide which screen you want displayed on your screen. This means you 
select whether you want to work in the Product-, the Customer- or the Order screen. Select 
from the Maintain menu the appropriate menu-option or use the Toolbar buttons.

 

General screen

All options are top-level menu-items in the General screen and will show pop-up menus when 
selected. On the main menu, you click this menu, point at a sub menu, clicking it to select it.
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Customer Screen

When you want to enter, edit or view customers on customer-number, you select Customer from 

the Maintain menu or press the C- button, to open the Customer screen.
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On top of the SOSET OrderEntry screen you find the Menubar. All options are top-level menu-
items in the menubar and will show pop-up menus when selected. On the Menubar you click this 
menu, point at a sub menu, clicking it to select it.

 

Order Screen

When you want to enter, edit or view orders on order number, you select Order from the Maintain 

menu or press the O-button, to open Order screen.
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On top of the SOSET OrderEntry screen you find the menubar. All options are top-level menu-
items in the Menubar and will show pop-up menus when selected. On the Menubar you click this 
menu, point at a sub menu, clicking it to select it.

 

Product Screen

When you want to enter, edit or view products on product-number, you select Product from the 

Maintain menu or press the P-button, to open the Product screen.
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On top of the SOSET OrderEntry screen you find the menubar. All options are top-level menu-
items in the Menubar and will show pop-up menus when selected. On the Menubar you click this 
menu, point at a sub menu, clicking it to select it.
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Toolbar in OrderEntry

Here you see common designing-tools and database-managing tools. Click the 
command buttons to quickly select main Order- and database-managing commands. 
Buttons shown in gray, mean that they are not applicable at the moment. In other words 
they are not necessary to the action you want to perform.

The Toolbar offers graphical representations of common commands or additional 
windows that pertain to the window. Some are common to most windows programs, 
while others are quite specific.

Here's a brief description of the toolbar buttons in the window.

 Button Description
Customer Screen Switches you directly to the Customer screen of 

your current company.
Order Screen Switches you directly to the Order screen of your 

current company. When you are in a Customer 
screen, and you select the O-button, SOSET 
OrderEntry will ask you whether you want to add a 
new order in case the active customer has no 
current orders.

Product Screen Switches you directly Product screen, enabling you 
to maintain the products of your current company. 
All product-information becomes available.

SOSET Typeset Opens SOSET Typeset, enabling you to maintain 
the typeset orders in SOSET Typeset. In case the 
current order consists of typeset stamps, you can 
view these immediately on screen in SOSET 
Typeset.

If you want to switch between SOSET OrderEntry 
and a Typeset document, you are advised to use 
the minimized Typeset application window in the 
Windows taskbar.
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Cut Removes selected text, controls, or anything else 
that is selectable, to the Clipboard. For details, see 
Edit Menu.

Copy Duplicates selected text, controls, or anything else 
that is selectable. For details, see Edit Menu.

Paste Places cut or copied text, controls, or anything else 
that is selectable at the insertion point position. For 
details, see Edit Menu.

First Item Displays the first order of the database-table This 
will move the record pointer to the first order/part in 
the current order number.

Previous Item Displays the previous database item 

Next Item Displays to the next database item 

Last Item Displays the last order of the database table. This 
will move the record pointer to the first order/part in 
the current order number.

New customer/ order/product Adds a new customer, order or product to the 
database.

When used in the Product screen, you are prompted 
to fill out the ProductID first.

When used in the Customer screen, SOSET 
automatically attaches a customerID to the new 
customer. You are prompted to enter the appropriate 
customer group, belonging to the specific customer. 
Fill in the rest of the Customer screen.

When used in the Order screen, the New Order 
dialog box appears, asking if the new order belongs 
to the current customer: CustomerID, Customer 
Name, Phone, Fax, and Status. Answering 
affirmatively will result in copying the customer 
information to the new order document. You can 
also choose to search for a new customer on the 
following searchkeys: CustomerID, Name 
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searchkey, City searchkey, and the Customer 
Group.

Edit Enables you to modify the current customer, order or 
product. All possible OrderEntry options are 
available now.

Update Saves the newly entered information in the SOSET 
database. In case you are not satisfied with the 
entered information, you simply close the active 
window (this Close-option can be found in the 
Customer/Order/Product menu).

Delete Deletes an order or product. A deleted order or 
product is still visible in the database-table. To 
refresh your database table, you can run the Pack 
Tables option in SOSET NamoSys.

This option is only available in the Order and 
Product menu. You can not delete a customer, for 
obvious reasons.

 Multiple Search Displays the Multiple Search dialog box which 
enables you to search for orders, products or 
customers.

While used in the Order screen, you can search on 
orderno., shipping date, reference and customer ID.

While used in the Customer screen, you can search 
on customer ID, name searchkey, city searchkey 
and customer group.

While used in the Product screen, you can search 
on Product ID, product searchkey and 
customergroup.

Add Item Adds an orderitem to a current order.

Edit Item Edit a selected orderitem of the current order.

http://www.namosoft.nl/help/oe_toolbar.htm (3 of 4) [10-Jul-2002 11:51:00 AM]



Toolbar in OrderEntry

Delete Item Deletes a selected orderitem of the current order.

Print Prints the current screen. For more information on 
printsetting, etc. take a look at the Preferences 
submenu in the File menu.

About SOSET Displays information about the SOSET OrderEntry. 
This way you have easy access to relevant 
information concerning program information, 
copyright, versionnumber.

Context-sensitive help Displays the context-sensitive help for a selected 
screen element. Clicking the button on the toolbar 
changes the mouse pointer to an arrow and a 
question mark, point at the screen element that you 
want information on and then click. The requested 
information is now being displayed on your screen.
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Typeset Help
To get information select an item in the table of contents or click the appropriate item in the screenshot.

Table of Contents:

●     Introduction to SOSET Typeset
●     Typeset Step-By-Step
●     Typeset Status
●     DesignWizard
●     Design a Stamp Manually
●     Working with OLE objects
●     File Menu in Typeset
●     Edit Menu in Typeset
●     Record Menu in Typeset
●     Properties Menu in Typeset
●     Text Menu in Typeset
●     Logo Menu in Typeset
●     Overviews Menu in Typeset
●     Shipment Menu in Typeset
●     Window Menu in Typeset
●     Help Menu in Typeset
●     Toolbar in Typeset
●     Status Bar in Typeset
●     Other screen components in Typeset
●     Shortcut Keys in typeset
●     Miscellaneous Typeset Info

Typeset screenshot:
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Introduction to SOSET Typeset

SOSET stands for Stamp Order and (type-) SETting. A new and revolutionary 
approach to manage ordering, shipping, invoicing and typesetting for the rubberstamp 
industry.

It is very important to understand the SOSET principles, so that you can get the most out 
of it.

SOSET consists of a dual system. It is divided into two major parts: a Typeset part and 
an Order part. SOSET is based on a powerful database under Microsoft Windows in an 
MS-DOS-operating system (DOS can only run 16bit version of SOSET). SOSET 
OrderEntry is special Windows-based software that handles order-management and can 
work together in perfect harmony with the SOSET typesetting software. SOSET Typeset 
is available in different versions, depending on your needs. The most extended version is 
the SOSET Typeset Gold version.

The SOSET Typeset Gold version can work both in stand-alone and multi-user 
version with Windows-network drivers. This network-option partly accounts for SOSET's 
new approach to typesetting every one of your stamp-designs as a separate record in a 
network-compatible database in your system.

Easy tracking, designing, layout and reporting, driven by the many possibilities of the 
built-in database. No more searching for stamps in numerous undefined files or pages! 
Just enter a search key and get all the stamp-design-information including a stamp-view. 
A powerful import-option can merge your customers-texts or scanned images with any 
design in the database.

SOSET Typeset can create wonderful stamps with the DesignWizard. All functions are 
very easy to understand and fit to stamp makers standards all over the world. Oval and 
circular stamps, lines and logo's are a snap!

Moreover, the SOSET Typeset Gold is standard supplied with the PageWizard, which 
creates your pages automatically, so why do it yourself? Add to this the availability of 
Status-control, which drives your production, proofreading and printing, as well as 
automatic laser engraving and lasercutting. Barcodes help you in an easy way to 
keep all data updated and available to all users. Shipping and invoicing is computerized 
in a fantastic and modern way.
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In short: SOSET can stamp your production in style!
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DesignWizard

The Record menu will offer you to use the DesignWizard for computerized stamp 
design. In case you first decided to design a stamp yourself (with the Blank stamp-

option), but later changed your mind, you can push the DesignWizard-button,  on the 
Toolbar to start (re)designing with the DesignWizard.

When you want to create a new stamp, you choose the New command in the Record 

menu, shortcut: , Ctrl +F8. In the dialog that appears on the screen, you have the 
choice between designing a stamp yourself (choose Blank stamp) in that case, or 
designing a stamp the easy way: let the DesignWizard guide you!
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In the dialog box that appears on your screen after choosing DesignWizard, you can 
specify the following options: 

●     Font
●     Alignment
●     Border and Rounded corners. When you select the border-field you can also 

specify the linewidth and the distance between the text and the border.
●     Format-section. You can choose between:

❍     Small, Normal, Large or King size straight line.
❍     Draw line specifies a horizontal line in the stamp. DesignWizard will ask you 

the width of the line in an appearing dialog and put it exactly in the middle 
between textlines.

❍     Fixed linespacing is used when you want to overrule the automatically 
calculated linespace between two lines. SOSET Typeset will prompt you to 
enter the height of the space in the Fixed Leading dialog box.

❍     Small, Normal, Large or King size oval line.

In case you want several fonts or different alignments in your stamp design, you choose 
here any font or alignment. It does not matter, since this does not directly affect the 
design. Later, once you have the stamp design on your screen, you will be able to modify 
all these settings, per textline or selection. 

With the arrow buttons in the DesignWizard dialogbox you can confirm (>) or undo (<) 
your selection. The double arrow button (<<) will undo all selections. For oval 
typesetting you can choose the oval linetypes (small, normal, large and king size oval 
lines). Every time you add or undo a line, the Row field will show the amount of rows 
(lines) in your stamp design. 

●     In the Column field you can set the columns in case you want the design divided in 
more than one vertical section. After setting the columns, tabulations in your stamp 
design can only be made by column.

●     For perfect use of all vertical space SOSET needs to know if the last textline 
contains descenders. Click the appropriate box if this is the case (e.g. the letters: 
g,j,p etc. are not fully printed inside the stamp area if you don't selected the 
descenders option).

Adding and Editing a Stamp.
When you select OK in the DesignWizard you can begin to typeset, with all options 
preset in accordance to your entry. The cursor is blinking on the first pre-defined textline, 
enter some text here and with the down-arrow key on the keyboard you go to the second 
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line, under the specified line. Here you enter text again and you repeat this action on the 
third line. The Enter-key is disabled during design with the DesignWizard! The 
reason for this is that the DesignWizard designs your stamp. Using the Enter-key would 
add a new line to your design and destroy the predefined design. For the same reason 
you cannot delete a text-line during DesignWizard operations.

In case you want to add a line to your design, you must update the stamp first. Now you 
are out the DesignWizard-mode and you can edit the stamp yourself and of course use 
the Enter-key. To let SOSET Typeset re-design your stamp, just click the DesignWizard-

button,  on the Toolbar. The current design will be destroyed and you can define your 
stamp once again.

You will see that the DesignWizard has found perfect sizes and space between the 
lines. Take also notice of the fantastic feature of Auto-compression.
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Record Menu in Typeset

This Record or Stamp menu has database-management options.

Remember that you are adding a NEW record to a database-table and NOT creating 
a NEW file.

New
Edit
Duplicate
Update
Close
Delete
Undelete
Change Sort Order
Find
Go To
Refresh
Print
M&R Laser Engrave

New

Select this command to design a new stamp. Shortcut: , Ctrl + F8.
This new stamp will be added to the database, after updating it(select the Update 
command).

Enter typical data as order-number, searchkeys, customer-information in the New Stamp 
dialog box. Select the product in the product field and enter the stamp size, shape, color 
and mount.
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Furthermore you can enter the Quantity and set the most commonly used properties of a 
stamp.

After this opening entry dialog you will enter the stamp-design using either the 
DesignWizard.or creating a blank stamp.

 

Edit

The Edit command activates the current record/stamp, enabling you to modify its design 

or properties. Shortcut: , Ctrl + F9.
All typesetting and record-options are available now.
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Duplicate

With this option you can duplicate a current record/stamp with its design and record-
properties into a new order-number. Shortcut: Shift + F9.

The Duplicate stamp dialog box is similar to the New Stamp dialog box. The dialog is 
already filled with data of the current record/stamp. The quantity is always defaulted to 1.

Note: In this way ALL stamps in the SOSET database can be used as a template for a 
new stamp.

 

Update

Finish designing or editing your stamp with the update-option to write the current design 

with its properties to the SOSET database Shortcut: , Ctrl + F10.

In case you are not satisfied with your stamp design, you simply close the stamp (with 
the Close command), without updating it. The (last) changes you have made to your 
stamp design or the entire design (in case you opened a new record/stamp) will not be 
saved.

 

Close

This option will end your current stamp entry. If you are well pleased with your 
stampdesign, you answer yes to the question whether or not SOSET should update your 
stamp. The stamp will be saved in the Stamp database-table.

In case you are not satisfied with your stamp design, you simply close the stamp, without 
updating it. In that case the (last) changes you have made to your stamp design or the 
entire design (in case you opened a new record/stamp) will not be saved.

 

Delete
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This option enables you to delete the current record/stamp in the database. You need to 
confirm complete deletion of the stamp. Although the design remains on the screen, 
SOSET will change the status into Deleted. Note that the stamp will not disappear 
immediately, despite of the fact that it is deleted! See Undelete Command for more 
information.

 

Undelete

This option enables you to undelete only the current record/stamp in the database if you 
change your mind after deleting the stamp. The typeset status of a stamp you undelete 
and in this way retrieve is by definition set on Entered. You can change this status using 
the shortcut key: CTRL + X.

As long as the stamp is visible in the design screen you can undelete the deleted stamp 
with the undelete command. After you start working with another stamp the deleted 
stamp can only be retrieved with the NamoUtil program.

Before you want to view undeleted stamps in NamoUtil make sure you select the SET 
Deleted off command in the Options menu in NamoUtil. 

In case you want to retrieve a deleted stamp, you choose the Open Table Exclusive in 
the File menu in NamoUtil and open Stamp.dbf. Browse trough the stamp table to find 
the required stamp. The first column of the table will display a black field indicating that 
this stamp is mark as deleted. Click on this checkmark to undelete the stamp.

Note: If you click in the first column on a white field (the stamp is mark as not deleted) 
the field will become black and thus mark the stamp as deleted. The stamp will not be 
accessible in Typeset anymore (unless you undelete the stamp again).

Only after running the option Pack tables in the File menu in NamoSys program deleted 
stamps are definitely ejected from the database (a backup of the original tables is copied 
to the SOSET\TEMP directory, just in case…).

 

Change Sort Order
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With this option you can change the ( index-) order in which the stamps/records are 
sorted in the database-table (the checkmark shows the active index). You can choose 
between an index on: 

●     Orderno (from low to high)
●     Searchkey 1 and Searchkey 2 (both in alphabetical order)
●     CustomerID (from low to high)
●     Customer Info
●     Natural order ('date in', that means the day of entering the stamp/order).

This option is very useful in combination with viewing the Next and Previous stamp 
option in the Record menu or the browser on the Toolbar.

 

Find

Displays the Find submenu. Enter one of the offered search-options. You can search on: 

●     Orderno. Shortcut: Ctrl + F3
●     Searchkey 1. Shortcut: Ctrl + F1
●     Searchkey 2. Shortcut: Ctrl + F2
●     Customer ID. Shortcut: Ctrl + Shift + N
●     Customer info. Shortcut: Ctrl + Shift + I
●     All of the above mentioned options. Shortcut: Ctrl + Shift + A.
●     Archive.

Enables you to search for all stamps made in a certain year. This option shows 
only a view of all stamps of that archive year. You can not edit while you are in this 
mode. So it is impossible to create stamps. Copying a stamp is possible, just click 
the Copy option in the Edit menu and paste the stamp in the original work 
database.

Once the stamps are found, you will get a selection of all records/stamps that fit to your 
specifications. A double-click in the list will show the selected stamp on the screen. You 
can go back to the search results with the Last search results command in the Find 
submenu.

This option is only available in the SOSET Typeset Gold version!
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Go To

A database system needs a browser to go through all saved records, from first to last, 
from beginning to end and forward or backward.

The Go to-options offer all this. You can go respectively to the first, the last, the next and 
the previous record, simply by clicking the appropriate menu-item. Using the browse 

buttons,  on the Toolbar will have the same effect.

 

Refresh

This option is intended for useful working in a network environment. If you are in the 
view mode (so NOT editing! ) in SOSET Typeset, a stamp might have been edited by 
another user. Refresh the screen to get the latest information.

 

Print

This option will print the current stamp. This option is similar to the Print command in the 

File menu. Shortcut: , Ctrl + P
Output includes stamp information (specified in the Local Preferences) and can be used 
as a proof print for you and your customer. In order to print more stamps and to have a 
page-layout made, you need to start the PageWizard program.

Users of SOSET Remote Typeset will see a gray background on their printed output, 
since they do not need production quality.

 

M&R Laser Engrave
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The M&R laser engrave command in the Record menu is similar to the M&R Laser 
Engrave command in the File menu.
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Toolbar in Typeset

In Typeset you can work in different graphical modes. The available graphical objects 
can be found in the Mode command in the Properties menu. The Text-mode can also be 
found here.

They can also be toggled on the toolbar. The various graphical objects correspond with 
the buttons on the toolbar. Push the requested graphical object below, to see the 
appropriate button to push.

Click the command buttons to quickly select main Typeset and database commands. 
Buttons shown in gray are not applicable at the moment. This might be due to the 
different capabilities of SOSET Typeset Gold and the Silver version. They also might not 
be necessary to the action you want to perform.

There are two toolbars:

1.  Standard toolbar which contains the most commonly used edit, database and 
view commands.

2.  Advanced toolbar which lets you insert the most common graphical objects and 
which contains the most commonly used (text-) formatting commands.

Standard toolbar

 Button Description
Cut Removes selected text, controls, or anything else that you 

can select, to the Clipboard. Once you cut (or copy) 
something, you can paste it elsewhere in your application or 
in other applications.

Copy Duplicates selected text, controls, or anything else that you 
can select, and puts it on the Clipboard. Once you copy (or 
cut) something to the Clipboard, you can paste it elsewhere in 
your application or in other applications.

Paste Takes cut or copied text, objects, controls, or anything that 
you can select (except for forms) from the Clipboard and 
places it at the insertion point. To place your selection on the 
Clipboard, use the Cut or Copy commands 
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Undo Reverses the last editing change. When you save a file, the 
Undo command is disabled until you change the file in some 
way. You can set the number of undo actions with the Local 
preferences.

Redo Reverses the effect of the last Undo command. You can redo 
up to 10 actions.

Browse: First Go To First Stamp

Browse: Previous Go To Previous Stamp

Browse: Next Go To Next Stamp

Browse: Last Go To Last Stamp

New Record A new stamp will be added to the database. Enter typical data 
as order-number, search keys, customer-information in the 
New stamp dialog. Select the product in the product field. 
After this opening entry dialog you will enter the stamp-design 
either manually or with the DesignWizard.

Edit Record Edit will activate the current record/stamp enabling you to 
modify its design or properties. All Typeset and record-options 
are available now.

Update Record When you decide your stamp is finished and the results live 
up to your expectations, you push the Update Record button 
and the current design with its properties will be automatically 
written to the SOSET database.

In case you are not satisfied with your stamp design, you 
simply close the stamp, (this Close option can be found under 
the Record menu). The (last) changes you have made to your 
stamp design or the entire design (in case you opened a new 
record/stamp) will not be saved.

Delete Deletes the current stamp.
See Delete in the Record menu for more information.

Print Prints the current stamp. You can specify the information 
printed with the output button in the Local Preferences.
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Zoom In Zoom the selected areas of the stamp.
See the Windows Menu for more information.

Zoom Out Shows the complete stamp design again.
See Zoom Mode Command for more information.

M&R Laser Engrave The M&R button is only accessible in the M&R laser 
engraver version of the SOSET Typeset software. Clicking 
this button will activate the laser engraver for immediate 
engraving of the current design.

 

Advanced Toolbar

 Button Description
Selection Enables you to select text and objects in your 

stamp design.
In SOSET Typeset you can work in two different 
modes: 

1.  In Selection mode you can create lines, 
boxes, circles and import logos. Just 
make sure the arrow-button on the toolbar 
is highlighted (so you are in selection 
mode), and double-click in or outside your 
stamp design. The appearing dialog box 
asks you whether or not you want to add 
a graphical object, and if so you are 
prompted to define its properties.

2.  In the Default mode, when the selection 
mode is turned off, you can draw 
graphical objects yourself. The cursor-
arrow changes in a cross, and by double-
clicking the mouse and dragging it over 
the screen (holding down the left mouse 
button), you draw the desired object: from 
starting point until end-position. It is not 
possible to draw lines outside the defined 
stampsize.
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You can always press the Insert-key or double-
click outside your stamp design to create a new 
object in your stamp.

Text Mode Set in textmode. This enables you to add, edit 
or delete text in your stamp design. When you 
are in text mode, the next options become 
available:

●     Font
●     Alignment
●     Shaping text

When you are in text mode it is not possible to 
turn off the Selection mode. See Design a 
Stamp Manually for more information.

Graphical Object: Line Mode Pushing this button toggles the line mode on. 
With the Selection Mode off, the cursor will 
show a cross. Position the cursor on a start-
position of the line and draw the line by 
dragging the mouse to the end-position of the 
line.
See Move or Change a Line for more 
information.

Graphical Object: Box Mode Pushing this button toggles the box mode on. 
With the Selection Mode off, the cursor will 
show a cross. Position the cursor on a start-
position of the box and draw the box by 
dragging the mouse to the opposite position of 
the box.
See Move or Change Graphical Objects for 
more information.
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Graphical Object: circle/ellipse 
Mode

Pushing this button toggles the circle/ellipse 
mode on. You can start drawing all kinds of 
ovals. With the Selection Mode off, the cursor 
will show a cross. Position the cursor on a start-
position of the circle and draw the circle by 
dragging the mouse to the opposite position of 
the circle.
See Move or Change Graphical Objects for 
more information.

Graphical Object: Arc Mode Pushing this button toggles the curve mode on. 
With the Selection Mode off, the cursor will 
show a cross. Position the cursor on a start-
position of the curve and draw the appearing 
circle by dragging the mouse to the opposite 
position of the circle. Releasing the mouse key 
will show the curve at 180°.
See Move or Change Graphical Objects for 
more information.

Graphical Object: Logo Mode Pushing this button toggles the logo mode on. 
Select the Logo-button to activate the logo-
import. Position the cursor in the design area 
and double-click to open the logo-dialog. Select 
a logo, the logo-format and enter the position, 
size and attributes of the logo, or use the default-
option.
See Move or Change a Logo for more 
information.

Font With this button you can select the desired font 
for your text. In the font-dialog you choose: font, 
font-style, type, size and compression factor to 
change the appearance of your text. You may 
enter a test-text in the sample field.

 Bold Sets the selected text style to Bold.
 Italic Sets the selected text style to Italic.
 Underline Sets the selected text style to Underline.

Alignment: Left Flush-left command
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Alignment: Center Center command

Alignment: Right Flush-right command

Shape: Straight Enables you to make a straight shape of the 
selected text. This option can also be found in 
Shape submenu in the Text menu.

Shape: Oval Enables you to make a round (oval) shape of 
the selected text. This option can also be found 
in Shape submenu in the Text menu.

Flip Text The flip text-option enables you to switch 
between clock- and counter clockwise 
typesetting in circular and oval textlines.

Note: In circular and oval textline with clockwise 
typesetting the 0-position is at the bottom center 
of the stamp. "Flip" the textline will move the 0-
position to the top center of the stamp.

DesignWizard Designing stamps is easy in Typeset. The 
DesignWizard facilitates designing 
tremendously. To let SOSET Typeset (re-
)design your stamp, just click the DesignWizard 
button.

You can start designing your stamp or the 
current design will be destroyed and you can 
define your stamp once again.
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Properties Menu in Typeset

In this menu you will find options to set, select and modify the properties of the current 
record/stamp displayed in Typeset.

You will also find the design mode-options.

Note: All property information will be printed on the run-cards, accurate entry will be of great help 
to your production. Many of the options in this menu have already been preset upon initial entry.

Searchkey
Size
Color
Product
Printset
Status
Customer
Mount
Quantity
Numbering
Date Area
Info
Exported
Rush
Attachment
Typeset
Mode
Resize
Center all
Scale
Send to Foreground/Background

 

Searchkey
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These options change the searchkeys and customer information of the current record/stamp. 
Shortcut: Ctrl + 1 and Ctrl + 2
Note that the searchkey is always in uppercase. Use simple and clear searchkeys to enable 
efficient tracking. In a network agreements concerning searchkeys are preferable to individual 
attributions.

 

Size

This command displays the Shape & Size Dialog Box, which enables you to change the shape 
and the size of your stamp. Shortcut: Ctrl + D.

 

Color

If the product is available in one or more (inkpad) colors, set in the Product-table, you can change 
the color here. Shortcut: Ctrl + K.

Note: Refer to the NamoSys chapter Structure of the Database-tables for more information.

This option is only available in the SOSET Typeset Gold version!

 

Product

Select a product from the range specified in the Product-table. Shortcut: Ctrl + R.
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If the product size of the selected product is different from the size of the current stamp, you can 
choose to accept or ignore the new size.

Note: To add or modify products to the product database table, see also: NamoSys.

 

Printset

Select one of the possible print-categories. Shortcut: Ctrl + E.
For default the printset category is set as specified in the Product-table.
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This option is only available in the SOSET Typeset Gold version!

 

Status

This option enables you to change the Typeset status of the current stamp. Shortcut: CTRL + X.

Note: Some status-options are set and updated by SOSET automatically during Typeset 
procedures like printing and shipping.

There is an extra shortcut for the regularly used command: Change status in Corrected: Alt + C

 

Customer

This option enables you to modify the customer-number and the customer information of your 
orders. Shortcut: Ctrl + U.
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Mount

With this option you specify the mount you want for the current stamp. Shortcut: Ctrl + M.
Use this option also in case your customer wants its name on the mount.

Note: To add or modify mounts go to the Mount-table, see also: NamoSys.

This option is only available in the SOSET Typeset Gold version!

 

Quantity

When you need more than one stamp you choose the Quantity command. Shortcut: Ctrl + Q. 
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Enter the desired amount of stamps. In the dialog you can enter the Quantity ordered. You also 
can see and modify the quantity In production.

During printing of All corrected stamps in the PageWizard, SOSET will automatically update the 
quantity In production.

When the status of a record is reset to Corrected after production, the production of all or some 
stamps should start over again. In these cases SOSET Typeset will change the quantity In 
production automatically into 0. So the amount of corrected and ordered stamps will be printed 
once they are updated to In production.

If a number of stamps has already been produced, you can change the quantity In production. 
You fill out the number of stamps, which already have been successfully produced. SOSET will 
print the amount of stamps left! This way, the ordered quantity remains the same, but stamps 
which have been approved of, are not produced twice.

 

Numbering

This option offers a unique but very simple solution to produce series of stamps with rising 
numbers. Shortcut: Ctrl + N.
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First you place the cursor on the screen to fix the exact position of the numbers to appear. Then 
you choose Numbering. Enter start and end of the numbers and step sequence. Entering the 
quantity each will result in a total quantity calculation to check.

After closing the dialog the first number of the series will appear in the stamp design. It is colored 
red to indicate that this is a numbering field. The stamp, complete with the correct quantities and 
the numbering sequence, can be called up and printed in PageWizard.

Numbers can only be changed by re-entering the Numbering dialog.

It is possible to have more rising numbers in the same stamp, but they must have all the same 
start, end and step values.

The numbering field behaves similar as all other texts in a stamp, so typographical properties etc. 
can be changed at all times. You can change e.g. from straight to circular typesetting as well.

This option is only available in the SOSET Typeset Gold version!

 

Date Area

For each product in the Product-table you can specify whether this product should have a date-
area. Just use the Date-area command.
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With this option you can define the exact size and position of this field. The center-option will 
automatically center the date in the stamp. Naturally you are able to switch off the date-area any 
time you want.

During editing, SOSET Typeset will show the product including the date-area. This date-area is 
gray colored to indicate that this space is reserved for the date.

While you design the stamp, you can position the date-area by clicking the mouse and drag it to 
the desired place in the stamp.

In case you use a flatbed laser which has a laser engrave indicator, PageWizard will automatically 
cut the date-area.

 

Info

Displays the Info submenu commands: 

●     History shows a list of all-important changes with date/time and user information. This 
option is only for service purpose.
This option is only available in the SOSET Typeset Gold version!
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●     General Info shows several important stamp-data in the data-area under the menu bar. If 
you want to see all information as stored in the database-table you use this General Info 
option. You see the information or stamp properties per stamp. At bottom right of this screen 
you will find a record counter, with the total number of records in your database-table. Most 
of the ID-fields here have a code, which refers to the appropriate database-tables.

 
For the Numbering and Date Area fields a True/False switch is used, a T here indicates that 
Numbering and Date Area is switched on and a F indicates that these options are switched 
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off. For the PageWizard and Exported fields a T here indicates that the stamp is in 
PageWizard or is Exported and a F indicates that the stamp is not in PageWizard (but in 
Typeset) or the stamp has not been exported.

At the bottom of the screen there are 3 buttons. Press the OK button to leave this screen. 
Press History to see the history of the stamp ( this option is equal to the History command 
in the Info submenu) or press Stamp to view the technical data of the stamp (it is NOT 
recommended to edit any of these values).

Note: behind Quantity you will find two values: the first for ordered and the second for 
printed quantity.
This option is only available in the SOSET Typeset Gold version!

●     Note enables you to put a note on to a stamp. This note will be displayed when you edit a 
stamp. On the runcard the word, INFO will be printed to indicated that this stamp has 
additional information.

 

Exported

If you use the options for importing and exporting stamps (in the File menu) for remote entry, you 
will find that every exported stamp at the remote side has an export switch. This way a stamp can 
only be exported once. Choosing this option will reset the switch so the stamp can be exported 
again.

This option is only available in the SOSET Typeset Gold version!

 

Rush

Most rubber stamp manufacturers (AND THEIR CUSTOMERS!) rush all orders. SOSET offers a 
nice way to draw extra attention to rush stamps. 

http://www.namosoft.nl/help/tp_properties.htm (10 of 13) [10-Jul-2002 11:51:05 AM]



Properties Menu in Typeset

A stamp has the No rush status, by default. Select this option in case you want to assign a rush-
status to the current stamp. The current stamp gets a marker. On the screen a stamp with 'Rush' 
status will show a yellow border. A stamp with 'Rush 24 hours' will show an orange border. A 
stamp with 'Rush 48 hours' will show a red border.

During page-layout in the PageWizard all stamps with a rush-status, receive the same mark as in 
Typeset, to enable special rush treatment.

This option is only available in the SOSET Typeset Gold version!

 

Attachment

When customers send you an order for a new stamp, they sometimes include a selfinker or 
mount, for re-use. Often this is forgotten at the moment that you start producing the stamp. The 
attachment setting will inform you about the attachment on the run-cards and/or the production-
overview.

It is advised to code the attachment with the order- and item number, on entering the order and to 
send it already into production, where it awaits final mounting.

This option is only available in the SOSET Typeset Gold version!

 

Typeset

SOSET Typeset software works in perfect harmony with SOSET OrderEntry.
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While SOSET OrderEntry software covers ALL orders, SOSET Typeset software is actually 
designed to handle production orders only and NO stock orders.

However, to enable full production and shipment control in SOSET Typeset software the Typeset 
option is added. This way stock orders can be included in the order execution.

A stock-product can be entered in the Product-table. For this product the Typeset-property is 
set to F (= False), a Typeset-product is normally set to T (= True) to enable designing the stamp.

During every Get all entered stamps print-procedure in PageWizard the records with the Typeset 
= False setting are excluded from the page-layout. The (stock) run-cards for these order-items 
are being printed all the same.

 

Mode

You can set the design mode in the Mode option in the Properties Menu, as well as on the 
Toolbar. You can switch from text mode to graphical mode, in order to respectively write or draw 
objects. The mode-options are described in brief below. For more information see Design a Stamp 
Manually. 

●     The Text option,  enables you to insert any text you want in your stamp design as long 

as the selection mode in turned on (the on the toolbar is highlighted).

●     The Lines,  option enables you to draw perfect lines in your stamp design.

●     The option Boxes,  enables you to draw perfect boxes in your stamp design.

●     The Ovals,  option enables you to draw perfect circles or ellipses in your stamp design.

●     The Curves,  option enables you to draw curves in your stamp design.

●     The option Logo's,  enables you to insert any logo you want in your stamp design.

 

Resize

Very often you do not know the exact size of the stamp, when you start typesetting.
SOSET Typeset solves this for you. It finds the bounding of your text and changes the size of the 
stamp into the found values. Shortcut: Ctrl + Shift + S.

The justification as specified for this stamp will remain the same, so centered text will still be 
centered after this option.
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Use this option in combination with the vertical justification option in the Text menu to simplify your 
Typeset.

Warning: Remember that this option only takes entered text into account. So you can not resize 
borders and (other) graphical objects with this option.

 

Center all

This option enables you to center all text in your stampdesign, with a single keystroke.

This option is only available in the SOSET Typeset Gold version!

 

Scale

With this very powerful option you can scale the complete design. This option also scales the 
cutting lines for laser engraving if specified.

Determine the scale percentage with the Scale option also in case the stamps from a certain 
Printgroup don't fit on one page-layout in PageWizard.

This option is only available in the SOSET Typeset Gold version!

 

Send to Foreground/Background

You can move any object to the foreground or the background in your stamp. This way you can 
easily put for instance a textline in front of a drawing line.

In case you need a textline with a filled box at the back, this option is very helpful. You draw a 
filled box. Next to it you draw a line at the desired position of the text and make sure it is white. 
Now you can enter text, overwriting the white line. You should send the filled box to the back, 
using the option in the Properties menu.

This option is only available in the SOSET Typeset Gold version!
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Structure of the database-tables

SOSET uses Visual FoxPro-type database-tables. Select below one of the tables and 
you will find a description of the function and the fields of each of them.

For each database-table you also find on which field is an index with its file-name. This 
index-information is important if you want to query your database-tables.

Some of the files are only used in the SOSET OrderEntry program.

Open Database Structure:
SOSET software offers free access to all data. The Visual FoxPro structure of database 
files is used here.

Experienced FoxPro users can retrieve a lot of information from the SOSET database 
with the help of their own FoxPro applications. Namosoft supplies you with the program 
NamoUtil which allows you to manipulate the tables directly.
Because of intensive table relations, indexing and network security it is required that in 
that case you only use a copy of the SOSET database for such manipulations, instead of 
using the original database-tables used by SOSET.

For the database structure please vistit: http://www.namosoft.nl/structure.htm 
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Reindex
Browse
Check Tables
Change Logo Path
Pack Tables
Preferences
Query
Archiving
Print Barcode Labels

 

Reindex

Displays the Reindex submenu, which is used to initialize the SOSET database-tables 
and re-index the search-fields. You can choose to reindex all tables, a single table or 
an archive stamp table. Re-indexing is usually not necessary, because SOSET 
maintains the production index files automatically when you start the SOSET program 
and enter or modify data.

An index might become corrupted as a result of a system failure, such as a disk error or 
power outage, that prevents SOSET from properly saving changes to disk. Re-indexing 
the SOSET database-tables is recommended after such a situation. Use the reindex 
routine also in case you discover strange results in any search or print routine.

Note: It is a good habit to regularly reindex your database-tables, to avoid problems and 
ensure that the indexes are intact and accurate. We advise you to take a few minutes 
each morning to reindex the tables. 
In a network it is necessary that nobody is using the SOSET program and that all SOSET 
databases are closed. Otherwise the reindexation tables is impossible. A message will 
appear in case NamoSys cannot re-index one or more database-tables.

 

Browse
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Displays the Browse submenu in which you can select a database-table of the SOSET 
program. After selecting one table to browse, you enter a dialog that shows the ID's and 
the descriptions. You can add, edit, or delete items.

Some extra attention is required when entering or modifying the product-table. Enter only 
net-sizes in this table, as SOSET will use and control all this specified space. All the 
examples in the product-table are manufacturer-sizes minus 1 Millimeter (1/32") on each 
side.

Once you have selected a database-table to view, you can view each item by clicking 
the Edit button. If you subsequently make changes that do not satisfy you, you push the 
Cancel button. SOSET will cancel any selection made and will therefore not save any of 
the changes made to the database record. Clicking the Add button will enable you to add 
another record to the selected database table. In case you want to delete a record from 
the database-table, you simply click the Delete button. Selecting the Close button 
returns to the main application.

Product-table

Displays the Product-table which offers the total numbers of different kinds of products. 
For each product you can enter a predicted, a product description, a Searchkey, the 
printsetID. You can also include the size and shape of the product and the size and 
position of the date-area (if applicable). Next to it you can check Color, if the product is 
colored or leave this field unmarked if not, and you can check Typeset, if the product is a 
typeset product and leave it unmarked in case of a stockproduct (F = False).
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Color-table

Displays the Color-table which shows all available colored's and the corresponding 
colors.

Mount-table

Displays the Mount-table which shows all available mount's and the corresponding 
mounts.

PrintSet-table

Displays the PrintSet-table which sets the preferences per printset.
Here you can set and modify settings for output to printing devices but also for laser 
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engraving. You can position the stamp on the page. Decide the size of the unprintable 
margin as well as the size of the separator. The Fixed Positioning option should be 
used with care. This option enables you to overrule PageWizard positioning, if you 
choose to set this field to false.

 

●     Print Title will print PageWizard information on top of the page.
●     Unprintable margin sets the page margins.
●     Separator sets the distance between the stamps in the page-layout.
●     Cut distance sets the distance between the stamp-border and the cutting lines.
●     Lasercutting will display the LaserJet dialog box in Typeset which enables you to 

select a Lasercutting options whenever you update a stamp. If the Contourcutting 
box is selected the Advanced Contour is by default selected in the LaserJet 
dialog box.
Check Lasercutting if you want laser engraving for this product-group, this also 
initiates automatic calculation of the cutting-paths. If you don not want laser 

http://www.namosoft.nl/help/ns_file.htm (4 of 13) [10-Jul-2002 11:51:07 AM]



File Menu in NamoSys

engraving, this field should be unmarked. If you want the cutting-paths for laser 
engraving calculated around the text, you check the Contourcutting-field. If you 
want cutting along the size of the product set make sure this field is not marked.

●     Scale enable you to compress a complete page when you print a page to the 
printer or to the laser.

●     Mold enables you to use, set and print a mold. You can also place ledger-lines in 
the mold if you want to manually align the stamps.

●     Fixed positioning enables you to set a default page layout for the printed
You can start lay-out-positioning of products of the intended group on the start and 
starry position with a delta and delete distance between each product. This means 
that with the Start fields you determine the XY-coordinate or the starting-point of 
the page-layout. With the value for start and starry you enter the start position (X, 
Y) of the engraving (from the upper left of the page). With the Delta fields you 
define the distance between the various products on the page. With the value for 
delta you set the horizontal whitecap between the stamps to engrave. With the 
value for Delta Y you set the vertical whitecap between 

In the SOSET M&R Gold version it is possible to select either Standard M&R Laser 
Settings or Advanced M&R Laser Settings. This means: High quality laser engraving 
with the best of both SOSET and M&R expertise.

The Standard M&R Laser Settings offer highest possible precision, you can expect 
from laser cutting and engraving. Only in special circumstances (for instance in case of 
certain technical problems), you are advised to use the Advanced M&R Laser Settings. 
Both laser settings offer the M&R default settings.
For more information see M&R Laser Engraving and SOSET Typeset.

System-table

Displays the System-table which shows all system-variables or parameters and their 
values. We advise you very much against editing this table.

User-table

Display the User-table which shows all users in the SOSET system (in case of a multi-
user environment).
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For each user you can view the used and the username and access level. Thereby you 
can view and assign the type of user, e.g. remote customer, salesman or expired. In 
case of a remote customer, you can enter the appropriate remote customer. Finally you 
can change the assigned PIN code. 

All users of the SOSET-software need a pin-code in order to get access to several 
functions.These pin-codes enable you to track user-information and to protect the 
SOSET-data with restricted use. This allows a SOSET-supervisor to add, edit or delete 
users for the Soset program. The level attached to the pin-code can vary from 0 to 9. A 
higher level (of course) gives access to more critical functions and can be used to 
overrule a low-level pin-code. These functions can be specified as follows: 

●     level 9 allows unrestricted access to ALL Soset functions
●     level 8 allows access to Maintain functions in OrderEntry, access to NamoSys 

functions, Restore Shipment run, Restore Invoice run, Exit NamoKey, edit of 
global preferences

●     level 7 reserved for future use
●     level 6 allows invoicing,history and sales reports
●     level 5 allows editing Order, Customer and Product-data
●     level 4 allows Shipping options,Typeset delete, PageWizard functions
●     level 3 access to all Typeset options
●     level 2 view options in Typeset options
●     level 1 reserved for future use

Notes-table
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Displays the Notes-table which gives information about the notes which are saved on 
behalf of SOSET Quick Typeset.

Laser Table

Displays the Laser-table which shows all of the available lasers.

When using a LMI laser leave the RX box unmarked. Now SOSET will make all the 
necessary calculations to "laser-enable" the stamps. 

When you use an Universal laser you have to mark the RX box. You can then specify 
the default printer driver used by this laserID (the printer driver has to be installed in 
Windows). All calculations are now being done by the laser-driver.
For more information see M&R Laser Engraving and SOSET Typeset.

Laser Settings table

Displays the Laser Settings-table which enables you to specify for every printset ID a 
different laser ID. For each laser ID you can specify the Power and the Speed.
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●     Raster Engraving sets the way your stamp is engraved
●     Vector Engraving sets the way your cutting lines are engraves

 

Check Tables

Check up your tables on any inconsistencies. This usually only has to be done in case of 
severe problems. This option may cause deletion of corrupted data!

For advanced ways to repair corrupted tables use the NamoUtil program

 

Change Logo Path

Moves your logo directory. Typeset uses external logo's to save disk space. Moving a 
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logo to another directory might result in stamps without the specified logo. This option will 
search in ALL stamps for the old logo path and replace it by the new specified logo 
path.

This option is only available in the SOSET Gold version!

 

Pack Tables

No more packing!
Wrong usage of this option causes corruption database tables or massive loss of data.

The packing option in the NamoSys program has been disabled. This option is originally designed to reorganize 
files and to delete records with deletion marks to create space. Packing takes away the option to check 
deleted records and restore deleted data in order to solve occurred problems.

Instead we recommend to contact NamoSoft for help with reorganizing files and records.

 

Preferences

Displays the Preferences dialog box, which enables you to set the settings of you 
SOSET application.
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●     SOSET Data Path displays where all stamp-data is stored in your system. Make 
sure that in a network all SOSET Typeset users have the same setting shown 
here. This path cannot be changed here it is the first parameter of each SOSET 
program command-line.

●     Ruler Units switches between inches and millimeters.
●     (Removed option in NamoSys preferences) Date Order and Date Separator:

SOSET now uses the date setting from Windows. To change the settings in 
Windows goto the Regional Settings icon in the Control Panel. You can specify 
the date order (either Day/Month/Year or Month/Day/Year) and the kind of date 
separator you prefer (either slashes or points).

●     Barcode labels enables you to set the Barcode labels:
❍     Columns refers to the number of labels you want to print next to each other.
❍     Rows refers to the number of labels you want to print vertically on the page.
❍     Start X and Start Y enters the start position of the bar-code printing (from 

the upper left of the page). You should define the label width and label 
height here as well.

❍     Delta X sets the horizontal whitecap between the barcodes to print.
❍     Delta Y sets the vertical whitecap between the barcodes to print.

●     Modem displays the Modem dialog box which enables you to enter the 
Preferences settings.
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You can set the port, the parity, the baud, the data and the stop 
bits.(Standard settings for these preferences are: for the parity: none, the 
baud: 2480, the data: 8 bits, and the stop bits: 1 bit.). These settings 
normally have to be set only once, since they import/export stamps to the 
same host.

Note: Make sure that all preferences settings (except for the port: COM1 
through COM8, which can be different for every computer) are similar for 
both the host side and the remote side. The best way to attain matching 
preference settings between the two operations is to check and adapt these 
to one another over the telephone.

 

Query

Creates a new Query or use one of the pre-defined queries. Use the power of your 
database-system and get all information out of it with a query.

Select a table to analyze, a list with all fields of that table appears. First you select one or 
more fields to view by double-click or click one of the arrows. If you do not set a filter 
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than you will get a list of all records in the selected database-table.

To set a filter highlight one of the fields on the right side of the query-dialog and click the 
filter-key. You will be prompted to enter a start- and end-value for this field. It is possible 
to set more than one filter.

SOSET will produce a list on your printer with the specified data. At the same time 
numeric and data fields are summed and averaged. You can save a query for later use.

In the Overviews menu you will find a user activity query.

Use the NamoUtil program for more advanced utilities to scan and query your databse-
tables.

This option is only available in the SOSET Gold version!

 

Archiving
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Offers an efficient way to archive stamps. SOSET keeps stamps in SOSET-type stamp 
files, to make search very easy. In the appearing dialog you can specify which stamps 
will be deleted and which stamps will be saved in the archive database. The Find > 
Archive command in the Record menu in Typeset enables searching these stamps.

This option is only available in the SOSET Gold version!
Note: The archive-option in SOSET NamoSys and SOSET NamoUtil are not designed to create space and 
will only slightly compress data.
In general we do not recommend to delete data and/or files to generate diskspace.
Harddrives come with huge volumespace and database-systems are designed to handle large volume tables.
Searching for information within SOSET is faster than any other search. By simply entry of jobs, the data are 
simply build up and should be used.
The archive-procedure  is meant to get archive-files for each year and to enable you to isolate these.
The archive-procedure also checks data and correct errors and re-write the job-files, which improves disc-
access and usually optimizes the performance of databases in general.

To prepare your tables for archiving use the NamoUtil option:"SOSET Utils > Production status update" (to 
activate use pincode 7676).
When this command has finished you can archive stamp via the Archive option in NamoSys.

 

Print Barcode Labels

Prints the barcode labels. Barcodes support a fully controlled production process. You 
enter the first and the last number in the appearing dialog.

This option is only available in the SOSET Gold version!
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PageWizard Help
To get information select an item in the table of contents or click the appropriate item in the screenshot.

Table of Contents:

●     Getting Started SOSET PageWizard
●     File Menu in PageWizard
●     Edit Menu in PageWizard
●     Options Menu in PageWizard
●     View Menu in PageWizard
●     Window Menu in PageWizard
●     Help Menu in PageWizard
●     Toolbar in PageWizard
●     Statusbar in PageWizard
●     Rulers in PageWizard
●     Shortcuts in PageWizard

PageWizard Screenshot:
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Getting Started SOSET PageWizard

The PageWizard is designed to make page-layout very easy! Here you will find help on 
the following items:

From the SOSET folder you click the PageWizard icon. To prepare output of a specific 
range of stamps select one of the options from the File menu.

Stamps designed in Typeset can be selected on typeset status or on selection-options. 
The Get all entered stamps command will select newly entered stamps and output these 
including the order-number, for efficient proofreading. When you use the Get all 
entered Stamps command you are prompted to selected the user(s) whose stamps you 
want in PageWizard.

With the Get corrected stamps command you can choose if you only want to produce 
stamps of a certain printset, e.g. output pre-inked stamps or any other group of stamps 
you want to produce.

After a selection you can preview the page-layout on which you will recognize the shape 
of your stamps. You can change this page-layout, but it is not necessary. PageWizard 
fits stamps as good and economical as possible on a page.
With a right mouse click on a stamp you will get the following information of the stamp:

●     Printgroup
●     Status
●     Quantity
●     Product
●     Color

Each seal is shown twice on the page. The counter is always being displayed on the right 
side of the page (to you). The die is shown on the left of the page. You can move a seal, 
but you cannot change the fact, that the counter is always positioned to the right of the 
die.

In case you want to change the page-layout, you can do the following. You can select 
one or more stamps on the page-layout. The selected stamps can be moved, rotated, 
copied and pasted to any place on the same or on another page.

When you press the delete key you do not delete the selected stamp(s), but only exclude 
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these from your current print-run.

The PageWizard can be started at any moment, also in a network environment. You can 
see if there are enough stamps ready for production by making your selection and check 
the previewed pages.

Only when you choose to print the previewed pages, PageWizard will prompt you to 
change the typeset status of all stamps on the pages into In Production.

The print-procedure will not only produce an efficient layout for production but also 
notes with a barcode and stamp impression on it for production control, you also can 
choose to have a list printed.

Print/Selection. 

●     When printing after Get all entered stamps you will be asked: Update status of 
stamps? In case the printer printed all pages correct, answer Yes. SOSET will 
now change the status of all printed stamps of this run into: Proofreading

●     Printing after Get Corrected stamps you will get a dialog where you can choose to 
print runcards with a barcode on it.
SOSET prints a runcard for each item entered. These run cards can be used to 
enter proofed, completed, or shipped status easily with an inexpensive barcode 
scanner. This automates your system and allows you to instantly track the order. 
When the order is confirmed as shipped, this information is available to link to your 
billing/accounting system, or for even more control in SOSET OrderEntry.

You can also decide to have a specified overview of all printed stamps. After 
printing, you will be asked: Update status of stamps? In case the printer printed 
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all pages correct, answer yes. SOSET will now change the status of all printed 
stamps of this run into: In Production

Run-Number.
Each time the PageWizard prints stamps to a page; all the printed stamps get a run-
number. The run-number increases with 1, each time a run is started and will be 
overwritten.

The run-number enables you to get all stamps of a selected run. SOSET PageWizard 
will lay-out the stamps of this run, so the positioning may be different in case stamp-sizes 
or quantities have been changed.

Saving the page lay-out with the Save command from the Options Menu will save the 
exact positioning of the stamps on the page.

Warning: the size of the stamps or the quantity in that saved page-layout might be 
changed. If indeed stamps on a saved page are edited reprinting that page would bring 
quite some problems.
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File Menu in PageWizard

New/Close
Get All Entered Stamps
Get Corrected Stamps
Get Stamps On ...
Export
Print
Laser Engraving
Preferences
Send Message

 

New/Close

Starts and finish a new print-run in the PageWizard. Shortcut: , Ctrl + N.
During a print session in the PageWizard all stamps are marked to prevent editing of 
stamps which are being printing in PageWizard. Close will unmark all these stamps.

In case of an abnormal program termination, while running stamps in PageWizard, the 
stamps remain in the PageWizard status. This status however prohibits editing. During 
the Get stamps on... run in PageWizard, stamps cannot be edited, for obvious reasons. It 
is impossible to change the status of the stamps in Typeset, when the stamps are 
(supposed to be) in PageWizard.

This problem can be solved. You select Reset PageWizard status in the Utilities menu 
in NamoSys. SOSET asks you if you are sure to reset the PageWizard status. If you 
click OK, the stamps are released from PageWizard. Now they can be edited again 
(including changing the status) in SOSET Typeset.

Be very careful with this option: if another SOSET user is working in PageWizard, while 
you reset the PageWizard status, the possibility exists that stamps are being edited in 
Typeset, while at the same time being runned in PageWizard. This causes problems.

This option is only available in the SOSET Gold version!
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Get All Entered Stamps

If you choose to get all newly entered stamps, all stamps with typeset status Entered, 
Remake and SOSET Import are selected from the stamp table. You can select the 
entered stamps per user. This will not result in an optimum page-layout.

You will get every stamp only once, even if the quantity is more than one. This print-run 
is meant for proofreading only. During this run the stamps are selected in chronological 
(entry-)order.

Print in the file menu will print the previewed pages.

On the output you will find the following information: 

●     On top of the page: Date, Runnumber, Pagenumber
●     Stamp impression
●     Order-number of this stamp
●     Product
●     Status

The question: Update the typeset status of the printed stamps? can normally be 
answered with OK, and PageWizard will automatically change the typeset status of the 
printed stamps from Entered into Proofreading. Answer this question with Cancel in 
case your printer does not output properly. With the original copy of your customer's 
order you can start proofreading now. Correction can be done on screen in Typeset. 
After proofreading you change the status with the Status command from the Properties 
menu in Typeset into Corrected .

Note: This overview is only to verify that all stamps are correct. To get an overview for 
production use the Get Corrected Stamps command (this overview only contains the 
stamp and no stamp information).

 

Get Corrected Stamps
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After proofreading of all (but also of some) of the entered stamps you (or any other user 
in a network) can change the typeset status in Corrected. Then you can decide to 
perform a Get corrected stamps run in PageWizard. The Selection of Corrected 
Stamps dialog appears.

You can now specify which stamps you want to get. You can select the printset as well 
as the color. You can e.g. choose to only get pre-inked stamps in red and blue or other 
selections. Read the browse chapter in NamoSys. in the help-manual on how to add and 
modify print-options to the Printset-table.

Choose Printset Select All in case you want to have all corrected stamps printed.
Choose Color Select All in case you want to have all colors printed.

You can get only corrected stamps and/or delayed stamps in case you have used this 
status option in Typeset.

You can also select two types of stamps: you can include typeset items and/or stock 
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items.

The PageWizard will now select all stamps from the database-table and sort them by 
type and size and layout them on the page(s).

 

Get Stamps On ...

Displays the Get stamps on submenu, which enables you to select stamps by the 
following options: 

●     Ordernumber
●     Searchkey 1
●     Searchkey 2
●     CustID
●     Runnumber
●     Status
●     Pagenumber

Pages made by one of these options will generate a Printset error message because the 
printset of the stamps are not set when selected by these options. You can set the 
Printset by selecting the Printset current page command in the Options menu.

Note: As these options are only meant for overview-reasons, you will NOT get an 
efficient page layout, the stamps are printed in chronological order. However with Get 
stamps on page-number you will get the stamps positioned as saved. During these 
print-runs the typeset status of the stamps is NOT changed by the PageWizard.

This option is only available in the SOSET Gold version!

 

Export

Displays the Export submenu, which enables you to export the pages current loaded in 
PageWizard to a TIFF-file. Shortcut: Ctrl + J
This data in PageWizard can then be used be other programs.
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Print

This will prompt you to enter one or more, or a selection of previewed pages to the 

printer. Shortcut: , Ctrl + P

Note: Printing during the All entered stamps-run will by default print all pages. Printing 
during the Corrected stamps run will by default only print the current page. You can 
overwrite the page settings in the print-dialog.

 

Laser Engraving

Starts the sending the current page(s) to the M&R Laser Engraver. Shortcut: 

This option is only available in the SOSET Gold M&R version!

 

Preferences

In the PageWizard Preferences command , you can set the default PageWizard options 
to your own requirements.

Note: Starting version 2.8 of Typeset several preference-settings can not be set global 
anymore. Now these settings are added to the Printset-table to specify preferences per 
Product-group.
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●     The SOSET Data Path specifies where the database directory is located. This is 
installed during set-up and can not be modified. The path is a parameter of the 
command line for SOSET PageWizard.

●     In the Runcards Printer section you specify a printer for the runcards, in case you 
want these printed on a second printer. The default runcards printer is the default 
printer as specified under Windows print manager.

●     Ruler units lets you choose mm's or inches as your favorite sizing. For precise 
information concerning units see inches and millimeters conversion.

●     In the PageWizard Parameters section you specify the following:
❍     Page Title Fontsize
❍     Grid-settings to fix the stamp-movements.
❍     Undo steps. When you manually alter the page layout, you can use the 

Undo command to reverse the last change to a page. This number must lay 
between 2 and 10.

Note: the larger the number the more memory PageWizard needs. This can 
slow down the performance of your computer.

●     In the Runcards parameters section you set the Fontsize, Size and Barcode 
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(both width x height) for your run cards. Sample Stamp Height is the size of the 
impression on the run card.

●     Selecting Page per Color will print pre-inked stamps separated by color.
●     Selecting Page per user will print (only new entered!) stamps sorted by user to 

simplify proofreading.
●     Selecting Select all users will result in selecting all users by default when you start 

a Get all entered stamps run.
●     Selecting Rush order will print only stamps, you have assigned one of the rush 

status to in Typeset. This means the page layout is not optimized and you will 
NOT get an efficient page layout, the stamps are printed in rush order.

●     Date Order and Date Separator:
SOSET uses the date setting from Windows. To change the settings in Windows 
goto the Regional Settings icon in the Control Panel. You can specify the date 
order (either Day/Month/Year or Month/Day/Year) and the kind of date separator 
you prefer (either slashes or points).
Important: the date settings marked in this dialog are NOT used anymore by 
SOSET.

●     In the Lasercutting section you specify the Cutting color with its value. You 
specify the color for one or more lines in a stamp, which will be recognized by a 
laser-engraver as line(s), which must be cut out. You can set the color to Red, 
Green or Blue or any blending of these colors. You can enter a value from 0 to 
255. As soon as you set the cutting property of an object, the object will get this 
color to let the laser-engraver do the cutting of this object.

●     Output button specifies the print options

· Photographic negative changes black into white and vice versa
· Mirror image mirrors the printed page
· Resolution sets the clarity of the printed page.

●     M&R button. The M&R Settings are special laserengrave options to enhance 
efficiency and speed.
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You can select the following: 

●     Compress data 
●     Trim non engraved left and right sections skips empty space on a 

page during engraving.
●     Environmental-friendly rastering skips non engraved sections.
●     Speed up during non engraved areas.
●     Combine cutting lines

Note: For cutting during laser engraving on some flatbed-laser engravers the 
color setting in PageWizard must be the same as the cutting color setting in 
Typeset.

 

Send Message

Communication is very important in the rubber stamp industry. In SOSET it is possible to 
send messages to users in the network. SOSET offers a very easy and efficient way to 
mail users, known in the SOSET User-table.

Just click the Send message option, select the user(s) in the network you want to mail 
and enter the message. All SOSET software checks the mailbox and warns the logged 
user(s) when there is mail. When the user is not logged in, the mail remains in the box 
and will appear during next login of this user.
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Mail in the mailbox can only be deleted by its user.

This option is only available in the SOSET Gold version!
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Utilities Menu in NamoSys

Lasercut circles/rectangles
Reset PageWizard Status
ASCII/ANSI Conversion and vice versa
Generate Remote license file

 

Lasercut circles/rectangles

Displays the Lasercut circles/rectangles dialog box in which you can select Lasercut 
circles/rectangles, and set the lasercutting preferences. After you made you selections 
you press OK to start engraving the circles or rectangles. 

●     X-position and Y-position determines the start-position, from which the laser will 
start engraving.

●     Select Circles or Rectangles. In case you select Circles, you have to enter the 
diameter of the circle

●     In case you select Rectangles, you have to enter the width and the height of the 
rectangle.
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●     You set the power, speed and pulse for efficient and precise laser engraving.
●     Furthermore, you have to decide how many circles/rectangles you want to engrave 

from the top to the bottom of the page (# Hor) and from the left to the right side of 
the page (# Ver).

This option is only available in the SOSET Gold M&R version!

 

Reset PageWizard Status

Resets the PageWizard status of stamps. This command should be used with GREAT 
care! It exists only for one reason. In case of an abnormal program termination, while 
running stamps in PageWizard, the stamps remain in the PageWizard status. This 
status however prohibits editing. During the Get stamps on...run in PageWizard, stamps 
cannot be edited, for obvious reasons. It is impossible to change the status of the stamps 
in Typeset, when the stamps are (supposed to be) in PageWizard. This problem can be 
easily solved.

If you select Reset PageWizard status, SOSET asks you if you are sure to reset the 
PageWizard status. If you click OK, the stamps are released from PageWizard. Now 
they can be edited again (including changing the status) in Typeset.

Be very careful with this option: if another SOSET user is working in PageWizard, while 
you reset the PageWizard status, the possibility exists that stamps are being edited in 
Typeset, while at the same time being runned in PageWizard. This causes problems.

You can also reindex the status-table, with the Reindex command. This command is not 
recommended to solve the before mentioned problem.

This option is only available in the SOSET Gold version!

 

ASCII/ANSI Conversion and vice versa

Converts *.DBF and *.TXT files from ASCII to ANSI or vice versa.

This option is only available in the SOSET Gold version!
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Generate Remote license file

Creates a REMOTE.SOS file, which must be used for the Remote Typeset user.

IMPORTANT: Owners (only!) of a 5, 10 or 20 user SOSET Typeset Gold software have 
an option in the NamoSys program to create a special REMOTE.SOS file for activating 
the SOSET Remote Typeset software. This file should be placed in the license-path of 
the SOSET typeset remote installation.

To distribute a SOSET Typeset Remote version do the following: 

Create a remote.sos file. You do this in SOSET namosys> utilities> generate remote 
license file.
Although the min. and max. remote No. are not in use right now, it is required that these 
fields are filled in (8 digits). The telephone number must be filled in to.
Copy the remote.sos to a floppy disk.
On the remote location you can now run setup to install the SOSET typeset remote 
(during setup you can choose "Remote Typeset").
Write down the license path which can be specified during setup
After setup you need to copy the remote.sos file from the floppy disk to the license path
When you create the remote.sos SOSET Namosys will automatically copy SOSET tables 
in the \data\soset\remote directory. You need to overwrite the demo tables on     the 
remote side with these tables. This way you make sure that both you and the remote 
user have the same technical information in the database (e.g  color data,          printset 
data, etc.).
Keep in mind that a remote version can't be used for production. The output is gray and 
cannot be recovered.
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Typeset Status

All stamps entered via SOSET Typeset in the database are controlled by a Typeset 
status. There are about 25 different status-options. Some of these options are 
automatically set during several operations. Other status-options have to be changed 
manually.

All status-options can be changed with the Status command in the Properties menu to 
change the status of only the current stamp or with the Change Status command in the 
File Menu to change the status of one or more stamps.

The Typeset Status Overview:

Status Description
0 Entry During entry or edit, the status is Entry to avoid printing during 

editing.
1 Entered After entry the status becomes Entered. The stamp is now 

available for the next Entered-stamp-run in the PageWizard.

2 Proofreading After printing entered stamps in PageWizard, SOSET 
automatically changes the status of the stamp into 
Proofreading.

3 Corrected This status is set by operator after proofreading. The 
Corrected status will set the stamp available for next 
production printrun.

4 Delayed To delay stamp for later production. Selection of Delayed 
stamps is available during printruns in PageWizard.

5 Not delayed To undo the delayed status choose Not-delayed.
6 Deleted Stamp is marked for deletion. This means it will be Deleted 

during next system-check.
7 In production Stamp is In production. Status is automatically set when 

corrected run is performed.
8 Too long Stamp is Too long and needs to be revised by customer.
9 In Box Stamp is produced and ready for next shipment. Only if all 

stamps-/order-items are In box the status will be automatically 
changed into Ready to ship.
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10 Proof/Embargo To put the stamp on hold for later production.
11 Ready to ship This stamp is Ready to ship. Only if all stamps-/order-items are 

in boxes the status is changed into ready to ship.
12 Shipped This stamp is Shipped. 
13 Ready to modem A stamp with this status is ready to modem, during a modem 

session. See also: the Modem menu in NamoSys to transfer 
files by modem.

14 SOSET-DOS Import Status set after import of SOSET-type DOS files.
15 Processing During printing and other operation, SOSET changes the 

status into Processing. The stamp cannot be edited.
16 Remake At any moment during production anyone can change the 

status into Remake. The stamp will be on the next printrun for 
proofreading as any newly entered stamp. The remake type 
can be registered.

In case the order has the status Ready to ship, the remake 
status will automatically change the status of all other parts of 
the same order back into In box.

17 Template Select this option to save a design for duplication. A 
record/stamp with Template status can not be edited.

18 Labels In PageWizard you can automatically create Labels for your 
stamps. The label information/design is stored in a stamp.

19 Partly in box In case quantity is more than 1 and not all stamps are 
produced/ in box/ready to ship, choose Partly in box.

20 Quotation A quotation has been submitted, but awaits a reply.
21 Purchased Order-items have been purchased, but are not yet available
22 Hold for answer The order is held until customer's approval.
23 Not in stock The products for this order are not in stock, and therefore have 

to be ordered.
24 Hold for proof The stamp is held for later production, after the proof print is 

approved of.
25 Credit hold The stamp is held for production until the customer has proven 

his credibility.
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26 Quick Export This stamp is entered in Quick Typeset. When this stamp is 
exported to Typeset, the status in the Quick Typeset will 
change to in production.

Note: The status of stamps in PageWizard procedures can not be changed, the change 
status procedure will warn, that in this case the status is NOT changed. Status change 
can be much more efficient and accurate if you use a (guntype) bar-code scanner.

When set in the Global Preferences the following sub-status options become available 
when a stamp gets the In Production status:
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File Menu in Typeset

Here you find the usual Windows-options. However you will NOT find options to Open, 
Save or Save as, for the database (file) management is completely performed by the 
SOSET system.

New records are automatically sorted into the database. You can find them in the 
database-tables immediately after updating the newly entered or corrected stamps in the 
Record menu.

New
Import
Export
Additional Information about SOSET-Import/Export Operations
Print
M&R Laser Engrave
Change Status
Global Preferences
Local Preferences
Hotkey
Typeface Overview
Send Message

New

This option gives you access to the SOSET Typeset Stamp-table. All stamps are stored 
in this database-table.

By starting SOSET Typeset, you automatically open the SOSET Stamp-table. This gives 
you a screen view at one stamp at a time. In case you want to work with more than one 
stamp at a time, you click the New command in File menu for every stamp you want to 
view.

By opening this database-table, you can view other stamps. This will enable you to 
switch to or work in more stamps at the same time. You can choose between two 
screens that overlap each other or that can be seen simultaneously next to each other. 
Just use the Window menu options: Cascade or Tile
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In the SOSET Quick Typeset version you can choose from the Quick-Entry screen and 
the typesetting screen. The Quick-Entry screen enables you to import textlines in existing 
stamps, automatically stored in the database-table. However if you need to perform 
typesetting operations, you just click the typesetting screen-option in the New submenu 
of the File menu.

This option is only available in the SOSET Typeset Gold version!

 

Import

SOSET can import files in several formats.

This option is only available in the SOSET Typeset Gold version!

Import SOSET DOS:
SOSET provides a special import filter for SOSET DOS. You can import data that is 
made in this SOSET DOS format. This option can also be used for other order entry 
systems, as long as you stick to this particular format. The layout of the DOS-file is 
standardized and available to SOSET customers. See Import Interface File Version 2.89 
for details about this special format.

Import SOSET Windows:
With this option you can import stampdata that has been created on another (remote) 
station that uses SOSET Windows-based software. This remote station exports the 
SOSET data (with the Export SOSET Windows command from the File menu), and you 
use the Import Soset Windows command item to import the SOSET Windows data.

Note: In case you use the SOSET Windows Import option be sure that both the 
exported files (Stamp.dbf and Stamp.ftp) are copied to the same directory. You need 
both files in the same directory to be able to read the imported records correctly. 
Information concerning order entry and customer information is primarily stored in the 
table Stamp.dbf. In the table Stamp.ftp the information stored is mainly related to stamp 
design.

After selecting the database-files, a dialog appears on your screen. On automatic request 
of SOSET you can assign a remote customer-ID to a remote branch or customer, 
who wants to import a Windows file in SOSET.
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If you do not fill out the remote customer-ID, SOSET will simply copy the customer-ID 
and the customer-information belonging to the different stamps, as entered by the remote 
side.
However, you can rename the customer-ID by entering a remote-customer-ID. SOSET 
moves each original customer-ID of the imported stamps into the customer information 
field and replaces all these different customer-ID with the remote customer-ID. This way 
all imported stamps have the same customer-ID, which facilitates for instance correct 
shipping and invoicing to this remote customer.

Warning: If you do not fill out the remote customer-ID, SOSET will copy customer-ID and 
customer-information as entered by the remote side. This might cause problems if you 
want to ship and invoice the stamps to one and the same address (in this case the 
address of your customer!). SOSET will come with a message to warn you of this 
possibly confusing situation!

Import from ASCII or ANSI Textfiles:
In case you want to use texts from an ASCII- or ANSI-data-file (e.g. provided by your 
customer) to create new stamps, you should use here the Import ASCII/ANSI command.

The import option is also very helpful in case you have an order for multiple stamps that 
differ only in one stamp-textline (or more textlines). You can think here of simple stamps 
with the same style, but with different names.

It is important that the file you want to import is a so-called DOS-Text file, it may not 
contain any word processing commands. A DOS-Text file can be created with the help of 
a DOS-editor, like Edit.exe. All modern word-processors offer the option to save a file as 
DOS-text (and thus with the extension .TXT).

In this file you enter the text that you want on your stamp. The first line is the (changing) 
text of the first stamp, the second line is the (changing) text of the second stamp, and so 
on.
In case two lines have to be changed in each stamp, you type these two lines in 
succession in the textfile. So, you have to enter text per stamp and not per line. Make 
sure that the last textline of the textfile contains actual text. To know this for sure, you 
can, while positioning your cursor behind the last letter of the last textline in the file, press 
the down-arrow key at the keyboard and delete the lines that are redundant.

Further it is important to know what type of characters you have in your file. In case the 
file is made in any Windows-application than you will probably have an ANSI-type of file. 
Under DOS created files are ASCII-type of files.
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Import text from a .TXT file: 

1.  Create a template to which the texts from the file will be added. You also can 
choose one of the stamps in the SOSET database and duplicate and modify its 
design. Keep in mind that textlines from your file will be added to the end of any 
text-segment in the stamp-design. During the import-session SOSET will copy all 
properties of the template, including the order-number. Only a rising item number is 
automatically added to each new stamp. In case texts are too long, SOSET will use 
auto-compression to make the text fit in the stamp-size.
Important: the textlines in the template may NOT be empty.

2.  You enter the order/stamp and have it displayed on your screen in SOSET 
Typeset. Then you select the Import ASCII/ANSI command from the File Menu. 
You open the appropriate textfile and click OK. SOSET will ask you if the file 
contains ASCII (or ANSI) information. Choose Yes or No.

3.  Then SOSET asks you whether the first textline in the stamp corresponds with the 
first textline in the TXT file. If so, choose Yes.

4.  If your template consists of more than one line, SOSET will prompt for every 
textline if it corresponds with a textline in the TXT file. Answer accordingly.

5.  SOSET then asks you whether the format should be adjusted (from the textfile to 
the stampdesign). Choose 'No' in case you have e.g. put a border around your 
stamp template. If your stamp only consists of plain text, you can choose Yes here.

6.  After these questions SOSET sums up the entered information. You can Cancel 
the import or you can click OK.

7.  SOSET will start importing text as soon as you have confirmed your answers to the 
above mentioned questions. Now you can start or finish typesetting the stamp.

8.  Notice that the partnumber of all the imported stamp is 000.
9.  If additional typesetting is necessary you finish designing the stamps as any other 

stamp.
10.  Now you must copy the first stamp with partnumber -000 into the stamp with 

partnumber -001. You then delete the stamp that you have copied. This in order to 
have a partnumber (or orderitemnumber) attached to the ordernumber. This 
facilitates adequate scanning the bar codes and retrieving the stamps in box. Now 
production of these stamps can start without delay.

Import Logo:
Enables you to import logos directly into a stamp. This option works the same as the 
Import from ASCII or ANSI Textfiles option accept that it import logos instead of 
textlines. This means you can select more than one logo at the same time.

http://www.namosoft.nl/help/tp_file.htm (4 of 16) [10-Jul-2002 11:51:13 AM]



File Menu in Typeset

To import logos to the following: 

●     Make and update a new (empty) stamp.
●     Select the logos you want to import.
●     Typeset will make a new stamp with partnumber 000 for every selected logos.
●     After import you have to copy and past the first stamp, with partnumber 000 to the 

empty stamp. This way the new stamps will be included in the production process.

Import TOP:
SOSET provides a special import filter for Mindware's TOP OrderEntry. This option can 
only be used when you have Mindware's TOP OrderEntry managing you order execution 
and you want to use its order-information including the design information.

 

Export

SOSET Typeset can export stamps in .DBF (.FPT), in WMF-format and in TIFF-format:

This option is only available in the SOSET Typeset Gold version!

Export to Windows:
Exports stamps from your database to a SOSET Windows-export file. You can export 
the current stamp to SOSET Windows. You can also export stamp(s) on status to 
SOSET Windows. This means that the export is done by typeset status.

You will be prompted to select a status and enter a path and filename. SOSET will export 
all stamps with the specified status, in case they have not yet been exported. A stamp 
can only be exported ONCE. The exported file (in fact 2 files: Stamp.dbf and Stamp.fpt) 
can be imported in another SOSET Typeset application.
You can reset exported stamps by unmarking the export flag in the Properties menu.

Note: To avoid overwriting existing stamps, please make sure that you have reserved a 
wide range of order-numbers.

Export to WMF:
Exports in the WMF-format which is a very popular standard in Windows metafile style. 
Use this option also if you want to import a SOSET stamp into another SOSET stamp, 
e.g. a circular text within a straight stamp.
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Export to TIFF:
Export in the TIFF-format which is a very popular bitmap format. Use this option also if 
you want to import a SOSET stamp into another SOSET stamp, e.g. circular text within a 
straight stamp. In the appearing dialog box, you select the file name to export. You also 
have to define the resolution, the scale and whether the image should be in 
photographically negative or mirrored. Click OK to start exporting the selected file.

 

Additional Information about SOSET-Import/ Export Operations

To avoid double order-numbers or overwriting existing order-numbers please make good 
appointments about the range of order-numbers used at remote and at host side. In order 
to get the same basic data (like products, colors, mounts etc.) on both sides you need to 
copy all databases from host-side to the SOSET-DATA directory in remote-side.

It is advised to copy Product.dbf (and belonging Product.fpt), Printset.dbf, Colour.dbf, 
Mount.dbf from time to time to the remote side in order for both sides to have the same 
up-to-date information. After copying please run the Reindex in NamoSys. Possibly you 
prefer similar preference settings for the remote and the host side. The best way to attain 
matching preference settings between the two operations is to check and adapt these to 
one another over the telephone.

 

Print

This option is to enable printing the current stamp design to your printer. Shortcut: , 
Ctrl + P.
Output includes stamp information and can be used as a proof print for you and your 
customer. In order to print more stamps and to have a page-layout made, you need to 
start the PageWizard program.

Users of SOSET Remote Typeset will see a gray background on their printed output, 
since they do not need production quality.
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M&R Laser Engrave

Important: this option is only available in the M&R laser engraver version of the SOSET 
Typeset software.

Make sure that the laser engraver and its exhaust are installed correctly and ready to 
engrave stamps, signs or seals. Power-, speed- and shoulder-settings are specified in 
the Printset-table and can be adjusted per product-category in the Browse command of 
the NamoSys program.

Several settings are already defined during the SOSET setup, but a check and test 
is strongly recommended.

On the File menu you choose the option M&R laser engraver or click on the M&R 

button,  in the Toolbar.

If you are using am Universal Laser a printer dialog will appear. Click on Options button 
to get an overview of the laser settings. You can alter the settings manually or you can 
load a previously saved setting file.
See the Universal Laser Manual for more information.

If you are using a Lmi Laser you will get a dialog which displays the Engrave position. 
You can enter the X- and Y-coordinate (upper left = 0,0) to define the starting point of the 
laser engraver. The laser will start at this position with the engraving of the current 
design. The entered quantity does not have any effect to this procedure, as this option 
will engrave the product only once. To engrave the desired quantity you need to start 
laser engraving from within the PageWizard program.
You will now get the SOSET SuperShoulder Driver screen, which gives actual stamp 
data and informs you about the laser engraving process.
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Change Status

With this option you can change the status of one or more stamps in a very easy way.

Change status On Orderno and Partno will open the dialog box and shows all status-
options.
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The status of the entered order-numbers will be changed into the status you set here. In 
the field order-number you must enter the complete order-number, including the item 
number, in total 9 digits (no dash!). You will find these complete numbers on all run cards 
or forms provided by the SOSET system.

In the boxnumber field you can only enter data in case you have selected the In box 
status. Use this status-update as a preparation to the shipment. Every time a stamp or 
order-item is finished you read the order- and item-number from the run-card and the 
number on the box. SOSET will check if all items of this order have the In Box status and 
if so automatically update all items of this order from In Box to Ready to Ship.

SOSET will also help you to check the quantity per order-item. For instance, you have an 
order-item with a quantity more than 1. Every time that you have a part from the order 
ready for shipment and want to change the status into In box; you have to answer the 
question: "Part of this order-item is already in boxno., order-item completed?". This 
procedure guarantees the order to be complete before shipment. You can check the 
quantity until completed. After every entry SOSET will search for the order-number and if 
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found shows the previous status and confirm a status-change. You can leave the update 
session by choosing the Cancel-option.

Change status On Order-number or Run-number will show a list of all the stamps with 
the selected order number or Run number. You can select one or more stamps in this 
list, by simply click the item. Clicking OK will show all status-options. Make your choice to 
change the Typeset Status of all earlier selected stamps.

Note: The status of stamps in PageWizard-procedures can not be changed, the change 
status procedure will warn, that in this case the status is NOT changed. Status change 
can be much more efficient and accurate if you use a (guntype) barcode scanner.

This option is only available in the SOSET Typeset Gold version!

 

Global Preferences

Global Preference settings are valid for ALL users working with the SOSET programs. 
Only applicable for multi-user version.

Specifies if you want to use the Production sub-status. If this option is marked every 
time a stamp gets the status In production a dialog will pop-up which lets you specify a 
sub-status.

Choose one of the following sub-status (you cannot add a new sub-status to this list):
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Note: Changing of these settings will apply to future operations only.

 

Local Preferences

Set the local preferences to change the default settings in SOSET Typeset and 
customize Typeset to your own requirements. Each time you design a new stamp 
SOSET Typeset will start with these settings. However you can always change these 
settings for each stamp in its own design.

Local Preference settings are ONLY valid for the local user working with the SOSET 
programs.
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●     SOSET Data Path shows where all stamp-data is stored in your system. Make 
sure that in a network this directory is shared and all SOSET Typeset users have 
the same setting shown here. This path cannot be changed here. It is the first 
parameter of each SOSET program command-line.

●     Ruler Units enable you to select inches or millimeters. For precise information 
concerning the inches and millimeters conversion see Inch/Millimeter Conversion.

●     Default Stamp Size sets both the shape (straight, round or oval) and the size of 
the default stamp (width and height).

●     Default Font selects your most used font in its inch/mm size or typographical point-
size. For precise information concerning the inches and millimeters conversion see 
Inch/Millimeter Conversion

●     Lasercutting color specifies the color for one or more lines in a stamp, which will 
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be recognized by a laser-engraver as line(s), which must be cut out. You can set 
the color to Red, Green or Blue or any blending of these colors. You can enter a 
value from 0 to 255.
As soon as you set the cutting property of an object, the object will get this color to 
let the laser-engraver do the cutting of this object.

●     Default Text Settings specifies the following: 
❍     Tabulation (always starting from the left side of the stamp)
❍     Whitespace sets the space between different characters or text segments, 

that can be used at any location in the text.
❍     Select one out of three available Alignment-options: Left, Center or Right 

to achieve respectively flush left, center or flush right of all text in the stamp.
❍     Auto-compression turned on, will automatically compress texts in case they 

are longer than the specified limits.
❍     Auto-linespacing will automatically changes the linespacing of (ONLY) the 

first line in a stamp-design, in case the size in that line has been changed.
●     Default Graph Settings applies to the graphical objects in the stamp-design. You 

can set the following:
❍     Default linewidth of all drawn lines.
❍     Dash specifies the relation between dash and gap.
❍     Boxwidth sets the default width of the lines of a box. Straight ends give 

lines straight ends, exactly between the (in the stamp-design) specified 
coordinates. Not selecting this option will result in rounded ends, partly 
outside the specified coordinates.

❍     Selecting Inside Coordinates will place boxes, ovals and curves exactly 
between the specified coordinates.

❍     Select Straight ends to give lines by default straight ends. If not selected 
lines will by default rounded ends.

❍     Select Rounded if you use boxes with rounded corners, Rx and Ry let you 
set the radius of these corners.

❍     With the Curveshape you set the default shape of curves. There are three 
available options: arc, chord and pie.

❍     Show Logos specifies whether or not logos are displayed as if or are 
represented by a rectangle.

❍     With Arabic/Hebrew Order you can choose the setting for text-entry from 
right to left instead of the default setting from left to right.

❍     The Grid setting enables you to fix the cursor movement while moving 
objects in your stamp-design. This facilitates designing tremendously. The 
object moves exactly along the predefined grid references. The moves you 
make are displayed on the right in the status bar.
CTRL + Cursor moves the selected segment(s) in your stamp design exactly 
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along the specified grid.
Using CTRL + SHIFT + Cursor, you move the selected segment(s) exactly 
one tenth (1/10) of the specified grid.
Because of difficult mathematical techniques it is easier to use the curve tool 
as the most preferred tool and check its settings (hit the return-key) enter 
these settings in the preferences.

●     Print Options will prompt you to print an overview of imported/exported data after 
you exported or imported some stamps.

●     Use hotkeys enables the list of hotkeys. The hotkey list is a global list and if you 
do not wish to use the hotkeys unmark this check box.

●     Adjust equal textlines specifies whether or not the adjust equal textline option is 
by default enabled when setting a new stamp. See Text menu for more information.

●     Undo steps. When you manually alter a stamp, you can use the Undo command to 
reverse the last change to a page. This number must lay between 2 and 10.
Note: the larger the number the more memory Typeset needs. This can slow down 
the performance of your computer.

Output button:
When printing a stamp from typeset the following print-layout options are available:

 

●     Print title will print a title with information on all output.
●     Print description will print the ordernumber, searchkeys, customer ID and status 

below the design
●     Center Preprint will center the output on the page. In case you do not want to 

center your page-layout, you can enter here the X-coordinate and the Y-coordinate.

M & R button:
The M&R Settings are special laserengrave options to enhance efficiency and speed.
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You can select the following: 

●     Compress data
●     Trim non engraved left and right sections skips empty space on a page during 

engraving.
●     Environmental-friendly rastering skips non engraved sections.
●     Speed up during non engraved areas.
●     Lasercutting inside stamp area
●     Don't lasercut corners prevents stamps from being completely cut-out. Stamps 

keep attached to the page by thin strips at the corners of the stamp.
●     LMI support

See M&R options and M&R Laser Engraver for more information.

(These settings are only available as from the SOSET Typeset Gold 2.88 M&R version).

 

Hotkey

This option makes data entry easy and quick. When you select this option a list with pre-
defined Hotkeys appears. You can add, edit and delete hotkeys in this sub menu. You 
simply enter often-used words and texts, in combination with a key or key-combination.
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During text editing you just hold down the pre-defined key or key-combination plus arrow-
up or arrow-down and SOSET will replace this entry with the pre-defined text.

The list of hotkeys is global list. You can enable or disable the use of hotkeys in Local 
Preferences in Typeset.

Be advised to use combinations of keys e.g.: @w for Washington, so unintentional use of 
the hotkeys is limited.

 

Typeface Overview

With this option you can print an overview of all available typefaces fonts. An example of 
a font is shown in the dialog box. It is possible to choose a selection of typefaces, to 
define a range of the fonts to be printed. You also can collate copies, in the print dialog, 
succeeding the typeface selection dialog.

 

Send Message

Communication is very important in the rubber stamp industry. In SOSET it is possible to 
send messages to users in the network. SOSET offers a very easy and efficient way to 
mail users, known in the User-table.

Just click the Send message option on the File menu, select the user(s) in the network 
you want to mail and enter the message. All SOSET software checks the mailbox and 
warns the logged user(s) when there is mail. When the user is not logged in, the mail 
remains in the box and will appear during next login of this user.

Mail in the mailbox can only be deleted by its user.

This option is only available in the SOSET Typeset Gold version!
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Window Menu in Typeset

Arranging Documents in Windows
Zoom Mode
Screen
Activating a Window

Arranging Documents in Windows

In this menu you can change the setup of your screen. You can change a window's size 
or shape in order to see more than one window at a time.

If you want to open more records at a time, but of each stamp you want a full screen 
display, you need screens to overlap. So you choose the Cascade option in the Window 
menu.

In case you want two records or screens next to each other in view, you choose Tile.

Arrange Icons refers to the fact that different open documents can be minimized and 
subsequently arranged as icons by clicking this option.

These options are also available in PageWizard, in the Window menu. In PageWizard, 
you can choose a new window to be displayed.

 

Zoom Mode

Perhaps you want to magnify a stamp on the screen to get a closer look at text, or you 
want to reduce the magnification to concentrate on the stamp-design layout.

With this option you can view your stamp design in zoom mode. This command reduces 
or enlarges the display of your stamp. Click the relevant menu-item and return to your 
stamp area. The (mouse-)arrow will change into a small magnifying glass. Inside the 

glass a minus symbol indicates that you can zoom out, shortcut: , Ctrl + O. A plus 

symbol indicates that you can zoom in. Shortcut: , Ctrl + I.
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Place the mouse pointer where you want to start selecting the area to view. Then press 
and hold down the mouse button, and drag the pointer to where you want the selection to 
end. Then release the mouse button. The marked area will be zoomed in (Repeat this 
action for every time you want to zoom in).

Clicking the zoom out-button,  on the Toolbar, will show the complete stamp design 
again.

These options are also available in PageWizard, in the View menu.

 

Screen

There are three options in the Window menu that influence the appearance of your 
screen. 

●     You can show or hide the Toolbar, which provides you with quick ways to do tasks. 
All Toolbar buttons correspond to the most common menu commands.

●     You can also show or hide the Status Bar, which shows the preferences you 
defined on record entry or editing.

●     You can show or hide the logos in your stamp designs. Deselecting Logo's in the 
Window menu will display a box in your stamp design area on screen with a cross 
instead of drawing the whole logo. This will speed up the drawing of the stamp on 
the screen.
This option does not affect printing. SOSET Typeset will always print a logo.

A check mark appears when an option is visible. Clicking it makes the checkmark as well 
as the toolbar, status bar or logo's disappear from your screen.

These options are also available in PageWizard, in the View menu.

Activating a Window

This option shows the documents, chronologically numbered, you have opened while 
working with Typeset. You can choose the document you want to activate and view on 
your screen by clicking it.

http://www.namosoft.nl/help/tp_windows.htm (2 of 3) [10-Jul-2002 11:51:13 AM]

http://www.namosoft.nl/help/pw_view.htm


Window Menu in Typeset

A checkmark appears when a document is selected and being displayed on screen.

This option is also available in PageWizard, in the Window menu.
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Design a Stamp Manually

General Typesetting
Positioning of Graphical Objects
Selection of Text and Objects
Move or Change a Line
Move or Change Graphical Objects
Move or Change a Logo
More about Circular and Oval Typesetting
Rotation of Text
Advanced SOSET Typeset Techniques
OpenType, The Future Font Format

 

General Typesetting

Creating Text:
When you are in textmode, the T-button,  on the Toolbar is highlighted and you press 
the Enter-key, you add a new textline to your stamp-design. This textline contains by 
default the same font-information and linespacing as the previously defined line. If it is the 
first line in your stamp this textline is set in accordance to your selections in the 
DesignWizard or the Local Preferences settings from the File menu. Before you enter the 
text, it is recommended to set its attributes.

Selecting Text. 
Make sure you are in text-mode (the T-button,  on the toolbar should be highlighted). 
Position the mouse pointer in a text and double-click to select that text-segment or drag 
(hold downing the left mouse button) it to select the text you want to change.

●     Hold the Shift-key each time that you click and/or drag over more text segments 
you want to edit.

-- Or -- 

●     Click outside the stamp-design area to select a complete text-line in one time. 
Position the pointer outside the working sheet in front of the text segments you 
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want to select and click. 
●     Use Shift + click to select multiple textlines.

Once you have selected the text, you can edit it by typing over it; by deleting it, cutting, 
copying, or pasting it; or by changing its attributes.

Editing Text.
Make sure you are in text-mode, the T-button,  on the left on the Toolbar should be 
highlighted. To enter text start typing at the cursor-position.

With the mouse you can move to any place in a textline where you want, click once to 
start editing at that position.

You can use HOME, END, CURSOR and other position keys to simplify cursor-
movement. CTRL + HOME deletes any text in the textline till where your cursor/mouse is 
positioned. CTRL + END deletes any text in the textline from where your cursor/mouse is 
positioned.

At any position in a text segment you can hit the Enter-key, which will result in a new 
textline with the same properties as the previous (not in DesignWizard, when the Enter-
key is disabled).

Horizontal Positioning:
Its margins, its alignment, its spacing and its tabulation determine the horizontal position 
of a text segment. You can find the options in the Text menu and on the Toolbar. 

●     The length of a text segment is determined by the Margin setting. You can drag the 
left and right margin marker or change the setting via the Margin command from 
the Text menu (margin makers are displayed as blue dotted lines in the upper- 
and left rulers).

●     With the Alignment option you can select flush-left, flush-right, center or justified for 
text selections or choose the button on the toolbar (the current alignment is 
highlighted in the toolbar).

●     With the White space command in the Text menu you can set an open space at 
any place. A white space can be recognized by a gray line. With this option you 
can modify the space between characters. Negative numbers move type closer 
together. In this way you can simulate kerning.

●     With the Autowhite space option all unused space in a textline will be spread 
between all characters in the selected textblock. An autowhite space can be 
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recognized by a dotted gray line.
●     With the Tabulation option in the Text menu you can arrange text at a fixed 

position. The tabulation dialog shows a list of tabulations of all text segments in the 
current design. A tab can, as a whitespace, be recognized by a gray line. Any text 
segment can be moved to the next and previous tab by using respectively the Tab 
and Shift + Tab key

Tab-management:
Tab-management is completely done by SOSET Typeset. Notice that the tabulation 
option only effects to selected text segments and the current text segment. Only columns 
defined in the DesignWizard will become tab-settings in all text-lines defined in the 
DesignWizard.

The tab-settings of the text-segment at the cursor-position are visible by the 
marginmarkers in the upper ruler (displayed as blue dotted lines). These markers can 
be dragged to change the active tab-settings.

The best way to work with tabulation in SOSET Typeset is to set a tab (Choose 
Tabulation from the Text menu) and then enter text and so on, instead of setting all tabs 
first. You can set all necessary tabulations in one or more lines. Per tabulation you can 
specify flush left, right or center. The tabulation in SOSET Typeset is a very well 
considered and the approach is totally differently from most word-processors and DTP-
software; it offers strict positioning. After a while you will experience its power and 
efficiency. E.g. where a tab normally moves forward when entering more text, the SOSET 
tab remains where it is. In this way new, modified and deleted tabs do not influence a 
stamp design.

Vertical positioning.
The vertical positioning of a text segment is determined by its vertical justification, the 
vertical centered option, linespacing and its y-position. 

●     Vertical justification automatically centers text over the height of your stamp. 
SOSET will spread unused linespace over all defined lines to fill the size of the 
stamp with text. In case your stamp has a border, you can specify this option and 
SOSET will adjust its calculations to this situation.

●     The vertical centered option in the Text menu enables you to vertically center one 
or more selected textlines in your stamp design.

●     With the linespacing option you can set the distance between text lines. Enter 
several lines of text and try out various linespacing options, and see how the 
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baselines are spaced in the stamp design area. As SOSET calculates the (very 
exact) size of a capital character in mm/inches, it initially sets the line spacing at the 
same size and each textline will have the previous line spacing. This makes that 
text exactly starts at the top of a stamp, which is very difficult to achieve with the 
uncontrollable point-size in other software. Especially for the design of accounting 
stamps and circular and oval stamps we receive very positive reactions to our 
approach. 

We recommend using the DesignWizard and the text-line-spacing options to let 
SOSET suggest most of the line spacing.

Note: In word-processors and DTP-software a character has a corps, which 
is 'flesh' above and below a character and that makes that characters 
automatically have a certain line spacing. This makes also that you never can 
start a text exactly at the top of a stamp and/or position a text exactly within a 
circular or accounting stamp. 

●     With the Y-position option you can set a fixed Y-position for the selected textblock.

Arrow Keys.
With the arrow-up and arrow-down key you move from textblock to textblock. Sometimes 
textblocks are beside each other so the cursor down will result in a move to the right and 
the cursor up in a move to the left.

 

Positioning of Graphical Objects

You can change linespacing or Y-position of any object by using the shortcut CTRL + 
Arrow up and down.

Notice that the object moves exactly along the predefined grid references set in the 
Local Preferences from the File Menu. The moves you make are being displayed on the 
right in the status bar.

As SOSET calculates the (very exact) size of a capital character in mm/inches, it initially 
sets the line spacing at the same size and each textline will have the previous line 
spacing. This makes that text exactly starts at the top of a stamp, which is very difficult to 
achieve with the uncontrollable point-size in other software. Especially for the design of 
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accounting stamps and circular and oval stamps we receive very positive reactions to our 
approach.

Note In word-processors and DTP-software a character has a corps, which is 'flesh' 
above and below a character and that makes that characters automatically have a certain 
line-spacing. This makes also that you never can start a text exactly at the top of a stamp 
and/or position a text exactly within a circular or accounting stamp.

We recommend using the DesignWizard and the text-line-spacing options to let SOSET 
suggest most of the line spacing.

 

Selection of Text and Objects

You can select text and objects in your stamp design area, by clicking the Selection 

button,  on the Toolbar, or by clicking the Selection option in the Mode submenu from 
the Properties menu. A selected textsegment or object can be recognized by 
transparent anchor points. These are transparent, so you can position the selection 
perfectly, even in a small stamp-design.

While editing a stamp you can change the attributes of any graphical object in your stamp-
design. Double-clicking the mouse or pressing the return-key opens the dialog of the 
current object you are pointing at. Now you can change the attributes of the selected 
object.

In SOSET Typeset you can work in two different modes. Sometimes it is easier to insert a 
graphical object by defining its coordinates. Or it is best that you insert a graphical object 
by drawing it with your pointing device.

Pressing a button on the toolbar will switch the current mode immediately to the 
requested mode. The appropriate mode button on the Toolbar will highlight.

Selection Mode.
In the selection mode you can create lines, boxes, circles and import logo's using dialog 

boxes. Just make sure the Selection button, on the toolbar is highlighted (so you are 
in selection mode), and double-click in or outside your stamp design. The dialog box that 

will appear depends on what graphical object button, , , , , is 
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highlighted/selected. The appearing dialog box asks you whether or not you want to add 
a graphical object, and if so you are prompted to define its properties.

Default Mode.
If the selection mode is turned off, you can draw graphical objects yourself in the default 
mode. The cursor-arrow changes in a cross and by clicking the mouse and dragging it 
over the screen (holding down the left mouse-button) you draw the desired object: from 
starting point until end-position. It is not possible to draw lines outside the defined 
stampsize.

Even when you are in Default mode you can open the dialog box by pressing the Insert-
key or double-click in the design-screen to create a new object using dialog boxes.

When you are in text mode it is impossible to turn off the selection mode.

Note: Using the Toolbar is the fasted way the work but you can also view and change the 
Mode you're in by using the Mode submenu in the Properties Menu. The checkmark 
displays what mode you are currently in.

 

Move or Change a Line

When you select the Line button,  in selection mode, the Selection button,  is 
highlighted, you can put the mouse pointer at one of the ends, hold down the left mouse-
button and drag the line to another position along the direction of the mouse. Then let go 
of the mouse-button. The line has changed. You can change the length of the line at the 
same time.

If you click any other position in the line (e.g. in the middle) you can move the line without 
changing the direction or the length of the line.

Another way to change a line is by double-clicking the line or pressing the Enter-key after 
you have selected the line (the anchors are visible). In order to do so, you should be in 
line-mode. A dialog box appears, called: Change line.
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You can change the coordinates and properties of the line in this dialog box.

Dialog box options. 

●     Start Position gives the begin-point coordinates from the line (you can change the 
ruler units with the Local Preferences in the File menu).

●     End Position gives the end-point coordinates from the line.
●     Repeat enables you to repeat the graphical object a number of times. You have to 

specify the distance (Shift X and Shift Y) between the repeating objects.
●     Line specifies the width, caps, color, style and dash for the line. With the color 

option you can select Cutting color. The Lasercutting color can by customized in 
Local Preferences in the File menu. Any line with this option is used by the laser 
engraver as a cutting line. This way you can add or edit cutting lines generated by 
SOSET (with the Lasercut command in the Edit menu).
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Note: The grid (specified in the Local Preferences from the File menu helps you to 
position the object very well. The object moves exactly along the predefined grid 
references. The moves you make are being displayed on the right in the status bar (you 
can move a line by using the Ctrl + arrow shortcut. See Positioning of Graphical Objects 
for more information).

 

Move or Change Graphical Objects

When you select the Box button, , Circle button,  or Curve button,  when you 

are in selection mode (the Selection button, is highlighted), you can move or modify 
the selected object. You simply click at one of the borders or selection objects and drag 
the object with the mouse to another position. This way you can change the size of the 
selected object at the same time.

If you click any other position in the object (e.g. the middle of a line) you can move the 
object without changing the direction of the object.

Another way to change a graphical object is by double-clicking the object to change (or 
pressing the Enter-key). In order to do so, you should be in the graphical object-mode. A 
dialog box appears, called: Change ...(Box, Circle, Oval or Logo).
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You can change the coordinates and properties of the object in this dialog box (the 
options in the Change Box dialog box and Change Curve dialog box are the same as 
the options displayed in this dialog box).

Dialog box options: 

●     Position gives the center-point coordinates from the box, oval or curve. With the 
options Left, Center and Bottom you specify the coordinates origin.

●     Size gives the size the Box/Oval/Curve
●     Repeat enables you to repeat the graphical object a number of times. You have to 

specify the distance (Shift X and Shift Y) between the repeating objects.
●     Line specifies the style, color, width and dash for the line used to draw the 

graphical object. The Inside coordinates box is a special feature for objects that 
have the same size as the stamp itself. If you mark this box the object-line will be 
placed completely inside the stamp-area. If not marked the center-line of the object-
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line will be placed on the bother of the stamp so a part of the line will be outside the 
stamp-area. See Figure 5 The effect of the Inside Coordinates box

The effect of the Inside Coordinates box 

●     Fill enables you to fill an object (in black or white). This is particularly useful in case 
of accounting stamps with a filled space. This option is available for boxes, circles 
and curves.

●     Center Box/Oval/Curve in Stamp places the object in the center of the stamp-
area.

Note: The grid specified in the Local Preferences from the File menu helps you to 
position the object accurately. The object moves exactly along the predefined grid 
references. The moves you make are being displayed on the right in the status bar (you 
can move an object with the arrow-buttons.

 

Move or Change a Logo
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When you select the Logo button,  when you are in selection mode (the Selection 

button,  is highlighted), you can add, move or modify a logo.

SOSET Typeset supports many import formats. However some rules must be followed to 
achieve proper logo handling. 

●     In some logo-scan-applications logos are by default saved with a background and 
appear in SOSET in the size of the background instead of the size of the logo. Try 
to change the size of the page to the size of the logo.

●     Background coloring also causes problems when more than one logo is used in the 
same stamp and they must overlap. Turn off the background coloring or change the 
background coloring into transparent.

●     Tests show the best results using logos in the WMF (Windows Metafile) format. 
You should include the so-called placable header when saving in WMF-format.

In the Logo dialog box you can browse to the logo picture you want insert. You can also 
specify the position, size and repeat option in this dialog box.
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For the import filetypes see Import File Types

 

More about Circular and Oval Typesetting

With the Shape command in the Text menu or the shaping text-buttons, , , on the 
Toolbar you can choose between a straight and round (oval) shape of the selected text. 

The flip text button,  enables you to switch between clock- or counter clockwise 
typesetting in circular and oval textlines.

Note: In circular and oval textline with clockwise typesetting the 0-position is at the 
bottom center of the stamp. "Flip" the textline will move the 0-position to the top center of 
the stamp. Experience these changes with flush left, center or right. Changing the 
linespacing or Y-position over the middle of the stamp will automatically flip the textline.

SOSET Typeset offers circular and oval typesetting using advanced screen 
techniques. However some computers need more time to perform the necessary heavy 
calculations. Avoid waiting by entering the text in straight Typeset mode first and switch 
then to circular mode. SOSET will perform the calculation for the whole text instead of 
redoing it per entered character.

Note: For default the center of oval text is at the same position as the middle of the 
stamp. You can shape the oval text using the Ctrl + arrow keys. You can also select the 
oval text and move it around in the stamp area.

 

Rotation of Text

SOSET will set the length of rotated text automatically to zero to avoid confusing text-
lengths and unwanted compression! However you can set the length with this option.

With the Rotation command in the Text menu you can request a rotation from 0° to 360° 
of any selected text segment. Negative values will result in clockwise rotation and positive 
values will move your text counter clockwise. The angle is always in relation to the 
horizontal axis of the stamp.
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To train yourself in this matter and to understand better what happens, you could start 
with left-aligning a textline. Select the whole line or a textsegment in that line and set the 
rotation-angle. The linespacing is now measured from the bottom of the rotated text.

 

Advanced SOSET Typeset Techniques

Font-size in SOSET Typeset.
The size of a font is generally measured in points; a point is almost exactly 1/72 of an 
inch. 12 points equals 1 pica.

Point size originally measured the vertical length of the lead slug that supported 
characters in printing shops. Point size only loosely refers to the size of the characters. 
The following example shows the font heights for the same letters in different fonts at the 
same (entered) point-size:

AAAAABBBBBCCCCC capital height

The point size does not limit the height or the width of the character; the characters can 
be either larger than, equal to, or smaller than the shoulder of the lead slug.

SOSET Typeset offers a unique way to select the size of a character. During installation 
all fonts in the system are scanned by the SOSET Typeset program to find the exact 
capital height. In SOSET Typeset you enter the capital height and in doing so all text in 
different fonts will have exactly the same height.

AAAAABBBBBCCCCC capital height

It is also an advantage that the use of the capital height of a character is easier to 
understand for most people than the typographical point-size.

For the experienced typesetter SOSET Typeset offers also point sizing-options.

Note: This technology requires the use of TrueType fonts.

 

OpenType, The Future Font Format
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SOSET Typeset uses sophisticated techniques to enable WYSIWYG typesetting, 
including circular fonts and font compression.

Note: These techniques can only work with TrueType Fonts.

Be sure that the use of TrueType fonts is enabled in the Fonts-section of your Control 
Panel, however...

Good news about fonts from Microsoft and adobe.
Microsoft and Adobe will collaborate on the development of a new universal font format 
that will combine TrueType and Type 1. The new font format will be called 'OpenType' 
and will handle the next generation of type for Windows.
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Text Menu in Typeset

Font
Style
Size
(Auto-)Compression
Adjust equal Textlines
Linespacing
Vertical Justification
Vertical Centered
Y-Position
Alignment
Rotation
Tabulation
(Auto-) Whitespace
Autoline
Shaping Text
Make Lower
Make Upper
Color
To Logo
Margins
CAP (Computer Aided Proofreading)

 

Font

In the font-dialog box you choose: font, font-style, type, size and compression-factor to 
change the appearance of your text. You may enter a test-text in the Sample field. 

Shortcut: , Ctrl + F.
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With the options Strikethrough and Underline you select extra options for displaying your 
font.

 

Style

Sets the selected or newly entered text style to Bold, Italic or underline

 

Size

The text size can be set in (real!) X-height (millimeters/inches) or graphical points in the 
Size option in the Text menu. Shortcut: Ctrl + S. The size is being displayed in mm's or 
inches and in pt's in the status bar on the left.
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Read more about the unique Size option in the Font-size section of the Advanced 
SOSET Typeset Techniques. For precise information concerning the inches and 
millimeters conversion see Inch/Millimeter Conversion

 

Auto-Compression

If the text becomes longer than the stamp-margin settings, SOSET Typeset 
automatically compresses all characters in that line, so that they will fit.

In the status bar on the left you can see the percentage that indicates the compression 
factor. 100% means that your text is not compressed. As soon as your text is being 
compressed the percentage displayed becomes smaller. This happens automatically. 
You can set the compression factor manually as well. Determine the compression factor 
with the Compression option in the Text menu. Shortcut: Ctrl + C.

Note: This also counts for lines with tabulation, white space, but also during ASCII-text-
import and numbering.

Auto-compression can be turned off in case you do not need or want compression. You 
can find this option in the Text menu of the main menu. A check mark indicates that the 
auto-compression is on.

This option is only available in the SOSET Typeset Gold version!

 

Adjust equal Textlines
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All lines in a stamp with the same font-size will get the same (maximum) compression-
factor after updating the stamp.

Eg.: 

Before updating: After Updating:
stamp line 1 compression = 50%, size = 12 compression = 50%, size = 12 
stamp line 2 compression = 75%, size = 10 compression = 75%, size = 10 
stamp line 3 compression = 100%, size = 12 compression = 50%, size = 12 

In the above example stamp-line 1 and 3 have the same (font-) size but are set with 
different compression. When the Adjust equal textlines is enabled, stamp-line 3 will get 
the same compression as line 1 (because line 1 has a larger compression-factor than 
line 3) when the stamp is updated.
Stamp-line 2 will stay unchanged because it has a different font-size than the other two 
lines.

 

Linespacing

Choose linespacing to change the distance between lines. Shortcut: Ctrl + L

Enter several lines of text and try out various line spacing options, and see how the 
baselines are spaced in the stamp-design area.

As SOSET calculates the (very exact) size of a capital character in mm/inches, it initially 
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sets the line spacing at the same size and each textline will have the previous line 
spacing. This makes that text exactly starts at the top of a stamp, which is very difficult to 
achieve with the uncontrollable point-size in other software. Especially for the design of 
accounting stamps and circular and oval stamps we receive very positive reactions to our 
approach.

In word-processors and DTP-software a character has a corps, which is 'flesh' above and 
below a character and that makes that characters automatically have a certain line 
spacing. This makes also that you never can start a text exactly at the top of a stamp 
and/or position a text exactly within a circular or accounting stamp.

We recommend using the DesignWizard and the text-line-spacing options to let SOSET 
suggest most of the line-spacing.

 

Vertical Justification

With this vertical linespacing-option you can (re)design your stamp. Shortcut: Ctrl + V.
After entering the text in one or more textlines, you select Vertical justification from the 
Text menu.

SOSET automatically centers the text over the height of your stamp. SOSET will spread 
unused line space over all selected lines to fill the size of the stamp with text. In case 
you design a stamp with a border, you can specify this option and SOSET will adjust its 
calculations to this situation.

 

Vertical Centered

You select text and this option, if you want to vertically center one or more textlines in 
your stamp-design Shortcut: Ctrl + B.
You can vertically center every textline or textsegment separately. This option will center 
all text-lines together in the middle of the stamp, without changing the line-spacing 
between the lines in the design.
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Y-Position

With the Y-position-option you can set a fixed Y-position for the selected textblock. 
Shortcut: Ctrl + Y

 

Alignment

With the alignment options you can select: 

●     Flush-left. Shortcut: , Ctrl + Shift + L
●     Flush-right. Shortcut: , Ctrl +Shift + R
●     Center. Shortcut: , Ctrl + Shift + C
●     Justified. Shortcut: Ctrl + Shift + J. With the Justified alignment option all unused 

space in a textline will be spread between the blank space in the selected 
textblock. Whitespace is displayed as a dotted gray line.

 

Rotation

With the Rotation option you can request a rotation from 0° to 360° of any selected text 
segment. Shortcut: Ctrl + Alt + R.
Negative values will result in clockwise rotation and positive values will move your text 
counter clockwise. The angle is always in relation to the horizontal axis of the stamp.
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The result of rotation can be confusing!

Keep in mind that the length of the selected and rotated text is set to zero to avoid weird 
results.

To train yourself in this matter and to understand better what happens, you could start 
with left-aligning a textline.

Select the whole line or a textsegment in that line and set the Rotation-angle. The 
linespacing is now measured from the bottom of the rotated text.

 

Tabulation

With the Tabulation you can arrange text at a fixed position. Shortcut: Ctrl + T.
The tabulation dialog shows a list of tabulations of all text segments in the current design. 
You simply fill out the desired tabulation in the dialog.

Any text segment can be moved to the next and previous tab by using respectively the 
Tab and Shift + Tab-key. You can select a text segment and subsequently move it tab-
wise, or you can put the cursor in front of the text segment you wish to move. Tab-
management is completely performed by SOSET Typeset.

Notice that the tabulation-option only affects the selected text segments and the current 
text segment. Your design as a whole is unaffected by tabulations.

The tabulation in SOSET Typeset is a very well considered approach, which is totally 
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differently from most word-processors and DTP-software; it offers strict positioning. After 
a while you will experience its power and efficiency.
E.g. where a tab normally moves forward when entering more text, the SOSET tab 
remains where it is. In this way new, modified and deleted tabs do not influence a stamp 
design.

Only columns defined in the DesignWizard will become tab-settings in all text-lines 
defined in the DesignWizard.

The tab-settings of the text-segment at the cursor-position are visible by the 
marginmarkers in the upper ruler (displayed as blue dotted lines). These markers can 
be dragged to change the active tab-settings.

The best way to work with tabulation in SOSET Typeset is to set a tab (choose the 
Tabulation command from the Text menu) then enter text and so on, instead of setting 
all tabs first. You can set all necessary tabulations in one or more lines. Per tabulation 
you can specify flush left, right or center.

 

(Auto-) Whitespace

White space:
With the Whitespace option you can set an open space at any place. A tab and a white 
space can be recognized by a gray line. Shortcut: Ctrl + A.

Auto whitespace:
With the Auto whitespace command all unused space in a textline will be spread 
between all characters in the selected textblock. Auto-whitespace is displayed as a 
dotted gray line. Shortcut: Ctrl + W. 

 

Autoline

The Autoline command enables you to fill a textline (from the position of the cursor on) 
with a (dotted) line. Shortcut: Ctrl + H.
This linewidth is exactly one tenth of the font size. You can enter information concerning 
the vertical alignment (on top of the textline, in the middle of the textline or at the bottom 
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of the textline) of the line.

This autoline functions behaves as any other line object in SOSET Typeset. This means 
it can be edited in Line mode. 

 

Shaping Text

The Shape submenu gives you the possibilities to shape you text. 

●     Straight textline. Shortcut: , Ctrl + Alt + S
●     Oval textline. Shortcut: , Ctrl + Alt + C
●     Flip text command enables you to switch between clockwise and counter 

clockwise typesetting in circular and oval textlines. For default the center of oval 
text is at the same position as the middle of the stamp.

●     Parameters command edits the parameters of a circular textline in your stamp 
design.
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It enables you to change the center coordinates (X,Y) and the radius (X,Y) of the 
circle of your selected text. In case of circular typesetting, you can center the 
selected textline in the stamp. You also can determine the center and the radius 
per textline.

Note: In circular and oval textline with clockwise typesetting the 0-position is at the 
bottom center of the stamp. "Flip" the textline will move the 0-position to the top center of 
the stamp.

Experience these changes with Alignment: flush left, center, right or justified.

Note: Changing the Linespacing and Y-position over the middle of the stamp will 
automatically flip the textline.

 

Make Lower

This Make lower option is meant to change the selected text segments from uppercase 
into lowercase.

 

Make Upper

This Make upper option is meant to change the selected text segments from lowercase 
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to uppercase.

 

Color

You can use this option to determine the color of the text in the stampdesign. The 
choices are black, white text (white text will be displayed in gray. You can use this option 
to achieve reverse text.) or other. When the other box is checked you can choose 
between 16 different colors. This option however is only available for SOSET Gold 
versions.
You can also change the color of any object in a stamp with the color palet icon in the 
lower taskbar in Typeset.

Note: For cutting with your flatbed laser engraver you set with this option the cutting 
areas.

 

To Logo

With this option you can change selected text-segments into a logo. This enables you to 
move and change the size of the text just as any other logo.

The To Logo command facilitates positioning and sizing of text.

 

Margins

With this option you can set the left and right margin of the text segments in your current 
selection. You can drag both margins with the mouse to any place you want (the 
marginmarkers are displayed in the rulers by a blue dotted line). This enables fitting text 
into different columns. You drag the left and the right margin respectively to the first and 
the last line of the column. Center the text in between the two boundaries (set by the 
margins).

CAP (Computer Aided Proofreading)
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Function not implemented yet.

Available in SOSET typeset 4.1 and higher and SOSET quick typeset 4.0 and higher.
This option has been designed to offer the best possible way to do proofing. Intensive 
research shows that double entry of text not only improves the quality of proofing but it 
also takes less time.
Besides that it is much easier to concentrate on text-entry than doing original proof-
reading by reading and reading and getting more and more tired of that same reading.
After the first entry a stamp can be found by another typesetter, using search-
information. The CAP-option opens the stamp-design and a memo-type screen for the 
second entry. An OK will compare the two entries and will find possible errors. In that 
case the typesetter is prompted to either accept the old entry, the new entry or to correct 
the latest entry.
Next the text in the design is modified in accordance to the new entry.

http://www.namosoft.nl/help/tp_text.htm (12 of 12) [10-Jul-2002 11:51:17 AM]



Miscellaneous Typeset Info

Miscellaneous Typeset Info

M&R Options
Import Interface File Version 2.89
Information about the SOSET Export Interface File Version 2.89
Mouse Functions
Import File Formats in 16-bits
Import File Formats in 32-bits
Export File Formats in 32-bits
AppleMac Files
ANSI Characters
ASCII Characters
Working with Barcodes
Time Registration
Remake Options
Order Tracking for Remote Branches and Remote Customers
Inch/Millimeter Conversion

 

M&R Options

Typeset supports the following M&R options (thus these options are available with Typeset 
Gold M&R version only): 

●     Shoulder-support enables SOSET to generate "shoulders" around images/texts of design 
during printing/sending data to laser-engraver . SOSET uses and adjusts power and speed 
settings of the M&R laser.

●     Multi-laser support enables output to more than one M&R laser engraver. A special Laser-
table controls settings for the different laser engravers. You can edit the Laser-table by 
selecting the Laser command in the Browse submenu in the File menu in NamoSys.

●     Large table output controls output for the total size (3x A-4) of the M&R laser-engraver.
●     Seal support generates a mirrored copy of the design and places it on the page-layout 

and/or sends data of both die and counter to laser-engraver.
●     One time cutting specifies that during PageWizard output, overlapping cutting-lines are 

only engraved once.
●     Lasercut-path option calculates automatically the (laser-)cutting path around the 

boundings of a stamp. See Lasercutting Command for more information.
●     Extended-Cut-path option calculates automatically the exact cutting path around the 

boundings of a stamp. See Lasercutting Command for more information.
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●     Laser settings in browse dialog in NamoSys lets you select Laser settings which offers 
adjustment of specifications for the M&R laser.

●     Jump support skips empty space between stamps (movement with higher speed).
●     Trim support engraving starts and ends at beginning of stamps/lines. Movement to 

beginning of stamps are as minimum as possible. Also, artificial intelligent movement for 
signs and seals.

●     Environmental support does not engrave empty space between stamps (cutting path) 
during engraving.

 

Import Interface File Version 2.89

This option is only available in SOSET typeset Plus (refer to latest price-list about availability of 
this option)

All numbers are always positive and with leading zero's

Example
Name of ASCII-file: EXPOR001.SOS (001 up to 999 allowed!), place file in subdirectory 
drive\DATA\SOSET\IMPORT

%% SOSET-DOS 31.12.99 00:00:00 Copyright NamoSoft BV

[OrderInfo]
12345678,001,001,19991231,
1,123456789012,SEARCH,00,00,00,0,645592,CUSTOMERINFO,1,19991231,SEARCH,2[Props]
1000,10000,0
[OrderInfo]
12345678,001,001,19991231,
1,123456789012,SEARCH,00,00,00,0,645592,CUSTOMERINFO,1,19991231,SEARCH,2
[Props]
1000,10000,0
&END&

End example

FIELD DESCRIPTION:

Intro always:%% SOSET-DOS date time Copyright NamoSoft BV

The properties-info is optional.
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Orderintro Pos. Type Always [OrderInfo]
ORDERNO 8 Numeric
ORDERITEM 3 Numeric
ORDERITEM 3 Numeric always same as previous
ENTERDD 8 Numeric YYYYMMDD
QUANTITY 4 Numeric
PRODCO 12 Alpha/numeric
SEARCHKEY 6 Alpha/numeric
COLOR 2 numeric
STATUS 2. numeric always 00
MOUNT 2 numeric 00=default
RUSHCODE 1 numeric 1=rush,2=48 hour rush, 3=24 hour rush, 0=no rush
CUSTOMERID 6 numeric
CUSTOMERINFO 25 alpha/numeric
MISCELLANEOUS 1 numeric always 1
SHIPDD 8 numeric
SEARCHKEY 2 6 alpha/numeric
TERMINATOR 1 Numeric always 2
STAMPINFO always [Props]
WIDTH 5 Numeric mm-size X 100
HEIGHT 5 Numeric mm-size X 100
SHAPE 1 Numeric 0=normal, 1=circular, 2=oval
Epilog always &END&

After successful import, the file is automatically moved to subdirectory 
drive\DATA\SOSET\TEMP\

 

Information about the SOSET Export Interface File Version 2.89

To enable data exchange between SOSET software and other applications, SOSET 
automatically writes overview-information to a CSV-type file, every time an overview is printed.

The Export interface file: *.txt (the name of this ASCII-file as entered in the report dialog) has the 
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following fields:

All number always positive and with leading zero's

example:
The header-info describes the field-sequence, below an example of the Ready to ship order 
report.

[Title]
SOSET REPORT: Ready to Ship 16.04.97 00:00:00
[Version]
2.9
[Header]
CustID, OrderNo, PartNo, Quantity, ProductID, Colour, BoxNo, Date In, Date Out, RushID
[Data]
123456,12345678,001,1,123456789012,00,100001,19991231,20000131,0
223456,22345678,001,2,H0001,00,100002,19971231,20000131,1
223456,22345678,002,3,P100101,01,100003,19971231,20000131,2
[EndData]
&END&

End example

FIELD DESCRIPTION:

Line # Description Pos. Type Contents
-7 intro1 8
-6 intro2 3
-5 intro3 3
-4 intro4 8
-3 intro5 4 Numerical
-2 intro6 12
-1 intro7 6
0 intro8 2
1 CUSTOMERID 6 Numerical
1 ORDERNO 8 Numerical
1 ORDERITEM 3 Numerical
1 QUANTITY 1 Numerical
1 PRODCO 12 alpha/numerical
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1 COLOR 2 Numerical
1 BOX 6 Numerical
1 ENTERDD 8 Numerical
1 SHIPDD 8 Numerical
1 RUSHCODE 1 Numerical 1=rush, 2=48 hour rush, 3=24 hour rush, 0=no 

rush
LAST-1 DATA-LABEL always [EndData]
LAST EPILOG always &END&

So this file contains the same information and is in the same order as the printed overview.

The CSV (Comma Separated Value) file has a comma between each field and can be easily 
read into spreadsheets, accounting software, etc.

You can also use several of these files, like the shipment-overview to initiate automatic invoicing 
in your own OrderEntry software.

Note: You will find the file-name on the overview!

 

Mouse Functions

Mouse functions for Text segments:

LEFT Moves the current position to the mouse position.
LEFT DOUBLE Selects the textblock at the mouse-position.
MOVE Drag selection with left mouse button down
SHIFT + LEFT Supports multiple selection.

Mouse functions for Graphical objects:

LEFT Moves the current position to the mouse position.
LEFT DOUBLE In case the mouse is located on a graphical object this object can be modified. 

Otherwise an object is added to the list of objects.
MOVE Drags objects.
LEFT + MOVE Selects objects.
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SHIFT + LEFT Supports multiple selection.
RIGHT Show a pop-up menu in which you can select the most commonly used 

function for the selected object.

 

Import File Formats in 16-bits

SOSET Typeset supports many import formats. However some rules must be followed to 
achieve proper logo handling. 

●     In some logo-scan-applications logos are by default saved with a background and appear 
in SOSET in the size of the background instead of the size of the logo. Try to change the 
size of the page to the size of the logo.

●     Background coloring also causes problems when more than one logo is used in the same 
stamp and they must overlap. Turn off the background coloring or change the background 
coloring into transparent.

●     Tests show the best results using logos in the WMF (Windows Metafile) format. You should 
include the so-called placable header when saving in WMF-format.

Supported File Formats for Typeset 16 bits (version 3.3 and before): 

File type File Extension
Adobe Illustrator/encapsulated Postscript file EPS or AI
Microsoft Windows device independent Bitmap BMP or DIB
CorelDraw 3 drawing file (save as version 2 or 3) CDR
Computer Graphics Metafile CGM
Clear Text Computer Graphics Metafile CTM
Harvard Graphics 3.0 drawing file CH3 or SY3
Micrografx drawing file DRW
AutoCAD drawing interchange file DXF
Digital Research graphics file GEM
Compuserve graphics interchange format file GIF
Hewlett-Packard Graphics Language file HGL
Joint Photographic Experts Group bitmap JPG
OS/2PM metafile MET
NAPLPS graphics file NAP or PDI or PIC
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Kodak photo CD bitmap PCD
Macintosh Quickdraw file PCT
Lotus 1-2-3 graphics file PIC
AutoShade rendering file RND
Zsoft PC Paintbrush bitmap PCX
SOSET Typeset stamp-design SOS
Truevision TARGA file TGA
Tagged Image File Format TIF
Microsoft Windows Metafile WMF
Wordperfect graphic file WPG

Note: The SOSET Silver version only supports the image/logo import of .TIF, .CDR, .EPS, 
.WMF, AI. files.

 

Import File Formats in 32-bits

IMPORT FILE FORMATS IN SOSET TYPESET 32-BITS VERSION 4.00 and above:
The image options starting SOSET TYPESET 32-BITS VERSION 4.00 have been dramatically 
changed and exchanged with a more reliable and modern library. This library offers more and 
new formats and great features. Unfortunately some of the formats are not available, due to 
license-regulations.
The image procedures will try to repair possible errors in images in the WMF-format.
You can download the special 16-bits program image.exe which contains the "old" filters and can 
be used to convert the various file formats into a WMF-format for import into the new SOSET 
typeset. We also recommend to use the OLE-options to link 3rd party application-designs to a 
SOSET typeset stamp.

Below you will find an overview of all new import and export formats:

Note: Not all options might have been implemented yet, please contact our support department 
for a current status.

Import filters

File Format SOSET 16-bits SOSET 32-bits
AI - Adobe Illustrator File Supported Not supported
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BMP - Microsoft Windows DIB Supported Supported
CDR - Corel Draw Graphics Metafile Supported Not supported
CGM - Computer Graphics Metafile Supported Not supported
CHT - Harvard Graphics 3.3 Chart File Supported Not supported
CH3 - Harvard Graphics 3.0 Chart File Supported Not supported
CTM - Clear Text CGM Supported Not supported
DIB - Microsoft Windows Supported Supported
DRW - Micrografx Drawing File Format Supported Not supported
DXF - AutoCAD Drawing Interchange 
File Format

Supported Not supported

EPS - Encapsulated Postscript File Supported Supported
GEM - Digital Research GEM Format Supported Not supported
GIF - Graphics Interchange Format Supported Supported
HGL - Hewlett Packard Graphics 
Language

Supported Not supported

JPG - Joint Photographic Group 
Format

Supported Not supported

MET - OS/2 PM Metafile Supported Not supported
NAP - NAPLPS - Standard ANSI Supported Not supported
PCD - Kodak Photo CD Bitmap Supported Supported
PCX - Zsoft PC Paintbrush Bitmap Supported Supported
PDI - NAPLPS - IBM PC Videotex Supported Not supported
PIC - Lotus 123 Picture File Format Supported Not supported
PIC - NAPLPS - General Parametrics Supported Not supported
PCT - Macintosh PICT Format Supported Not supported
RND - AutoShade Rendering File 
Format

Supported Not supported

SYM - Harvard Graphics 2.3 Symbol 
File

Supported Not supported

SY3 - Harvard Graphics 3.0 Symbol 
File

Supported Not supported

TGA - Truevision Targa File Format Supported Not supported
TIF - Tag Image File Format Supported Supported
WMF - Microsoft Windows Metafile Supported Supported
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WPG – WordPerfect Graphic File 
Format

Supported Supported

AVI Not supported Supported
Windows Fax (AWD) Not supported Supported
CALS raster file Not supported Supported
JPEG Not supported Supported
LEAD CMP Not supported Supported
DICOM Not supported Supported
Raw FAX Not supported Supported
IOCA Not supported Supported
GEM Image Not supported Supported
Lead 1-Bit Not supported Supported
MacPaint Not supported Supported
MacPict Not supported Supported
Portabel Netword Graphics Not supported Supported
Adobe Photoshop 3.0 Not supported Supported
Sun Raster Not supported Supported
TARGA Not supported Supported
CCITT Not supported Supported
TIFF LZW compression Not supported Not supported
WinFax Not supported Supported
Kodak FlaxhPix only on 32 bits system Not supported Supported
Windows Icon Not supported Supported
Windows Cursor Not supported Supported
Microsoft Paint Not supported Supported

 

Export File Formats in 32-bits

File Format SOSET 16-bits SOSET 32-bits
AI - Adobe Illustrator File Supported Not supported
BMP – Microsoft Windows DIB Supported supported
CGM – Computer Graphics Metafile Supported Not supported
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CTM – Clear Text CGM Supported Not supported
DXF – AutoCad Drawing Interchange 
File Format

Supported Not supported

DRW – Micrografx Drawing File Format Supported Not supported
EPS – Encapsulated Postscript File Supported Supported
GEM – Digital Research GEM Format Supported Not supported
GIF – Graphics Interchange Format Supported Supported
HG3 – Havard Graphics File Format Supported Not supported
MET – OS/2 PM Metafile Supported Not supported
NAP – NAPLPS (nap, pdi, pic) Supported Not supported
PCX – Zsoft PC Paintbrush Bitmap Supported Supported
PCT – Macintosh PICT Format Supported Not supported
TGA – Truevision Targa File Format Supported Not supported
TIF – Tag Image File Format Supported Supported
WMF – Microsoft Windows Metafile Supported Supported
WPG – WordPerfect Graphic File 
Format

Supported Not supported

Ami Pro Not supported Supported
ASCII Not supported Supported
dBaseIV Not supported Supported
DCA/RFT Not supported Supported
Excel Not supported Supported
PostScript Not supported Supported
Word for Windows/ RTF Not supported Supported
HTML Not supported Supported

 

AppleMac Files

AppleMac * PCT files are only readable when saved on MS-DOS formatted disks!

 

ANSI Characters
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To access these characters, hold down the ALT-key and use the numeric keypad to type a zero 
followed by the ANSI character code.

Note: &127 indicates that this character is not supported by Windows.

 

ASCII Characters

http://www.namosoft.nl/help/tp_misc.htm (11 of 17) [10-Jul-2002 11:51:20 AM]



Miscellaneous Typeset Info

To access these ASCII characters, hold down the ALT-key and use the numeric keypad to type 
the ASCII character code.
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Note: You also can use the Character map in Windows accessories

 

Working with Barcodes

The SOSET Typeset software includes helpful shipping and invoicing procedures.

For shipping and handling procedures, you can use the bar-coded notes instead of the shipping-
lists provided by SOSET.

If you use the bar-coded notes we advise you to store products which are ready to ship in boxes. 
You will need 50-250 boxes. These boxes must be labeled with the numbered barcodes. These 
labels are included in your software package. In case you need new/more barcode labels, select 
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the Print barcode labels command from the File menu in NamoSys. Enter the range of barcode 
numbers you want to print.

Barcodes facilitate storage and retrieval. You label the orders/stamps by assigning a barcode to 
them. Each order has its own barcode. This enables tracking your order during the entire 
production process. Simply print the run-cards and keep them with the corresponding bar-coded 
box. When a stamp is produced and Ready for shipment, you scan the bar-code on the run-
card and on the bar-coded box. It is not until all order-items/stamps are In box and Ready for 
shipment, that the order automatically reads Shipped.

 

Time Registration

Every time you start to enter or edit a new or previously entered stamp, SOSET registers the 
time during entry and update of the design.

Use the query-option in the Overviews menu in NamoSys to get totals and averages on entry 
and edit time per user. Based on this information you can make a full report of any user's 
activities.

 

Remake Options

Very often you want to know the reason for a remake. Sometimes it is even essential to know the 
reason.

If you change the typeset status of a stamp into Remake, SOSET will treat this stamp as a newly 
entered stamp.
Therefore this stamp will appear on the next output of all newly entered stamps. The remake 
reason will be printed on the output to inform the corrector what must be checked to do a perfect 
remake.

Also, this option enables you to give the customer the correct information in case a stamp is too 
late because it has to be remade.

On screen this information is available with the General Information command in the Properties 
menu. The status information is stored in the stamp history.

You change the Typeset status into Remake by double-clicking this option or by pressing the 
Enter-key once. Subsequently SOSET comes with a dialog, which prompts you to select the 
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remake-reason.

The Remake Types are:

00 Unknown
01 Everything wrong
02 Lost
03 Production
04 Quality die
05 Quality mount
06 Quality dirty
07 Misspelled
08 Bad copy
09 Wrong cutting
10 Wrong quantity
11 Wrong size
12 Wrong color
13 Wrong product

Use the query-options in the NamoSys program to generate a printed list with remake 
information.

This options is only available in the SOSET Typeset Gold version!

 

Order Tracking for Remote Branches and Remote Customers

You can specify users in the user-table with the Browse command in the File menu in Namosys

SOSET considers a remote customer as any SOSET user with the only difference that the 
remote user is recognized by the customer-ID field of the user-table.

During log-in SOSET checks the pin-code of a user.

The user must also enter a customer-ID even when the customer-ID field is filled with a customer-
ID. In this way you can permit remote customers to log-on to YOUR system (by remote modem 
operation), enabling them to search for (only their own) stamps.
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Use this possibility as a special and modern service to your customers.

 

Inch/Millimeter Conversion

Fraction Inches Millimeter Fractions Inches Millimeters

1/64 .0156 0.396 33/64 .5156 13.096
1/32 .0312 0.793 17/32 .5312 13.493
3/64 .0468 1.190 35/64 .5468 13.890
1/16 .0625 1.587 9/16 .5625 14.287
5/64 .0781 1.984 37/64 .5781 14.684
3/32 .0937 2.381 19/32 .5937 15.081
7/64 .1093 2.778 39/64 .6093 15.478
1/8 .125 3.175 5/8 .6250 15.875
9/64 .1406 3.571 41/64 .6406 16.271
5/32 .1562 3.968 21/32 .6562 16.668
11/64 .1718 4.365 43/64 .6718 17.065
3/16 .1875 4.762 11/16 .6875 17.462
13/64 .2031 5.159 45/64 .7031 17.859
7/32 .2187 5.556 23/32 .7187 18.256
15/64 .2343 5.953 47/64 .7343 18.653
1/4 .2500 6.350 3/4 .7500 19.050
17/64 .2656 6.746 49/64 .7656 19.446
9/32 .2812 7.143 25/32 .7812 19.843
19/64 .2968 7.540 51/64 .7968 20.240
5/16 .3125 7.937 13/16 .8125 20.637
21/64 .3281 8.334 53/64 .8281 21.034
11/32 .3437 8.731 27/32 .8437 21.431
23/64 .3593 9.128 55/64 .8593 21.828
3/8 .3750 9.525 7/8 .8750 22.225
25/64 .3906 9.921 57/64 .8906 22.621
13/32 .4062 10.318 29/32 .9062 23.018
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27/64 .4218 10.715 59/64 .9218 23.415
7/16 .4375 11.112 15/16 .9375 23.812
29/64 .4531 11.509 61/64 .9531 24.209
15/32 .4687 11.906 31/32 .9687 24.606
31/64 .4743 12.303 63/64 .9843 25.003
1/2 .5000 12.700 1 1.000 25.400
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NamoSys Help
To get information select an item in the table of contents or click the appropriate item in the 
screenshot.

Table of Contents:

●     NamoSys General
●     File Menu in NamoSys
●     Overviews Menu in NamoSys
●     Utilities Menu in NamoSys
●     Modem Menu in NamoSys
●     Help Menu in NamoSys
●     Structure of the database-tables

 

NamoSys screenshot:
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NamoSys General

All SOSET software is accompanied by a NamoSys-program with very helpful tools. You 
can find this program in the SOSET-group under the name: NamoSys.

The NamoSys program manages your database-tables in an efficient way, enabling you 
to take full advantage of the extensive possibilities and advantages of (working with) 
databases. For more information see Structure of the database-tables.

 

 

Logo's:

Where to find and save logo's?
Logo's which you want to include in your stamp-design, are stored on your harddisk. 
During setup SOSET creates a logo-subdirectory from the SOSET data path. This 
subdirectory is called LOGO. When you save logo's you are strongly advised to save 
them in this subdirectory.

Importing and exporting stamps with a logo:
Import and export of SOSET stamps with a logo might cause missing logos after import. 
This is due to either the wrong location of the logo-image-file or that the logo-image-file is 
not copied during the import- and export-operation. SOSET Typeset offers a very 
efficient yet simple solution to avoid this.

To avoid missing logo's during editing after import and export, we advise you to save and 
copy logo-files always in the same logo-subdirectory from the SOSET data path. 
(SOSET import- and export-operations do not cover this!).

Make sure the logo's are copied from the logo-directory to the export directory or from 
the import directory to the logodirectory, to avoid missing logo's.
As long as you respect the logo-subdirectory policy, you should have no difficulties, when 
importing logo's from a remote side or exporting stamps with a logo.

Though the SOSET Typeset Silver-version does not give you the possibility of importing 
and exporting stamps, we advise you to follow the guidelines mentioned above all the 
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same, in case of later upgrades.
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Overviews Menu in NamoSys

 

User Activities

In the Overviews menu in NamoSys, you can view user activities. You can see exactly 
which stamps and consequently how many stamps were made and by whom. After 
selecting this option a dialog appears on screen, asking you to select which user you 
want to view, and which date you want to see. SOSET makes a user report. This report 
includes the order-number, part-number and customerinfo of the designed stamps. The 
total sum and the total average per user is determined. Furthermore the number of days 
is registered, between the OrderEntry date and the shipping date.

This option is only available in the SOSET Gold version!
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Modem Menu in NamoSys

In NamoSys you can select File Transfer to transfer files by modem.

Exporting stamps in SOSET Typeset:
In SOSET Typeset you first decide which stamps you want to export. Select the Export 
to SOSET Windows command from the File menu in Typeset. You can either export the 
current stamp on screen or export stamps on status.
All stamps to export can be transferred to the SOSET export directory (a sub-directory 
of the SOSET-data directory). After selecting this option SOSET Typeset prompts you to 
save the stamp as a Stamp.dbf file in the export directory from the SOSET data path. 
These default settings need not to be changed, so you will not have problems with 
finding the stamps to export.

Importing stamps in SOSET Typeset:
In SOSET Typeset you import stamps. Select the Import to SOSET Windows command 
from the File menu in Typeset. Select the appropriate .DBF file from which the stamps 
will be imported (and the directory in which this file can be found).

Preparing your modem:
In NamoSys you can select the Preferences command from the File menu to set your 
modem properties. After clicking the button Modem a dialog will appear in which you can 
enter the Preferences settings. In this dialog you can enter the modem settings. You 
can set the port, the parity, the baud, the data and the stop bits.
(Standard settings for these preferences are: for the parity: none, the baud: 2480, the 
data: 8 bits, and the stop bits: 1 bit.). These settings normally have to be set only once, 
since they import/export stamps to the same host.

Note: Make sure that all preferences settings (except for the port: COM1 through COM8, 
which can be different for every computer) are similar for both the host side and the 
remote side. The best way to attain matching preference settings between the two 
operations is to check and adapt these to one another over the telephone.

 

File Transfer

Dial/Send or Wait/Receive:
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Selecting the File transfer option from the Modem menu, will open a dialog in which you 
can select whether you want to dial/send (all data from the export directory is being 
transferred) or to wait/receive (all data will be transferred to the import directory).

Click the appropriate button and SOSET will automatically transfer all data from the 
SOSET export directory to the SOSET import directory from the host side (the 
receiving side). As soon as the file transfer is finished, the modem connection will be 
automatically terminated.

After exporting stamps by modem the following question appears on screen: Move all 
transferred files to the SOSET temporary folder? Answer Yes to this question, in case 
you want stamps to be exported only once.

On entering the stamps in Typeset, you are advised to choose your OrderNumber with 
care. The OrderNumber at the remote side needs to be different from the OrderNumber 
at the host side. Otherwise they will be overwritten. To avoid overlapping 
OrderNumber you have to make good appointments concerning the range of 
OrderNumber you use.

In NamoSys you choose the System-table option from the Browse submenu. You can 
enter the next OrderNumber for a stamp that will be assigned to a stamp in Typeset. 
When you opened the system-table, press "o" and the OrderNumber-line will appear. 
Now press edit to change the Value (do Not change the parameter). For instance, you 
could choose OrderNumber until a certain number, and the other side chooses her 
OrderNumber from that number on.

Note: To avoid missing logo's during editing after import and export, we advise you to 
save and copy logo-files always in the same LOGO-subdirectory from the SOSET data 
path. (SOSET import- and export-operations do not cover this!). Make sure the logo's are 
copied from the logo-directory to the export directory or from the import directory to the 
logo-directory, to avoid missing logo's.
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Help Menu in NamoSys

In this menu you can select to search for help on contents or index. The Using Help-
option starts the windows help which displays instructions about how to use help.

About NamoSys displays program information, version number and copyright.
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Edit Menu in Typeset

Edit
Replace
DesignWizard
Lasercutting
Insert New Object
Object

 

Edit

●     Undo reverses the last editing change. When you save a file, the Undo command 
is disabled until you change the file in some way. You can set the number of undo 

actions with the Local preferences. Shortcut: , CTRL + Z
●     Redo reverses the effect of the last Undo command. You can redo up to 10 

actions. Shortcut: 
●     Cut removes selected text, controls, or anything else that you can select, to the 

Clipboard. Once you cut (or copy) something, you can paste it elsewhere in your 

application or in other applications. Shortcut: , Shift + Delete.
●     Copy duplicates selected text, controls, or anything else that you can select, and 

puts it on the Clipboard. Once you copy (or cut) something to the Clipboard, you 

can paste it elsewhere in your application or in other applications. Shortcut: , 
CTRL +Insert

●     Paste takes cut or copied text, objects, controls, or anything that you can select 
(except for forms) from the Clipboard and places it at the insertion point. To place 

your selection on the Clipboard, use the Cut or Copy commands. Shortcut: , 
Shift + Insert

Please refer to the Windows documentation for more information about standard 
Windows editing topics, like undo, cut, copy and paste.
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Replace

Selecting Replace enables you to replace a selected text pattern in your stampdesign. 
You can search for a certain text and once found replace it with the preferred words.

 

DesignWizard

The option DesignWizard activates the DesignWizard dialog.

It is especially developed for computerized stamp-design or looking up a previously 
made stamp and duplicating its design and properties.
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Pushing the DesignWizard button,  on the Toolbar enables you to redesign your 
stamp with the DesignWizard.

See DesignWizard in Typeset for more information.

 

Lasercutting

With the Lasercut option, SOSET Typeset generates automatically the outlines of the 
stamp for lasercutting. The specifications of the lasercutting lines are set in the laser 
information section of the Local Preferences in the File menu.

If the lasercutting flag of this product or Printgroup is set to True, SOSET Typeset will 
prompt you to generate the cutting lines as soon as you update the stamp information. 
Per graphical object you can set the Lasercutting Color on or off.

The lines calculated by this special laser-option can be edited as all drawing objects in a 
stamp-design. The following options are available:

●     None means no cutting-lines are being generated.
●     Product Size cuts along the contours of the product.
●     Contour cuts along the boundings of all objects of a stamp
●     Advanced Contour cuts not just along the boundings of all objects of a stamp, but 

exactly along the contours of all objects of stamps (even logos!). This option is 
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developed especially to enable precise lasercutting.

If the Add cutting lines box is unmarked all the existing cutting lines are deleted. If 
marked the new cutting lines are added to the existing cutting lines.

Note: For cutting during laser engraving on some flatbed-laser engravers the color-
setting in PageWizard must be the same as the cutting color setting in Typeset.

 

Insert New Object

Insert a new embedded object in the stamp. For more information about embedded 
objects see Working with OLE objects.

 

Object

Select this option to edit an embedded object. First select the object you want to edit and 
select this menu item. The program that was used to create the embedded object will 
start within Typeset and you can edit the object as if you were working in the original 
program. 

To go back to Typeset select File menu > Close

For more information about embedded objects see Working with OLE objects
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Working with OLE objects

Use objects linking and embedded (OLE) to share information between Typeset and 
other programs. Those other programs can be any program installed on your computer 
(e.g. CorelDraw, Wordpad, Word, Excel, PowerPoint).

Use an embedded object to add all or part of a file created in any other program that 
supports linked and embedded objects. You can create a new embedded object or 
embedded object from an existing file. If the file you want to use was created in a 
program that does not support linked and embedded objects, you can still copy and 
paste information from the file to share the information between programs.

With an embedded object, information in the destination file does not change if you 
modify the source file. Embedded objects become part of the destination file and, once 
inserted, are no longer part of the source file. Double-click the embedded object to 
open it in the source program.

To insert an embedded object click in the stamp where you want to place the embedded 
object. 

●     On the EDIT menu select Insert new object
●     In the Object type box, click the type of object you want to create.
●     To display the embedded object as an icon, if others are going to view the 

document online select the Display as icon check box.

Notes: Only programs that are installed on your computer and that support linked and 
embedded objects appear in the Object type box.

 

http://www.namosoft.nl/help/tp_ole.htm [10-Jul-2002 11:51:23 AM]



faq

 
  |  Home   |  Description   |  FAQ   |  Readme   |  Pricing   |  Terms   |  Download   |  Contact us   |  On-line help   |  

-You will find the latest and important information about the SOSET software in readme
-Click for on-line help-options
-Click for emergency information

SOSET-TIP OF THE WEEK:
               Enable proofprint with Outlook Express 

New: Codebase-error overview 

GENERAL QUESTIONS: 

●     Archive option issues in NamoSys and NamoUtil
●     Can I use the Soset software with any laser engraver or any other output device?
●     Do we need to purchase statements (printed forms with blank area to place our monthly customer 

activity for each month) which are set up to match Soset's standard output or can we format the activity 
to print on our existing statements?

●     Do you offer SOSET training? Can you help me with my setup?
●     Do you support standard Windows shortcuts?
●     Enable proofprint with Outlook express
●     How can I check which tables are currently in use by SOSET?
●     How can I change the next available ordernumber and/or invoice-number?
●     In NamoUtil I am getting a file access is denied error. Method Brauwse; error info saved in etc. line ...
●     I only get a lot of data on my screen when I try to download the license file namosoft.sos from the 

download directory
●     I would like to run some tests with the new SOSET software. Can I have an extra software protection 

key that I could use for testing?
●     Some options behave different from the instructions or do not work?
●     Soset error information.
●     We are having problems downloading SOSET software from the namosoft-web-site.
●     What to do if the SOSET-license is expired or in case of emergency?
●     What's new in SOSET typeset and SOSET order entry?
●     When will orders be archived
●     Where can I find the Euro-symbol?
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●     How does the tax-option work and how does SOSET handle tax-charges for various situations?

SOSET SETUP QUESTIONS: 

●     How to set up a New Company in SOSET order-entry?
●     How do we import the few hundred or so customers we have? We'd rather not retype all the information.
●     Where can I find an up-to-date description of all SOSET database-tables, fields and indexes in the 

structure-description?

SOSET TYPESET QUESTIONS: 

●     Can I enter decimal values in the quantity field?
●     Can SOSET typeset run without software protection hardware key or how to use and install SOSET 

typeset remote software?
●     How can I prepare data in e.g. Excel-format into a format which can be used with the SOSET Import 

ASCII/ANSI option?
●     How can we setup one of our customers as a SOSET remote user?
●     I need 'font x', can you send it to me? 
●     In PageWizard, Function Get Entered Stamps only gets the stamps of the current user and not all 

selected users.
●     In PageWizard, Function Get Corrected Stamps does not show all stamps, they do, however, appear 

when we do a Get stamps by status: corrected?
●     SOSET Remote starts up instead of the Full version
●     Typeset "freezes" while importing a logo
●     Using the Import SOSET Windows command and filling in the CustomerId results in a checksum error.
●     We need to have stamps in JPEG-format for our web-site?
●     What is the difference between SOSET Typeset Gold and SOSET Typeset Silver?
●     When I try to bring up a template that contains a logo and copy created before the update, I get the 

copyfile failed error message. 
●     Where can I find the Euro-symbol?
●     When using the import logo button on the toolbar, the selected log-file does not appear in the logo-path 

field. To logo is also not displayed in the stamp.
●     We are unable to read images in CDR, AI, EPS etc formats in the new SOSET Typeset 32-bits version?
●     We installed the new SOSET typeset 32-bits version 4.01. Will our customers on SOSET remote need to 

upgrade to the new version as well?
●     Why functions the line-spacing so different from other DTP software?
●     We are unable to engrave seals on our M&R, RSX laser. In PageWizard, the seal the counterpart is 

missing, only a red cutting line appears here.

SOSET ORDER ENTRY QUESTIONS: 

●     Shipment interface copies shipment data into your shipper's format
●     Automatic currency from web-site in currency-table
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●     Can only one person be in invoicing at a time?
●     We want to edit the invoice address in the "Enter invoice address" in SOSET order entry , while entering 

an order. This is not possible, why not?
●     Can I change the customer number in an order in SOSET order-entry?
●     Can I enter decimal values in the quantity field?
●     Can we have several prices for the same product and can they be in the same currency's?
●     (Not) Deleting Customers 
●     During order-entry we want to use need the bar-code of the product, normally we type the ProductID in 

the Field PRODUCT ID, is there a solution?
●     How can I change the next available ordernumber and/or invoice-number?
●     How can I print an Order Confirmation, Packing List or Invoice?
●     How can we print business cards?
●     How can we specify special prices for a group of customers?
●     How do we import the few hundred or so customers we have? We'd rather not retype all the information.
●     How to cancel an invoice?
●     How to edit the last used invoice number?
●     How to print a product-report?
●     How do we set up boxes?
●     How do we put jobs in boxes?
●     How do we ship and print delivery notes?
●     How do we invoice?
●     No default Tax and No default Discount.
●     Why can't we go back to an already invoiced year?
●     What do I do when a customer cancels his requirement and he sends the goods back to the stock?
●     While engraving a stamp there still is an edge left (good to see in a print).
●     Unable to find the Typeset Program error in SOSET order entry
●     What does "Quality Control" on an order mean?
●     What does "Check shipment" on an order mean?

TYPICAL ERRORS: 

●     Codebase error overview
●     Codebase error 935 occurs when starting up SOSET 
●     File Access Denied in NamoUtil program
●     Fatal Error, Soset NamoUtil program will close and quit.
●     Using the Import SOSET Windows command and filling in the CustomerId results in a checksum error.
●     Missing default ... when starting OrderEntry (after updating) you get the message: No default Tax and 

No default Discount.
●     Namokey is not running but we get the message: namokey is allready running
●     Runtime CodeBase errors.
●     Setup error -115 (+ filename(s)) during running of the setup.
●     Silver version starts, however the date for the Gold version is not expired yet?
●     SOSET Remote starts up instead of the Full version 
●     Stamp definition not empty. Can't close element. Not a Correct Index File is exclusive, locked, or dos 
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read-only-parent leat mismatch invalid. An active window has been closed.
●     When I click on the tiny "T" in the upper left of the Order Entry Screen, I get the message "Unable to find 

the Typeset Program". How do we fix this problem? 
●     What to do in case of serious license and other emergency? Read info.
●     Problems with downloading SOSET program-files. Read info.
●     In NamoUtil I am getting a file access is denied error. Read info.
●     I only get data on screen when downloading namosoft.sos Read info.
●     Codebase error information. Read info. 
●     SOSET error information. Read info. 

FREQUENTLY ASKED QUESTIONS AND ANSWERS SECTION: 

●     1. I cannot use the option as it is advertised?
Make sure that you have the latest version. You can download these from our web-site download pages 
or request via e-mail mail@namosoft.nl

●     2. Is SOSET ready for the year 2000?
Yes, SOSET is ready for the year 2000! YEAR 2000 compatible memo: in the SOSET order entry 
software all output of date-fields to screen and printer have been modified to apply to Windows standard 
settings. All screen and printer output in the SOSET order entry have been modified, to allow you to 
choose the format now. Use the Regional Settings in the Control Panel to specify your preferred format. 
With this change, the date-format in the SOSET Preferences is NOT available any more. Visit the 
NamoSoft-Y2K-page where you can find the latest information, testing information and an official 
NamoSoft memo (2000.doc and 2000.txt) in the document directory on the distribution CD-ROM, about 
the year 2000 compliance of the SOSET software.

●     3. When using the import logo button on the toolbar, the selected logo file does not appear in the 
logo-path field. The logo is also not displayed in the stamp.
Copy the file ISGDI9.INI from the setup directory (of CD-ROM) to the <drive>:\APPS\SOSET\FILTER 
directory.

●     4. We are unable to read images in CDR, AI, EPS etc formats in the new SOSET Typeset 32-bits 
version?
The image options in this version have been dramatically changed and is exchanged for a more reliable 
and modern library. This library offers more and new import formats. Unfortunately not all formats are 
available, due to license-regulations. You can download the special 16-bits program image.exe which 
contains the "old" filters and can be used to convert the various file formats into a WMF-format for import 
into the new SOSET typeset. We also recommend to use the OLE-options to link 3rd party application-
designs to a SOSET typeset stamp.

●     5. We installed the new SOSET typeset 32-bits version 4.00. Will our customers on SOSET remote 
need to upgrade to the new version as well?
The new SOSET typeset 32 bits version 4.00 is very new and requires some experience before further 
distribution. The new version can read from previous versions. Only if there is a need for some of the 
new options you can upgrade your remote sites also. Keep in mind that this version is NOT backward 
compatible.
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●     6. Stamp definition not empty. Can't close element. Not a Correct Index File is exclusive, locked, 
or dos read-only-parent leat mismatch invalid. An active window has been closed.
This is a MS Windows bug. You need to run the program: Vrdr2upd.exe (in the windows directory of the 
SOSET CD-ROM). This will fix a database handling error in the Windows system.

●     7. In PageWizard, Function Get Entered Stamps only gets the stamps of the current user and not 
all selected users.
The UserID must consist of two 2 digits (e.g. UserID=01 instead of UserID =1). Check this in User.dbf 
with NamoUtil

●     8. Setup error error -115 (+ filename(s)) during running of the setup.
The named files have property Read-Only on your local drive. The setup cannot override these files 
unless you change this in property in Archive or delete the file.

●     9. Runtime CodeBase errors.
There is a known Windows 95 / Windows NT buffering problem, where Windows 95 workstations that 
open files shared from Windows NT machines have problems with buffering. This is caused by a 
corrupted Virtual Network Redirector (VREDIR.VXD version in the Windows-system directory).There is 
now a new VREDIR.VXD for Windows 95 that does disable the buffering of files shared on Windows NT. 
Refer to the readme for the latest information about his. You can also download the latest version of 
VREDIR.VXD

Other Codebase errors:
●     10. The tabulation position does not move?

The tabulation in Soset typeset is a very well considered approach which is totally different from most 
word-processors or DTP-software; it offers strict positioning. After a while you will experience its power 
and efficiency. E.g. where a tab normally moves forward when entering more text, the Soset tab remains 
where it is. In this way new, modified and deleted tabs do not influence a stamp design. The tab-leader 
option offers even more flexibility and efficiency.

●     11. Why functions the line-spacing so different from other DTP software?
As Soset calculates the (very exact) size of a capital character in mm/inches, it initially sets the line-
spacing to that same size and each new textline will have the previous line-spacing. This makes that text 
exactly starts at the top of a stamp, which is very difficult to achieve with the uncontrollable point-size in 
other software. Especially for the design of accounting stamps and circular and oval stamps this 
approach offers more precision and efficiency.
In word-processors and DTP-software a character has a corps, which is "flesh" above and below a 
character and that makes that characters automatically have a certain linespacing. This makes also that 
you never can start a text exactly at the top of a stamp and/or position a text exactly within a circular or 
accounting stamp. 
We recommend to use the design-wizard and the text-linespacing options to let Soset suggest most of 
the line-spacing.

●     12. How do we import the few hundred or so customers we have? We'd rather not retype all the 
information.
For the setup of Soset order entry we generally advice to follow the instructions of the setup1.doc from 
the document dir on the CD-ROM, you can also find a copy of this file at our web-site: 
http://www.namosoft.nl . For the import of customers there are several options: It depends what type of 
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file you currently have. Normally you will have a dBase-type of file or perhaps you can export the data 
into an ASCII-file, but also Excel files and so can be used. In NamoUtil Import you will find may import 
options. It is very advisable to have a remote PC-AnyWhere communication session we can look at the 
file and possibly do a conversion on line.

●     13. In exploring NamoUtil, using "Open Table Exclusive", we sometimes get the error message: 
"File Access Denied " This usually happens when we try to open "Product.dbf" or so. The next 
message we get is "Fatal Error. Soset NamoUtil program will close and quit."
The errors are caused by the fact that you try to open the file exclusive while others are using it. Be 
advised to only use exclusively for routines like re-indexing and so. Normally you can use the shared 
opening.

●     14. When I click on the tiny "T" in the upper left of the Order Entry Screen, I get the message 
"Unable to find the Typeset Program". How do we fix this problem?
It seems that some programs have been moved from the original position and that the SOSET order 
entry cannot find the SOSET typeset program. One of the solutions is re-installing. Another easy solution 
is the following; Please check the ORDER.INI file in the windows directory. Open this file with Notepad 
or Wordpad and check the Soset ProgramPath=C:\APPS\SOSET In that same path there has to be the 
typeset.exe otherwise Soset order entry cannot find it. If this is the wrong path, we recommend to 
change it accordingly. Make sure that you save as Text Document when you are finished editing the 
order.ini.

●     15. We want to edit the invoice address in the "Enter invoice address" in SOSET order entry , 
while entering an order. This is not possible, why not?
Editing an invoice-address should only be done in the customer data screen, where you will find several 
options. You should always know where the invoice is going to. In this way it is not possible to have 
many invoice addresses for one and the same customer. This makes it easier to deal with payment 
problem situations; now you know very well where you should send the overdue form.

●     16. Missing default ... when starting OrderEntry (after updating) you get the message: No default 
Tax and No default Discount.
Set the default Tax and Discount in the OrderEntry preferences.

●     17. Using the Import SOSET Windows command and filling in the CustomerId results in a 
checksum error.
Both on the remote- and host side the same Remote.sos must be installed in the license directory.

●     18. What does "Quality Control" on an order mean?
This option checked, will print the word 'QUALITY' on internal information (runcards, overviews etc.) and 
produces an extra label during a shipment run with the same word. This will help to improve quality of 
these orders.

●     19. What does "Check shipment" on an order mean?
With this option checked, you will be prompted with the shipment dialog on updating an order. This is 
very important if a customer has different shipment addresses for each order and different shipping 
requirements in general.

●     20. Silver version starts, however the date for the Gold version is not expired yet?

http://www.namosoft.nl/FAQ.htm (6 of 14) [10-Jul-2002 11:51:34 AM]

http://www.namosoft.nl/HELP/nsoft_tech_support.htm#Instructions for Modem-Connection with NamoSoft-support


faq

Check date from the PC. Use the Maintenance show code command in NamoKey and call NamoSoft for 
further assistance.

●     21. Can I change the customer number in an order in SOSET order-entry?
The Order New option defaults to the chosen and before used customer number, but also allows you to 
select a customer number, by clicking on the question-mark and search. SOSET does not allow you to 
change the customer number in the order. The reason for that is very simple, Order conditions, pricing 
and discounts are built by the data from that particular customer. Changing the order number afterwards 
would create a situation where all this information might be changed? Some order items may only be 
used by some customers. Some conditions are specific for one typical customer. We strongly 
recommend not to choose for such dramatic changes!

●     22. How to set up a New Company in SOSET order-entry?
Please refer to the setup1.doc in the document-directory on the SOSET distribution CD-ROM or find 
Company-information in the on-line help.

●     23. How to print a product-report?
There is currently no option for printing product overviews in SOSET order entry. However, the NamoUtil 
program offers many possibilities to define and save your own customized overview of any database-
table, including filters and index-order. Although we are preparing for a new version with more report-
options, we still consider the NamoUtil program as the best way to retrieve all kind of information.

●     24. Can I enter decimal values in the quantity field?
Soset does not allow decimals in the quantity field. This is based on the fact that fractions of stamps are 
never sold and this might cause problems when entering, per accident, 0.1 or so as quantity instead of 
1.

●     25. How to edit the last used invoice number?
In the SOSET Order entry you change this setting with the option File, Preferences, Internal, Change 
last used invoice number.

●     26. How to cancel an invoice?
You have the option to delete an order, so that it will not be invoiced. You cannot delete an invoice. (The 
data might have been exported to GL and SOSET cannot control GL) Instead, we recommend to enter 
the same order, but with negative quantities. In both situations SOSET will update the stock accordingly.

●     27. How can I print an Order Confirmation, Packing List or Invoice?
Normally the printing of all forms is automatically processed by SOSET if necessary. By changing the 
order status into Order confirmation and print you will get the order confirmation. Printing a packing list is 
currently only possible during shipment. Further, there is a print invoice option in the order screen, under 
Tasks, Invoicing. Keep in mind that one invoice may contain more than one order. This can be caused 
by the batch invoice option. Note: a new document print option has been added to the order screen 
under the File menu.

●     28. During order-entry we want to use the bar-code of the product, normally we type the 
ProductID in the Field PRODUCT ID, is there a solution?
To use bar-codes in order-(item-)entry you need to have the bar-codes in the barcode field in the 
product-table, you can read these in in the product-screen.
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During order-entry you scan the bar-code, when you are at the product-id field; SOSET always tries first 
to find the product via the bar-code field and if found show the appropriate information.

●     29. In Order Entry, how do we set up boxes?
First you need to have self-adhesive sheets or label-sheets. We advise to have small boxes (cardboard 
is OK as a start!) In NamoSys you need to set the barcode label preferences the same as these. Also in 
NamoSys you will find an option to print barcode labels under the File option. Enter here a range from 
e.g. 100001-100100 (ALWAYS 6 digits!) Put these labels on the boxes and put the boxes in the 
sequential row, rows and/or on a shelf.

●     30. In Order Entry, how do we put jobs in boxes?
After production, controlled by the runcard you take one of these boxes. No matter which one, just use 
an empty one! With the OrderEntry, Tasks, Shipment, In box option you enter the number from the 
runcard and next the number from the box. This will store the box-location in the orderitem information. 
You can check that by looking up that orderitem and you will see the box-number.

●     31. In Order Entry, how do we ship and print delivery notes?
With the OrderEntry, Tasks, Shipment, Ready to ship you can start a shipment run. Choose between a 
large or a small one or send only goods for selected customer groups. In a small shipment-run all 
finished orders are selected for shipment, only if there are no other orders from that same customer, in 
production any more. In a large shipment-run all finished orders are shipped; no matter if there are still 
others orders from that same customer in production. During a shipment run all orderitems and 
completed orders of the same customer are combined and depending on the specified shipping day (in 
the customer-screen) the orders will be processed. Depending on the customer-invoice specification you 
will get an invoice if shipment-invoicing is selected there, else you will get a packing list. Both forms 
specify the box-numbers. Soset will also produce an shipping-overview and labels. If specified: freight 
charges and best way of shipment is calculated and processed. The only thing you have to is to take the 
goods and pack it. Check now if there are orders not completed or having problems and change the 
status of these orders back to in production in the order entry. The other orders are shipped and you 
inform Soset about that with the Tasks, Shipment, Shipped option.

●     32. In Order Entry, how do we invoice?
Run a Tasks, Invoicing, All orders run and the rest of the orders will be batch-invoiced. The invoice will 
be produced as specified in the invoice-specifications in the customer-data-screen.

●     33. SOSET Remote starts up instead of the Full version
Check in Namokey> Software ProtectionKey info if your license hasn't expired. If so download the 
newest license file, namosoft.sos from this website. Copy it to your license directory

●     34. Codebase error 935 occurs when starting up SOSET
Reindex all tables in NamoSys

●     35. In PageWizard, Function Get Corrected Stamps does not show all stamps, they do however 
appear when we do a Get stamps by status: corrected?
In most situations this was caused by a missing printsetID in the stamp. The product does not have a 
printsetID or the printsetID has been deleted in the printset-table and consequently the stamp cannot be 
grouped in the PageWizard. Explains also why it appears with a run by status: corrected. This sort does 
not look at the printset and does not do any special page-layout.
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This problem is solved in version 3.3 and higher. Advise to install latest version from 
http://www.namosoft.nl/download_usa.htm

●     36. How do we setup a SOSET remote user
Create a remote.sos file. You do this in SOSET namosys> utilities> generate remote license file.
Although the min. and max. remote No. are not in use right now, it is required that these fields are filled 
in (8 digits). The telephone number must be filled in to.
Copy the remote.sos to a floppy disk.
On the remote location you can now run setup to install the SOSET typeset remote (during setup you 
can choose "Remote Typeset").
Write down the license path which can be specified during setup
After setup you need to copy the remote.sos file from the floppy disk to the license path
When you create the remote.sos SOSET Namosys will automatically copy SOSET tables in the 
\data\soset\remote directory. You need to overwrite the demo tables on the remote side with these 
tables. This way you make sure that both you and the remote user have the same technical information 
in the database (e.g. color data, printset data, etc.).
Keep in mind that a remote version can't be used for production. The output is gray and cannot be 
recovered.

●     37. When I try to bring up a template that contains a logo and copy created before the update, I 
get the copyfile failed error message. 
This error happens with WMF-type images. The newest image procedures require that a so-called 
placeble header available is NOT within that WMF-file. Soset checks for this header and if there is one, 
SOSET takes it out. This replacement requires that the image-file can be overwritten.
This error indicates a possible read-only lock on that file.
In Windows Explorer you can use the File, Properties to uncheck the read-only attribute.

●     38.I only get a lot of data on my screen if I try to download the license file namosoft.sos from the 
download directory
The registry of the file type *.sos is missing. Simply double-click on the namosoft.sos file in the SOSET 
license-path and select Notepad you want to use to open this type of file and the registry is ready now.
Note also: sometimes you will receive an older version of the Namosoft.sos, this is caused by the fact 
that the Internet Explorer caches the version. Therefore you need to clean up the cacher via the Internet 
Explorer menu, Tools, Internet options, in the section Temporary Internet Files, you click on the Delete 
Files button.
Next you can download the Namosoft.sos again and you will receive the latest version. 

●     39. We are unable to engrave seals on our M&R, RSX laser. In PageWizard, the counterpart is 
missing, only a red cutting line appears here.
With NamoSys, Browse, laser-table you need to check the "RSX"-box indicating that you 
are using a M&R, RSX-laser. 

●     40.Why can't we go back to an already invoiced year?
Once you have made invoices for the new year 1999, you have made a decision that the previous year 
cannot be used anymore for invoicing. Soset warns you for this. This protects SOSET invoicers also 
against trouble with the tax-department; generally they do not accept gaps in the range of 
invoicenumbers, which will happen if you could invoice before last-used invoice-date.

●     41.  What do I do when a customer cancels his requirement and he sends the goods back to the 
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stock?
Enter the same order, but with negative quantities. This will deduct the quantities and with invoicing that 
order you will get a credit-invoice to balance the previously entered order and invoice.

●     42. While engraving a stamp there still is an edge left (perceptible in a print).
Open the file pagewiz.ini (wich is found in the windows directory) in notepad or wordpad. Add the 
following line to Pagewiz.ini: Correction White=25     -->this means 0.25 mm extra engraving space 
around the stamp. Make sure that you save as Text Document when you are finished editing the 
pagewiz.ini.

●     43.* How can we specify special prices for a group of customers?
SOSET allows you to set up customer groups and each customer can be a member of such a group. 
This makes it very easy to set similar specifications, discounts etc. for all the members of that customer 
group. It also makes it possible to have special prices for a group of customers. This is done by selecting 
a customer-group in the product with the special pricing. During order-entry SOSET will first search for 
the product+the customer-group ID and take that product, if available. Otherwise SOSET will take the 
product, with an empty customer group ID. This means that you can have a same product ID, several 
times in the product table, as long as they all have different customer-group ID's. Therefore it is advised 
to duplicate a product and specify the customer-group. You can specify the prices of each product in the 
default currency and also 4 different currency's. You will understand that this way also enables you to 
better query your order and product tables on product ID AND customer group ID.

●     44. Can we have several prices for the same product and can they be in the same currency's?
SOSET supports multiple pricing and also allows to have them in the same currency's.
It is important to understand the customer-group option, which in fact leads to a better use of the product 
table.
If you still want to have several prices in the same product, you should follow this procedure: 
Important:make sure that the UsePriceList in the System-table is specified to 0, otherwise NamoUtil will 
report a: Nothing to do! (You also need to have the latest version of the NamoUtil program, available via 
our web-site download directory) From within the NamoUtil program you should run the SOSET Utils, 
5Price option; however this option has been secured and you need to contact NamoSoft, which enables 
us to check the situation and which will avoid any problems with this. The 5Price procedure will add 4 
different currency's to the currency-table, in fact 4 currency-ID's, with description: price_2, price_3, 
price_4, price_5 all of them with currency=1. In the product-screen you can now enter various prices and 
choose one of the available currency options. In the customer-data screen you can also choose from all 
of the currency options to specify the pricing you want for this customer. It is recommended to enter a 
few orders for testing, to see if all settings are in accordance to your requirements.

●     45. Soset error information.
To enable troubleshooting, Soset stores error and other messages in a soset.log file in the default 
datapath. You can find this file in the SOSET datapath. SOSET NamoUtil offers options to view, print 
and analyse error-information in the Soset Utils menu. The soset.log file and *.err files (in temp-subdir) 
can be deleted on a regular base.

●     46. When will orders be archived?
When orders will be archived depends on the following criteria;
1 While invoicing, the invoiced orders get the invoice status 02 (this means invoiced) and the given 
invoice date.
2 When an order isn't marked for deletion and the order status "deleted = 06" or "shipped = 12" and the 
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invoice status "invoiced = 02" and the invoice date is smaller as the archive date. The archive date is the 
current date minus 100 days.
3 The orders will be archived in the year of the invoice date. (E.g. 04-02-1998 is archive year 1998)

●     47. I would like to run some tests with the new SOSET software. Can I have an extra software 
protection key that I could use for testing?
A SOSET software protection key represents and controls a SOSET-license. We do not have an option 
to provide a key for testing purposes. However, if you have a multi-user SOSET license there is no need 
to have an extra key for testing. You can perform a local installation where you specify the shared 
licensepath. E.g. if your current programpath is f:\apps\soset and the datapath is: f:\data\soset and the 
licensepath is f:\data\license you can now install local with programpath C:\apps\soset and the datapath: 
C:\data\soset and with the shared licensepath is f:\data\license. You also can run a SOSET remote 
typeset without any key. This version offers all typeset functions for testing.

●     48. Typeset "freezes" while importing a logo
To fix the logo problem add in the c:\windows\Typeset.ini under the Default Settings the following 
section: Use Preview Dialog=0
This will disable the Preview dialog and turn it into a regular open-file dialog which will work better.

●     49. Do we need to purchase statement forms (printed forms with blank area to place our monthly 
customer activity for each month) which are set up to match Soset's standard output or can we 
format the activity to print on our existing statements?
SOSET actually only covers order-entry and typesetting and no accounting. Normally customer- and 
accounting-data are exported into an accounting package.
However, you can register all payments in SOSET order entry via menu: Tasks, Invoice register, Pay-off 
and next you can print the Overdue statement from the same menu.
The layout of this statement is fixed.
In general you can use pre printed paper with a header and a footer for all SOSET invoices, shipping 
notes, statements. SOSET will print necessary info on the form. You can use tractor-feed paper for this 
to print on a matrix-printer. Make sure that header and footer are similar to the sample I faxed to you; so 
without frames and texts printed in the middle!
You can also define header and footer files, which are (laser-)printed at pre-defined positions on a letter-
sheet form by SOSET

●     50. Namokey is not running but we get the message: namokey is allready running
This happens when namokey isn't properly shut down. For example when the computer where the 
key(s) are fysically attached to, crashes or hangs itself up. When namokey is started, it crerates the 
following 2 files in your license directory:
- actuser.dbf
- license.dbf
When you shut down namokey properly, it deletes those 2 files. In case of a system crash, those files 
couldn't be deleted, so all you have to do is make sure everybody is out of soset, and delete those 2 
files. Namokey could now be started again.

●     51. In NamoUtil I am getting a file access is denied error. Method Browse; error info saved in etc. 
line ...
This is appearing in the NamoUtil program, when trying to save a database-table. All editing during a 
browse operation is immediate, the table is opened and you are editing the actual records in the table. 
After the editing you only have to close the table, there is no need to save again. If you try to save you 
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will get a conflict with your own editing situation. 

●     52 * How can we print business cards?
The fixed-positioning options in SOSET PageWizard offer necessary tools to accomplish this. On our 
download directory you'll find the sample business.dbf with an example of the settings. Please follow 
these instructions carefully and you will see how this works: 

❍     Open the NamoUtil program and via File, Open table shared you choose the PrintSet-table. 
❍     Next File, Import and choose the sample table: business.dbf (available @ 

ftp://ftp.namosoft.nl/download/business.dbf). 
❍     You will find one new PrintSet-option (#39, called: BusinessCard) added to your PrintSet-table. 
❍     Open NamoSys, File, Browse: PrintSet-table and the dialog will show the Fixed Position checked 

and you will find Start X+Y and Delta X+Y values. 
❍     Now you can create a product Business Card in the product table and design in SOSET typeset. 

Size is of 3" 1/2 by 2", make sure that you choose and change the PrintSet into 39

●     53 Can I use the SOSET software with any laser engraver or any other output device ? 
Soset is compatible with any Windows driven device. I.e. if there is a Windows 95/98/NT/2000/XP driver 
available for your laser engraver, Soset you can make use of the laser.
The SOSET software has been designed to comply with Windows standards.
If a Windows compatible driver has been installed, you can output from within the SOSET software. 
The automatic design of cutting-lines and the support for automatic engraving of die and counter for 
seals will be available for ALL type laser engravers, per January 1, 2002, including the M&R laser 
engravers.

●     54 How do I get a list of all of my customers that are in a group?
There is no option for these overviews in soset. With Namoutil you have the option to specifie any query 
you want. You can change specify the fields and filter under the view menu. you can also export part or 
the whole table for further handling and analysis in e.g. MS Excel or MS Access. (Note: never open the 
original SOSET tables in a a 3rd party programm!)

●     55 How to delete customers in SOSET OrderEntry 
SOSET has been designed to exchange data with an accounting package. As here is no control over the 
financial status of customers, SOSET does not have the option to delete customers. It is very important 
to keep this.
If you want to delete customers you have to use NamoUtil, open the customer-table and use: Table, 
Delete records option. Be advised to handle this very carefully, as wrong criterion settings in NamoUtil 
might bring quite some dramatic and irreversible difficulties.

●     56 Can SOSET typeset run without software protection hardware key or how to use and install 
SOSET typeset remote software?
Yes, Soset typeset software can work without a key, BUT in that case it will behave as a remote typeset 
version, which does not support normal printing, page-wizard etc.
If you start Soset typeset software without a hardware key you will get a message:
Soset cannot find a valid license and/or hardware key. Soset can now only run in remote mode with 
limited capabilities. Please contact your host or Namosoft.
Feel free to copy and distribute this license free Soset typeset remote version.
Keep however in mind, that a remote version cannot be used for production; the output is gray and 
cannot be re-covered.
A Soset Typeset Plus* version offers an option to create a special interface for importing stamps from a 
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Soset typeset remote version.
(* special license required)

●     57 Archive option issues in NamoSys and NamoUtil
The archive-option in SOSET NamoSys and SOSET NamoUtil are not designed to create space and will 
only slightly compress data.
In general we do not recommend to delete data and/or files to generate diskspace.
Harddrives come with huge volumespace and database-systems are designed to handle large volume 
tables.
Searching for information within SOSET is faster than any other search. By simply entry of jobs, the data 
are simply build up and should be used.
The archive-procedure  is meant to get archive-files for each year and to enable you to isolate these.
The archive-procedure also checks data and correct errors and re-write the job-files, which improves 
disc-access and usually optimizes the performance of databases in general.

To prepare your tables for archiving use the NamoUtil option:"SOSET Utils > Production status update" 
(to activate use pincode 7676).
When this command has finished you can archive stamp via the Archive option in NamoSys.

●     58 Can only one person be in invoicing at a time?
In case an invoice-run has been started all other stations who try to start invoicing or a shipment-run 
(with invoicing) will be notified by the question:
User-X is running invoice-run. Is this correct?
HOWEVER: Handle this with care! If you answer NO, it might happen that the two invoice-runs have the 
same order-numbers.

●     59 * Enable proofprint with Outlook Express 
Outlook Express 4.x and Windows 98 

1.  On the Tools menu, click Options.
2.  On the General tab, click the Make Outlook Express my default Simple MAPI client check box to 

select it.
3.  Click Yes when you are prompted to set Outlook Express as your default Simple MAPI client.

NOTE: If you use another MAPI-enabled e-mail program such as Microsoft Exchange, Microsoft 
Outlook 97, or Microsoft Windows Messaging, it is no longer your Simple MAPI client when you 
set Outlook Express as your default Simple MAPI client. To set your other e-mail program as the 
default Simple MAPI client, click the Make Outlook Express my default Simple MAPI client check 
box to clear it. Click OK, and then click OK again when you are prompted to restart your 
computer.

4.  Quit Outlook Express, and then restart your computer.

 Outlook Express 5 

1.  On the Tools menu, click Options.
2.  On the General tab, click Make Default next to This application is the default mail handler.
3.  Click OK. 

●     60 Standard Windows shortcuts
We agree that we should comply more to the Windows-short-cut layout. Several short-cuts origin in 
photo-typesetting equipment, next they have been copied into our DOS-versions (back to the eighties) 
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and so they appeared in the Windows versions. 
We are reluctant in changing this, as this might cause some confusion and production problems around 
the world! It is in constant study and definitely high on the list for a next generation SOSET software.

●     61 * How to prepare data in e.g. Excel-format into a format which can be used with the SOSET 
Import ASCII/ANSI option? 
Open the table Sosetemp.dbf (included in your SOSET setup) in NamoUtil. Next use File, Import and 
choose from the several import formats here. Select the file and enter the name of the (temporary) table 
you want to create from the choosen import-file.
Use NamoUtil, File, Close and next File, Export, SOSET, Typeset ANSI and enter the text-filename. You 
will receive a text-file which has all fields of the Excel-file printed below each other, ready for import into 
SOSET typeset.

●     62 I need to have stamps in JPEG-format?
We have added an option to export designs into JPEG-format.
This option will automatically create a JPEG image of the design when you are updating it.
These images are used in combination with SOSET-via-the-web.
To enable you to have images of all earlier entered designs we have added the option: 'Export all 
stamps into JPEG-format'.
You will find this option in SOSET typeset, menu: File, Export
Next you need to check the box 'Always save stamp in JPEG-format', under File, Preferences, Global.
This option will automatically create a JPEG image of the design when you are updating it 

●     63 * Automatic currency from web-site in currency-table
With SOSET NamoUtil you can now automatically update currency-information in the currency-table.
The parameter can be specified in adding a record to the system table: 
In the field parameter you enter the text: CURRENCYURL and in the VALUE field you enter the full URL-
link to the currency-web-site. 
NEW feature: An extra parameter should be added to verify that the web-site has not been changed.This 
parameter is called:
CURRSITE_ID and in the value field you should enter a specific part from the beginning of the HTML-
sourcecode.
This could be something like: 'Currency information, Foreign against EURO'. If this string does not 
appear in the html-source of the page on the specified site, you will get a warning.
To avoid errors in case the web-page changes we have to build in a few simple checks. Therefore you 
need to let us know what url you want to use for this and we will modify this to your needs
With the NamoUtil option: SOSET options, Currency from HTML file the currency-table will be 
automatically updated.
You will have a choice to add 5% to the currency-value to minimize your cost of exchanging foreign 
currency.

●     64 How can I change the next used order-number and/or invoice-number?
In SOSET NamoUtil, Tools you will find the option: Change Order/Invoicenumber.
A PIN: 7676 is required to change the numbers
You are prompted with the current number and have options to confirm the new entry. 
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NAMOSOFT README INFORMATION
Updated: Monday, 22 April 2002 13:13

This file contains latest information about setup and use of SOSET TYPESET for Windows, Windows for 
Workgroups, Windows NT, Windows 95 and Windows 98 and SOSET ORDER ENTRY for Windows 95, 
Windows 98 and Windows NT/XP, 2000.

No part of this document may be reproduced or transmitted in any form or by any means, electronically or 
mechanical, for any purpose, without the express written permission of NAMOSOFT BV.The manual and 
associated software is sold with no warranties, either express or implied regarding its merchantability or fitness 
for any particular purpose. Information in this document is subject to change without notice and does not 
represent a commitment on the part of NamoSoft BV. © 1994-2002 NamoSoft BV. All rights 
reserved.NamoSoft, Naammo and SOSET are trademarks of NAAMMO DYNAMICS BV. Microsoft, MS, MS-
DOS, TrueType, Windows and Windows NT, FoxPro are trademarks of Microsoft Corporation in the USA and 
other countries. Exos, NetWare, and Novell are registered trademarks of Novell, Inc. dBase is a registered 
trademark of Borland Int., Inc. All other names are copyright and registered trademarks/tradenames of their 
respective owners

Our general e-mail address is: mail@namosoft.nl You can also e-mail to our departments by using:  
sales@namosoft.nl, admin@namosoft.nl, support@namosoft.nl

NamoSoft BV is putting a lot of effort to improve and add new options to the SOSET software. Make sure that 
you always have the latest version, your questions might be answered with new options and fixes. 
You can download these from our web-site: download pages or request via e-mail: mail@namosoft.nl

-SOSET-via-the-web released! Now available with XML-import options. 

-SOSET and new Windows XP:  
This combination has been tested intensively and there are no problems reported!
If you encounter any problem that might be related to this combination please let us know. 

-New utilities in NamoUtil program version 7.3
The NamoUtil program has been modified and updated with the latest techniques. 
New engines have been added to make this power-utility even more reliable and flexible.
This situation has caused us to change the menu-structure into a clear overview of options.
Check the following help-files for totally updated information about the new menu-structure and options.
File-menu, Edit-menu, View-menu, Options menu, SOSET Utils menu, Tools menu
Note: for installation you need to install new dll-libraries into your Windows-system. 

CustomerID-field note: with the newest versions of all SOSET software the CustomerID in the Customer-
table has been replaced by the field CustID. This will improve compatibility.
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You might encounter minor difficulties in using the wrong version of NamoUtil.exe. 
Make sure that you have updated both versions to the latest from our download-site.
For backward compatibility you will find a version of NamoUtil.exe which supports the CustomerID 
field.
Therefore you download the file ftp://ftp.namosoft.nl/download/NAMOUTIL.EXE before CustID 
After the download you should rename this file into: NamoUtil.exe. 

announced September 29, 2001
Import from free SOSET typeset remote requires order-clicks
Starting January 1, 2002 the current import into the SOSET tables will be changed dramatically.
Only import from XML-based files will be possible, the old import and export format will be cancelled.
From that date all SOSET export and web-utilities will only generate export-files in the XML-format.
This will enable optimum compatibility with all available software-systems and languages.

-Tax-charges and SOSET-via-the-web 

-New state-of-the-art tools in SOSET-via-the-web 

-HTML-based HELP 

-HELP in PDF-format  

-Windows compatibility shortcut-changes  

-IMPORTANT: WizzKey Hardware key not longer supported 

Section 1  NamoUtil version 7.3 released (March 31, 2002); Multi-language tools, XML-tools, Password 
generation for SOSET-via-the-web

Section 2 SOSET options at Naammo BV for ISO-9002 certification

Section 3 License for laser options per January 1, 2002

Section 6 New version: SOSET typeset 4.39.1 and SOSET order entry 2.39.1
(updated March, 2002) also information about previous updates

Section 6a Easier downloading and installation with SOSET DownLoad-Wizard

Section 7 Running Namokey on a Windows NT-server a special driver is required.

Section 11 Soset multi-user version in Novell Network. To avoid CodeBase error -200/-83805 refer to 
section 11 of this readme information.
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Section 12 Soset multi-user version in a Windows NT4.0 Server + MS-Network+ Win95 Workstations. For 
troubleshooting refer to section 12 of this readme information.

Section 38 SOSET Client/Server version  

Section 43 Settings up a remote connectio for support 
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0 GENERAL INFORMATION:
-OpenType the new font standard; SOSET will support OpenType very soon!
-SOSET IS READY FOR THE YEAR 2000, refer to information on our website or read 2000.doc and 2000.txt

1 New version 7.3 of NamoUtil released, includes Password generation and language-tools for SOSET-
via-the-web
-Password generation for SOSET-via-the-web

Version 7.2
-Installation of new dynamics libraries (dll-files) required.
-Menu options further structured and in alfabetic order.
-XML-tools have been added. Contact Namosoft as these are only available for licensed users.
-Options for conversion for various shippers like UPS; refer to shipment interface (others contact NamoSoft)
-autostart: now you can click on a *.dbf file and NamoUtil wil open the table automatically. 
 (if not: click on file once, click right mouse and select Open with, next you specify the path to NamoUtil with the 
other option)
-View, Count-sum information for totals on the open table
-SOSET utils, Invoices Aging report
-SOSET utils, table overview (shows table-size and record-count of all tables)
-Tools, Remake options for overviews of registered remakes
-automatic currency-update option, refer to Automatic currency from web-site in currency-table 
-option or company conversion to Euro (one-time fee)
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NamoSoft has modified the SOSET software to fully comply to Euro-specifications. You will find Euro-options in 
the order-entry preferences, the customer and order dialog. But also output has been modified to support Euro-
signs and printing of both currencies on cash-receipts and invoices.

Convert from your current EMU-currency to Euro
With a special option in the NamoUtil utility all tables in the SOSET database can be converted. 
This module has to be ordered with the special Euromodule-orderform.
At the moment you want to convert from your current EMU-currency to Euro you can use this option.
ALL currency-related fields in ALL tables will be converted: this means that all data in the order files, but also 
history and other overviews will be in Euro. 
For the customer-settings with the default currency specified Euro-cash receipts and invoices in Euro will be 
printed.
Until the definit date of introduction of the Euro (Jan 1, 2002) settings for special currency (e.g. Customer of 
Germany company wants invoice in Spanish Peseta's) will be respected. Another conversion is needed at that 
moment to convert all these also automatically.
This conversion is quite dramatic and can NOT be reversed. Therefore this can only be done under supervision 
and with the co-operation of NamoSoft support.

You will also find information in the EURO-section in the readme file. 

 

2 SOSET options at Naammo BV for ISO-9002 certification
Naammo BV, the sister-company of NamoSoft BV in The Netherlands has been ISO-9002 certified on 
December, 1999.

The ISO 9002 certification confirms that Naammo BV applies to the highest standards of quality. A great team 
and a disciplined organization are the basic ingredients for this achievement.
All processes, from customer-call, order entry, proofing, production, shipment until invoicing are subject of 
assessment. 
But also remake and complaint procedures are tested intensively during the 2 day examination for the ISO 9002 
commission.
The options are alsavailable in the SOSET-via-the-web module for the internet, allowing customers to use your 
quality registration system everywhere and always.

Several ISO-9002 related procedures have been implemented and/or have been optimized in the NamoSoft 
SOSET software, which controls order entry, typesetting, production, shipping and invoicing at the Naammo BV 
organization.

NamoSoft BV announces to include ISO-9002 in its SOSET-training. 

 

3 License for laser options per January 1, 2002

 

4 UNIVERSAL LASER ENGRAVER DRIVER NOT 32-BITS COMPATIBLE
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Note that the ULS-driver required to use the M&R-laser engraver is only available in a 16-bit version.
This version will NOT work properly in a 32-bit environment, such as Windows 2000 and Windows NT.
We strongly recommend NOT to install a Windows 2000 and/or Windows NT or other 32-bits environment on 
the system to which the M&R laser engraver is connected!
Please contact Universal Laser Scottsdale, AZ. mail@ulsinc.com for help.
They will inform you about the release-date of the necessary 32-bits driver and the link between SOSET and 
the Universal laser-engraver driver to support the M&R-button in the SOSET typeset software.

 

5 FAX AND E-MAIL DIRECTLY FROM WITHIN SOSET ORDER ENTRY 2.13
If you have e-mail and/or a fax driver installed on your system you can fax or e-mail directly from SOSET order 
entry.
On the customer data screen you will find the buttons for the procedure which copies the e-mail address or fax-
number from the customer into the outlook-messenger.

 

6 NEW VERSION: SOSET TYPESET 4.39.1 AND SOSET ORDER ENTRY 2.39.1
Updated March, 2002)
New versions are available via our web-site download page.
Note: When downloading the SOSET Update manually or with the Download Wizard, make sure you currently 
have SOSET version 4.25 or higher installed. 
If you have an older version, you are advised to download the SOSET full version.

 

New in SOSET order-entry 2.39:
-licensing via Namokey has been further improved.  
-new Searchoption on Order item description line 2; in this way also texts of e.g. nameplates can be searched 
for.
-products can no longer be edited in Namosys if order entry is installed; only in product dialog of the order entry 
module.
-language options have been added in the Maintain, Product and Maintain, Category dialogs.
 With the 'L'-button various languages can be added. More info in: language.htm
-option payment in order has been extended with 'Fysical payment' option.
 this is done to avoid errors with changing money from various currencies (like Euro)
-export in multi company setup includes companyid as automatic identifier (manual selection disabled)
-search-engines have been optimized and are all similar now.
-calculation information with right-mouse click on orderitem
-changing rush-code requires now date-check
-external info is now printed on all docs
-new option in payment dialog to enable payment in old currency; 
 this in preparation for Euro-conversion, customer can pay in old currency for a while. 
 (In system.dbf OLDCURRENCYID must be specified)
-layout on OPOS has been changed, due to fix for longer productID
-index on ship-to-addresses is now in alfabetical order
-copyright-field has been added to product-table, this can be used e.g. for publication in catalog or web-site
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New in SOSET typeset 4.39:
-licensing via Namokey has been further improved.
-wild-search is back again in the Record, Find menu.
-Layer-option in the Property-menu enables you to move an object step-by-step from foreground(10) or 
background(0).
-Search-engines have been optimized and are all similar now.
-In PageWizard a checkbox for rush-stamps has been added in the selection-dialog for corrected stamps
-products can no longer be edited in Namosys if order entry is installed; only in product dialog of the order entry 
module.
-delete laser-cuttinglines option in case PrintSet is changed
-message in case not all stamps of an order-item are on same page in PageWizard
-Close stamp, Update Yes/No? changed into: Yes, Cancel, No
-option to specify position in seal-embosser (1=top, 2=right, 3=bottom; 4-left)
-during export and import images are now copied in same (sub)directory
-export in quick typeset disables automatic expandoption for circular designs 

New in SOSET order-entry 2.38:
- Headers/Footers settings per customer and not anymore per customergroup.
- Rush code can also be adjusted per customer.
- Product image and product impression can be entered in the productscreen under the Image button.
- Category image and category description added to the category table.
- After printing order as packinglist you will be asked to charge shippingcosts.
- As SOSET Order Entry requires more information than SOSET Typeset and to avoid confusion the Product-
table can no longer be edited in NamoSys if SOSET Order Entry is installed.
- Missing production options have been added to the product-dialog in
- From export of order-data are excluded all orders with the following status: Proof/Embargo, Processing, 
Quotation, Hold for answer, Hold for proof, Credit hold

New in SOSET Quick typeset 4.30:
- Registration of worked-seconds in TIME field in QJOB.DBF table
- Automatic condens in circular disabled.
- New option in PageWizard: Get all Web-entered stamps to verify stamps automatically imported via SOSET-
via-the-web site

New in SOSET Quick typeset 4.29:
- Add spaces between the characters when the textline is too small in comparison to the stamp width

New in SOSET typeset 4.29:
- Ascenders in the first line of the stamp will affect the resizing of the stamp
- Assigning the status 'Template' will result in saving the image in the SOSET template directory in jpg format
- Advanced cropmarks
- Color separation, each color will be printed on a separate page
- New status to support entry via SOSET-via-the-web: Preview (when customers has a preview but still needs to 
submit) and Web-entry (after submit; stamp is ready for proofreading). Keep in mind that proofreading is not 
necessary, as customer does his own typesetting via the web-site. However you need to verify that customer 
does not orderstamps for fraude type purposes, also to check if there is no infringement with copyright 
regulations. Further you can check if customer has added a comment to the design, which might require some 
correction by your own staff. 
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New in SOSET order-entry 2.37:
- Search on purchaseID in the productscreen
- Financial export to Sigec format
- Pad change option. By pressing the right mouse button on the orderitem you can specify a pad change.

New in SOSET Quick typeset 4.28:
-To comply with ISO-standards and in order to control customer-service a complaint option has been added to 
the quick typeset screen. Specify your own complaint-options in the Complnt-table and choose from the 
available options in case of complaints.
- During correction entry it is now possible to use the uppercast and lowercast shortcuts

New in SOSET typeset 4.28:
- Remakes in Pagewizard will appear on a separate page
- Remake 'Many mistakes in order' added

New in SOSET order-entry 2.36:
- Remake 'Many mistakes in order' added
- All customer group settings will now be copied to the customer
- Changing orderstatus to 'Shipped' and changing from 'Shipped' to 'In production' will empty the boxnr of the 
orderitems

New in SOSET Quick typeset 4.27:
-During correction of an entry it is now also possible to copy and paste text.
-The properties bar will now also be updated during a correction.

New in SOSET order-entry 2.35:
-New option: When pressing the right mouse button on a order, a Show info... button is added. 
This will open a dialogue which will show the sales price, purchase price, and also the difference between them 
in standard currency and in percents.

New in SOSET typeset 4.26:
-Better Font handling for special characters
-A new Files.dbf will be generated every time NamoSys starts.
-Printing mirrored/negative option in PageWizard has been improved.
-Typeset now also supports long file names for Windows Meta Files (WMF).

New in SOSET order-entry 2.34:
-There now is a sales history available in the customer and product screen. Here you can acquire information 
about the sales history from the last 10 years.
-New button: To open a cash drawer in OrderEntry. (Note: This option can only be activated by NamoSoft BV 
on request)
-New history option: User-activity registration

New in SOSET typeset 4.25:
-Now when using font styles with text lines that contain different fonts and/or sizes, the font and size of each 
font will stay the same.
-New remake option: Wrong price and wrong discount.
-bugfix: Better handling of the open file dialogue when opening logos

http://www.namosoft.nl/readme.htm (8 of 30) [10-Jul-2002 11:51:39 AM]

http://www.namosoft.nl/DETAILS.HTM#15


readme

-Full Color support: for all objects and text-element a color can be specified and will be printed accordingly
-bugfix in PageWizard: during a save of page-information the generation of pagenumbers causes an overwrite 
in existing numbers. This has been fixed.
-A new image-engine has been installed to improve image-processing

New in SOSET order-entry 2.33:
-New remake option: Wrong price and wrong discount.
-Shipping costs can now be set per region
-The stock will now always be updated, even when the re-order level is <1
-History totals per month will be saved in the histtot.dbf for faster data handling
-Scrollbars have been added to the internal and external memofields in the order dialog. Readable during all 
modes.
-Tax charge has been modified to allow tax-over-tax charge (YES, some countries have this!). This option can 
be set in the Maintain, Tax-dialog
-Weight name (KILO, GRAM, OUNCE etc)  preference can be set in the general preferences
-The missing update of the Sales_YR0-9 field in the customergroup: 'Empty' has been implemented.

New in SOSET typeset 4.23:
-Improved option in PageWizard: Multiple undo that goes up to 10 times back
-Improved option in PageWizard: When using the option Change vulcanize factor, some stamps on the same 
page were duplicated, some were skipped
-When importing more than 999 stamps, the action will be aborted and a dialog will notify that you have 
imported the maximum amount of stamps
-In case the proofprint box is selected in OrderEntry, Typeset will generate a proofprint when using the option 
change status on runno.> to corrected.
-bugfix in PageWizard: When two stamps with the same orderno. and partno are placed on two different pages, 
and one of the pages is deleted, PageWizard will NOT print a run card to the printer.
-bugfix: Some fonts (like: Brush script) do not support characters like ü
-Improved option in PageWizard: Remakes are shown on proofprint with bold characters for better overview 

New in SOSET order-entry 2.32:
-You can now also change the shipping date of an invoiced order
-The invoicable order list is now show as a summary like other lists
-If a customer places an order and ships it to different customers, he will get one shipment label per customer
-Version number, date and time are now shown in the About box
-Labelnumber information is now also printed on packing lists
-Packing lists will also show the price in Euro
-The SOSET data and license path will be saved in the SOSET ini files when starting a SOSET program
-When updating an order the productsize of the stamp will be set by customer group and product number 
instead of just the product number.
-Internal information of stamp will now always be copied to stamp in Typeset, not only when an order is made
-New option to set the currency in the customer group, and a checkbox with the option: Do not overwrite 
currency settings
-When entering and looking up a shipping address, you can also view a list of addresses with the new browse 
option

New in SOSET typeset 4.21:
-Shortcut for entry direction swap (e.g. for use with Arabic/Hebrew text from right to left).
-Better GDI resource handling
-When making/duplicating a stamp don't change the color when the product doesn't change in the dialog
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-There is an extra space between the customer id and customer info for better screen layout
-Logos with long names (more than 30 characters) will cause a General Protection Fault
-bugfix: When the option "Resize stamp to original logo size" was used, the logo size was set to 0
-Status remake has two new options: Wrong address and Wrong logo
-New option in PageWizard: Drag stamps in straight horizontal and vertical movement by holding down the shift 
button
-When "changing status on runnumber" proofprints will be generated

New in SOSET Quick typeset 4.21:
-When duplicating a stamp the quantity will be set to 1
-bugfix: When pasting an address in the address combombox the old address appeared
-For viewing templates JPEG images now are being used instead of tiff images for better resolutions

New in SOSET order-entry 2.31:
-The default button in the shipment run dialog is now set to "cancel" to avoid accidentally starting the shipment 
run.
-All lists in dialogs have now a new look and better handling
-After restoring invoice/shipmentrun the message "Invoice/shipmentrun restored correctly" will be displayed
-When adding or editing an account in the Chart of Accounts dialog a, new field is added beneath the Account 
ID called Remote Account ID
-New Remake-options: Wrong address, Wrong logo, lost intern, lost extern
-Ordernumber can't be changed in edit mode, only when a new order is made
-In the complaint dialog an option to attach a file is added
-An Embargo counter is added next to the Embargo status in the customer screen
-When adding a new orderitem the search dialog will show the product list with also the contract-price of a 
product

New in SOSET typeset 4.2:
-Repaginate option in SOSET Pagewizard
-transparancy option for images in image-dialog
-customer-group code is copied from order entry to get 'customized' product definitions
-Preferred logopath can now be specified in pref-settings.
-Detailed quantity specification on runcards
-Bar-code on runcard has now quantity-code for automatic registration and improved check of finished quantity
-Choosing Remake-status and quantity>1 prompts for question how many remakes?
-Automatic option to have maximum molds on layout in PageWizard
-'Page per colour' can be checked in 'Get corrected' run in PageWizard
-Export of seal will export both die and counter data
-new shortcuts in PageWizard: Home, End, PgUp, PgDn, Ctrl+A
-Title data change after Undo in PageWizard
-Option Cutting lines in PageWizard to disable cutting lines printing. In this way the layout can also be    used 
for production via polymeer instead of via laser only.
-Auto-rotation in PageWizard now also available for designs with logo's.

New in SOSET Quick typeset 4.2:
-Auto-delete option for the Qjob-table. Period is specified in pref-settings.
-Days-in registration.
-Template option in JPEG or TIF can be specified in pref-settings.
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New in SOSET order-entry 2.3:
-ATTENTION: the inventory related fields in the Product table are NOT IN USE any more (they are still there for 
backjward compatibility!) they have been copied into the Pur-Prod table (purchase product).
-AccIdRem field has been added to InvData table. This allows support for various account-tables in multi-
company setup.
-Until date field added to Orders, Reports, Outstanding orders option. In this way recent orders can be excluded 
from rpinting.
-Search on CustomerID is now search in upper characters. (Only important if alfa-numeric ID's are in use)
-Advanced Shipping Notice are automatically generated during a shipment run. The file can be used to inform 
customers up front about an incoming shipment.Filename: XXXXXX.ASN (Shipment-number + ASN extension).
-Option to dump shipment data in CSV-format per shipper. (can be used for interfacing with UPS, FedEx etc)
-Pre Assigned Boxnumber (PAB) in customer screen allows to specify a boxnumber for a customer.
-Time-entered field has been added to OrdMain-table. 
-New Remake-options: Customer error, Customer-service error, Shipping error, Burned in laser-engraver
-Summarized invoice option in invoice-dialog in customer (and customer group) screen. With this option you will 
have order-totals only on e.g. batch-invoices.
-Maintain, Purchase products for maintaining the purchase product table.
-Maintain, Users for maintaining the user table.
-Improved grid-layout from history reports.
-Orders, Taks, Print labels from customer-to customer option
-Product change will check 2nd description and will prompt for replacing 
-Search on purchase product in product screen.
-Standardized reference-1 option in order-screen, reference dialog.
-Image-option (e.g. for Pastage paid image) per shipper via Maintain, Shipper
-Quotation orders are now excluded from order-overviews; quotation oevrview has been added to report-
options.
-Rush-order overview specifies PageWizard status
-Option: 'Copy discount-ID to customer' has been added to customer-group screen. This allows different 
discounts within a customer-group.
-Contract-price option has been added in the product-screen. These prices can be specified per customerID 
and are stored in the new Contract-table. 
-Wildsearch in product-table from various dialogs for search within product-description fields.

New in SOSET typeset 4.16:
-Vulcanise option in SOSET Pagewizard has been added. 
-Fix: better specification of quantity on run cards in case of multiple stamp orders on several pages.  (e.g. 2 of 4 
etc) a few new remake specifications have been added:
 -Laser engraver error
 -Air in polymer
 -Customer error
 -Customer service error
 -Shipping error
 -Burned in laser engraver

New in SOSET Quick typeset 4.16:
-Automatic deletion of stamp records in (temporary) Qjob-table after X days (days can be specified via 
preference-settings.
-Print option of dispatch note per record. Select note from note-table.
-registration of amount of days (minus: Saturday and Sunday!) in DaysIn field
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New in SOSET order-entry 2.21a:
-Extended search option for purchase products in product dialog screen
-BUG FIX: city name now also available in correct format for use in U.K.
-FIX: Pre Assigned Box number on run cards
-Option to specify Postage Paid image (in TIFF-format) for shipping labels, this can be specified for each 
shipper via Shipper-table options.
-Option to dump shipment data in CSV-format per shipper. (can be used for interfacing with UPS, FedEx etc)

New in SOSET typeset 4.15:
-Transparent option in logo-image dialog. This enables overlapping logos.
-Bug fix: Compression sometimes behaved strange, due to rounding problems.
-Bug fix: inches are now in 3 decimals, which offers more accuracy.
-While exporting a stamp-design, not only the die, but also the counter of a seal is exported.
-Searching on a part of a Customer ID added. E.g. searching on 14 will find all customers starting with 14.

New in SOSET order-entry 2.21:
-Summarized invoice option added to customer- and CustGrp-settings. It is now possible to print only the order 
date, order number, ship date and amount per order. This option is especially designed to simplify batch-
invoices.
-Pre Assigned Boxnumber (PAB) added to customer-screen. If filled in, all items for a customer are 
automatically assigned to the specified box.
-To comply with ISO-standards and in order to control customer-service a complaint option has been added to 
the customer screen. Specify your own complaint-options in the Complnt-table (via NamoUtil, Browse) and 
choose from the available options in case of remake or other complaints.
-Wildsearch on product name 1 and 2.
-Printing labels within a range of customer ID.
-Payment information on invoices
-Generate a sales journal and a file (soset\temp\*.sal). This can be used to import in other program's.
-Searching on a part of a Customer ID added. E.g. searching on 14 will find all customers starting with 14.

New in SOSET typeset 4.14:
-Enumeration-problem (fonts disappear) has been fixed
-Alt-C option (change into Corrected) is disabled now in editmode
-drag down font and size menu
-image-dialog default path
-cutting of circular stamps now with 4 perforations
-numbering information on proofsheet

Link for information about previous updates of all SOSET software

6a EASIER DOWNLOADING AND INSTALLATION VIA OUR WEB-SITE WITH THE DOWNLOADWIZARD 
NOW AVAILABLE!
The latest versions of the SOSET software can soon be downloaded and installed with the DownloadWizard 
tool. This tool managess the download procedure. After your choice it finds necessary compressed files and will 
only send what you need and no more. In the event of a sudden interruption of the transmission of data, the 
setup will continue from the setup-position as it was before interruption.
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7 RUNNING NAMOKEY ON A WINDOWS NT SERVER
Running Namokey on a Windows NT server requires a special protection key driver. This setupx86.exe is 
provided in the Sentinel/Win_Nt directory on the SOSET distribution CD-ROM.You can also download this 
program via download sentineldrv.zip at our web-site.
To install the software protectionkey driver, startup the "SetupX86.exe" and select "Functions menu > Install 
sentinel driver". Keep the default driver path and press OK.
After the driver is installed you will have to reboot your system.

8SOSET TYPESET 32-BITS AND OBJECT LINKING AND EMBEDDING (OLE)
In a Windows environment this is a protocol by which an object, such as a CorelDraw design, an Excel 
spreadsheet or a Word document, can be embedded in a SOSET stamp design. With this technique a copy of 
an object from one application into another can be made. Once the copy is embedded, it has no further 
association with the object from which it was copied. If the original object changes, the embedded copy does 
not. Please refer to the information in the Windows help or the application-help.

9 IMAGE IMPORT FILE FORMATS IN SOSET TYPESET 32-BITS VERSION 4.00
The image options starting SOSET TYPESET 32-BITS VERSION 4.00 have been dramatically changed and 
exchanged with a more reliable and modern library. This library offers more and new formats. Unfortunately 
some of the formats are not available, due to license-regulations. You can download the special 16-bits 
program image.exe which contains the "old" filters and can be used to convert the various file formats into a 
WMF-format for import into the new SOSET typeset. We also recommend to use the OLE-options to link 3rd 
party application-designs to a SOSET typeset stamp. Please find the available formats in the 
http://www.namosoft.nl/format.htm page from our web-site.
Note: not all options might have been implemented yet, please contact our support department for a current 
status.
Note: if a WMF-file with a placeble header is imported, the SOSET programs and Image.exe convert the file and 
remove the header, in order to improve performance and quality. The old file is saved in the same directory with 
the extension: WM_.

10 SOSET ORDER ENTRY CURRENCY OPTIONS
With the upcoming introduction of the Euro-currency a currency-option is available in SOSET order entry.This 
option enable simple and correct invoicing in foreign currency. some simple guidelines:

-The SOSET order entry software comes with a currency table.
-First you need to edit this table with the option: Maintain Currency table where you enter the exchange rates of 
the different currencies. (from bank or internet listings). You can also use the NamoUtil browse option to do this. 
(For correct functioning and calculation you should update the exchange rates in the CURRENCY-table 
frequently!)
(We now have special web-tools to simplify this!)
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-In the preferences you select the default currency for your country and/or company. EMU-countries also select 
the Euro-currency-identfier. 
WARNING: Once you have chosen this currency you should NOT change it, unless you change ALL 
value fields in ALL tables into the newly chosen currency!
-In the More section of the customerscreen you can select a Foreign Currency. This will be the default currency 
for this customer. Packinglists and invoices will be calculated printed in that Currency.
-Order entry is done via the Default Currency screen, but the default screen is the Foreign Currency screen. An 
option is in prepartion to enable entry in this Foreign Currency screen also.
-With the F11 button on the keyboard you can toggle between the screen with the Default Currency and the 
Euro Currency. (Title and colour change!)
-With the F12 button on the keyboard you can toggle between the screen with the Default Currency and the 
Foreign Currency. (Title and colour change!)
-All printaction from within the Foreign Currency order-screen will result in output in the chosen Foreign 
Currency.
-During invoicing the postings for accounting in the INVDATA and INVDATAL are ALWAYS calculated in the 
Default Currency.
-IMPORTANT: ALL values and totals in the customerscreen and listings, history-overviews are ALWAYS in the 
Default Currency.
AGAIN: changing of the Default Currency in the Preference-setting might have dramatic consequences 
and should be used with extreme caution.
In case you need to do so (e.g. change to the Euro in 2002) we recommend to contact NamoSoft support for 
the latest advise. 
Order now the Euro-conversion module to rebuild all SOSET tables with Euro-values. This module has to be 
ordered with the special Euromodule-orderform.

11 SOLUTION FOR CODEBASE -200 -83805 ERROR Novell network error: Message: "Codebase Error Error 
#: -200 Error #: 83805 File is not a datafile database corruption detected drive:\...\...\*.DBF drive:\...\...\*.DBF"
This message can occur when you work with Windows 95 and/or Windows NT in combination with a Novell 
network. There is no serious damage known, caused by this error.
-- Work around --Recent tests have brought a solution in a Novell-Windows95 network environment:Create and 
move the license path from the shared Novell network drive to a shared Windows95 disk on one of the stations.
-- LATEST NEWS Solution --Install intraNetWare Client from Novell.Instead of using Client for NetWare 
networks (included with Windows 3.xx and Windows 95), we recommend to install the Novell intraNetWare 
Client32 for Windows to get connected to a Novell fileserver. Running the setup from the Novell patch will 
automatically remove the Microsoft client for NetWare networks and replace it with IntraNetWare Client.You 
then need to restart Windows for the changes to take affect.

For this Novell Software you can contact your Novell supplier or download it via Novell-website page 
http://support.novell.com/products. Under the section heading you will find: 'NetWare Operating Systems' For 
more information about the Novell Client32 visit Novell-website page: http://netware.novell.com/clients 
Note: IntraNetWare client32 does not work with File and Printer sharing for NetWare networks. 

12 SOSET AND DATABASE-PROBLEMS IN A WINDOWS NT4.0 SERVER + MS-NETWORK+ WIN95 
WORKSTATIONS Windows NT server and Windows 95 stations error
There is a known Windows 95 / Windows NT buffering problem, where Windows 95 workstations that open files 
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shared from Windows NT machines have problems with buffering. This is caused by a corrupted Virtual 
Network Redirector (VREDIR.VXD version in the Windows-system directory).There is now a new VREDIR.VXD 
for Windows 95 that does disable the buffering of files shared on Windows NT. The redirector executable is a 
self installing program provided by Microsoft. Run it under Windows 95 and it installs itself and makes the 
needed changes to your Windows registry. You then need to restart Windows 95 for the changes to take affect. 
The new redirector has been tested by NamoSoft and does indeed solve the problems with data reliability 
between a Windows 95 workstation and an NT server. This redirector is not needed if accessing data on a 
Netware server, however, installing the new redirector will have no detrimental affects on sites not using NT 
servers. Thus, our general recommendation would be to use the new redirector at all customer sites.
IMPORTANT: Microsoft provides several versions of this VREDIR.VXD. Only the version as available via our 
web-site, has been tested (by Microsoft) to solve typical database-problems!
You can also download the latest version of VREDIR.VXD (300 Kb) via our web-site.
After the download you can click on the self extractable file; follow the instructions during the extraction 
procedure. You can also contact us for more information.

13 WINDOWS NT SERVER PROTECTION KEY ERROR
There is a known problem in Windows NT 4.0 to read the hardware protectionkey(s). This may cause Namokey 
to open up very slowly or to disable Namokey to read information from the protectionkey. There is now available 
Windows NT 4.0 Service Pack 3. After installation this problem will be solved. You can get more and updated 
information about the this Service Pack on the Internet from: http://www.microsoft.com/ntserver
If you have our software protection key with brandname Sentinel; only (white keys) you can work around the 
problem by following the next steps: - Add to namokey.ini in the windows dir: Wizzkey=0 - Add to 
namosys.ini, pagewiz.ini and typeset.ini in the windows dir: Start Namokey=0 Now Windows NT server and 
Windows NT workstations will start at normal speed.
Running Namokey on a Windows NT server this requires a special protection key driver. This setupx86.exe 
is provided in the Sentinel/Win_Nt directory on the SOSET distribution CD-ROM.You can also download this 
program via download setupx86.exe at our web-site.
Note: When using this option NamoKey will NOT start automatically when starting another SOSET program so 
make sure NamoKey is allready running when you want to use SOSET. 

14 MORE UTILITIES IN NAMOUTIL PROGRAM version 2.5
This item has been moved to the readme-archive

14a New reindexing option in NamoUtil 5.0
This item has been moved to the readme-archive

15 OPOS PRINTERS
SOSET order entry allows you to select in the printer preferences the output to so called OPOS thermal printers 
on 78 mm wide endless paper. These point-of-sale printers are very useful for situations where large volumes of 
run cards and packing slips etc. need to be printed. They can handle this at high speed with minimum 
maintenance.They do not come with a Windows compatible driver and therefore you can only use the model 
'TM T88P' from Epson. Please refer to your local supplier for more information about this printer.
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16 
New in SOSET typeset 4.10:
-the cutting of rubber-stamps with the M&R laser engraver has been improved. The remaining parts after cutting 
have been reduced and results in improved fixation to enable better cleaning.
-CAP computer aided proofreading: double entry with automatic control to check and correct first entry. (Faster 
and more accurate than any other proofing method!)
-Sub-status options for In Production: Film, Laser, Inking, Drying, Cutting, Mounting, Packing (useful in host-
remote situations)
-Deskew, a new image option for automatic positioning of angled images.
-New Image options: rotate, flip, reverse (mirroring), invert (negative), shear
-New Go to options: Back, Forward, 5 last edited orders
-New designed list-boxes
-Print option in list-boxes
-Order-number ranges for remote users can now be specified in Namosys, Browse, User table.
-There is now a shortcut: Ctrl+J for the Export to TIFF in typeset and page wizard program.
-Pin-level improvements
-Center all textlines improved
-Separator specification in PageWizard to set a fix distance between stamps in the PageWizard. This separator 
value comes in addition to the unprintable margin value, which specifies the amount of free space around the 
text in relation to the maximum sizes as specified by the manufacturer.
-Options, Cutting switch in PageWizard to allow production of (original) stamps with laser-cutting lines in e.g. 
polymer. This switch takes the lines out.

New in SOSET typeset 4.00:
32-bits version 3.3 is latest 16-bit version; 4.0 is next version only for 32-bits environment
-date fields accept Windows environment settings
-carry on question on new entry with same ordernumber
-search on customer info 
-PageWizard selection by CustomerInfo
-alt+H option until next Tab-position
-improved pin-code level system
-improved link between order entry and typeset
-automatic double line option
-scaling/shrinkage option for pre-inked has been added in the PrintSet dialog 
-updating production-status after laser engraving
-lines definition in printset to identify plate-sizes in PW
-improved seal-engraving support with negative stamp-record (female only NOW possible!)
-lasercutting switch to enable printing instead of laser-engraving
-multiple laser check. Per 1 license SOSET is only 1 M&R laser possible.
-bold, italic, underline buttons and underline, strikethrough options in font-dialog
-scroll buttons
-double line option in object dialogs
-OLE support object linking
-multiple undo
-2000 cool-look
-auto rotate feature in PageWizard
-right mouse click support
-memo from order entry to typeset
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17 information of previous updates of SOSET order-entry
This item has been moved to the readme-archive

18 AUTOMATIC DOWNLOAD OF EMERGENCY CODE
This service has been cancelled.

19 IMPROVED AND NEW OPTIONS FOR THE M&R LASER ENGRAVER
This item has been moved to the readme-archive 

20 GENERAL SETUP NOTES

CHECKING YOUR SOSET PACKAGE
Your SOSET software package should contain the following items: SOSET CD-ROM (in the Getting Started 
booklet), 1 SOSET Getting started, 1 SOSET Tutorial, 1 SOSET software protection key (for each SOSET 
program) If any item is missing, check with the person from whom you purchased SOSET Typeset.
Note: the SOSET CD-ROM is only compatible to CD-ROM players of 12 speed or less.

SOSET in a NETWORK
Important A SOSET user is licenced by buying the SOSET software. The special software protection key and 
its Namokey software will control the license.
The software protection key should be connected to one of the stations in a network-station, while running the 
Namokey software at the same time, to enable and to legalize the use of the SOSET software.

NETWORK PRINCIPALS
A workgroup is a group of people who share data in a multi-user environment (network). Users in a workgroup 
share the same workgroup database, which stores information about security restrictions and operating options. 
In order to use objects in secure databases, you must join the appropriate workgroup. In a network NamoSoft 
SOSET does entry and modifications in the same database on the shared directory in the network.
The software is designed to protect all work and users from a sharing violation. The software enables only 
writing to locked records. Reading is permitted to all users. In this way the most recent data remains up-to-date 
available to all users.

Important You can use SOSET software in the following networks:
- Microsoft Windows 95 (and/or Novell-network)
- Microsoft Windows for Workgroups (and/or Novell-network)
- Microsoft Windows NT (and/or Novell-network)

Check with your network administrator before setting up NamoSoft SOSET on a network server or in a shared 
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directory.The installation procedure for a multi-user version of the SOSET Typeset program should be repeated 
for each station on which you want to use it.The installation procedure will recognize already installed versions 
and will skip unneeded files/disks.

Note: Make sure that in a Novell network on each Novell network station you create or edit, a file called 
SHELL.CFG which contains the following line: FILE HANDLES 90 This file must be saved in the same directory 
from where you start the network drivers.

INSTALLATION of UPDATE/UPGRADE The installation of an update of SOSET software is controlled by the 
setup-procedure and this is very simple.
-To avoid license-check problems make sure that the system date of your computer is set correct and works 
without interruption.In a network you should check and write down the database-locations on the server-station
Note: Make sure that you have a backup of all SOSET-files. If you have versions 2.8 and before run CLIP2FOX 
program first. (In NamoUtil program under Tools menu) we recommend that you install the program files on a 
shared drive in the network. Updating/upgrading will count for all the stations in the network. 

This installation procedure will recognize an earlier installed version and will NOT overwrite datafiles, 
these will be automatically updated.

1. Start Windows
2. For udpate only: Ensure that there is no Soset software running.
3. Connect the software protection key (in your SOSET package) to either one of the parallel ports of your 
computer. (It is recommended to down the computer and turn off the power supply before connecting 
the software protection key and restart!)
4. For Windows 3.1x only: with a DOS-editor you add or edit the following lines in your CONFIG.SYS: FILES=90 
and BUFFERS=90.
5. Use this instruction only if you work on a network-station in a Windows network: Connect to the Windows 
network server. Make sure that you have enough rights to read, write, delete and create directories on the 
shared network drive.
6. Insert the CD-rom in the CD-ROM disk drive
7. Autorun will automatically start the SOSET setup. You also can choose Run from the File menu in the 
Windows Program Manager and choose setup from the CD-ROM.
8. Follow the set-up instructions on the screen and accept/enter one shared directory name for the SOSET 
database tables, one shared directory name for the SOSET program files and one shared directory name for 
the SOSET licenses.
9. In a network, where you have programs installed locally, this setup must be repeated on every workstation.
10. If the Set-up has been successful you should start the Namosys program to initialize your program and files.
11. After set-up a Supervisor pincode : 0000 gives access to all items
Please refer to the manual for additional setup information.

SETUP in a WINDOWS 95 ENVIRONMENT
A near future release of a 32-bit version of SOSET TYPESET will use full power of the Windows 95/98 and NT 
versions. The SOSET Order-Entry is only available in a 32-bit version.
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SETTING UP SOSET Order Entry 
ONLY if you use SOSET Typeset versions 2.8 and before and you want to install the SOSET Order Entry 
program as well, you need to run the conversion program Clip2Fox. This program will convert your current 
databases, which are in Clipper format, to the more modern and efficient FoxPro format. We recommend to 
contact NamoSoft BV for help with this conversion.

 

20a Multi-platform network
Difference in font-system in Windows 95-98-ME and Windows NT, 2000, XP

Due to a change in the font-properties between the Windows 95-98-ME and Windows NT, 2000, XP the font 
size and length of text might be wrongly interpreted when e.g. designed in a Windows NT-type environment and 
output via Windows95-98-ME.
This problem may happen in network- and interfacing situations. In general we recommend to have same 
environment on all stations in a network with SOSET software. 
Only with few fonts this problem might occur. Unfortunately as of yet there is no solution for this situation.
We recommend to use the same Windows environment for all stations in the network. Effected designs should 
be isolated and might need to be re-designed. Try to identify the fonts which cause this problem and report to 
Namosoft BV. Changing the font into a similar font might solve the problem right away.

21 TROUBLESHOOTING/ERRORS refer to the on-line help
The SOSET software alerts you to possible problems or conflicting conditions. The error messages that may 
appear are mostly self-explanatory. We have listed some of these messages followed by one or more solutions 
or explanations.

Setup errors:
Message: "SOSET detected a license error #051 or #52; date" The setup procedures tried to install files and 
settings, but could not open tables or files exclusively. This indicates that the tables are in use by other users or 
applications.

Message: "SOSET detected a license error #026; date" Normally this indicates that your license has been 
expired; check the date in the Namokey-program under: File, Software Protection key.Another cause for this 
error is that the date of your system is not correct and probably changed after or during Soset operation.This 
might be caused by an empty system-battery in your system or that the date is set forward or backward after 
Soset execution. Contact your hardware supplier to check the battery. The license procedures in the SOSET 
NamoKey software require correct date and time information.To continue working immediately you should set 
the date of your system back to the date as mentioned in the error-message. In that case you need to control 
the date until the date of the error message is the same as the current date.It is also possible that the 
system.dbf table and/or some so called *.ini have been damaged. Please contact NamoSoft if you need further 
assistance.

Message: "SOSET detected a license error #027 until #041, ; date" Normally this indicates that your license has 
been expired; check the date in the Namokey-program under: File, Software Protection key. Another cause for 
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this error is that the date of your system is not correct and probably changed after or during Soset operation. 
This might be caused by an empty system-battery in your system or that the date is set forward or backward 
after Soset execution. This might also indicate serious checksum-problems in various Soset initializing files. 
Check your harddisk with the Windows System Agent for data-errors. You also should contact your hardware 
supplier to check the battery.It is also possible that the system.dbf table and/or some so called *.ini have been 
damaged.The license procedures in the SOSET NamoKey software require correct date and time 
information.Please contact NamoSoft if you need further assistance.

Message: "Internal check error #101: Contact NamoSoft (OrderEntry)"
Message: "Internal check error #111: Contact NamoSoft (Typeset Gold)"
Message: "Internal check error #121: Contact NamoSoft (Typeset Gold M&R)"
Message: "Internal check error #131: Contact NamoSoft (Typeset Silver)"
Message: "Internal check error #141: Contact NamoSoft (Typeset Silver M&R)"
Message: "Internal check error #151: Contact NamoSoft (Typeset Remote)"
Message: "Internal check error #161: Contact NamoSoft (Typeset Quick)"
Message: "Internal check error #171: Contact NamoSoft (Typeset Quick M&R)"
These messages indicate a version conflict. Your license is limited to a lower version than the one you have 
started. An update or upgrade is advisable.
Please contact NamoSoft if you need further assistance.

Message: Internal check error #0: Contact NamoSoft
Wrong license-check for SOSET Order-Entry Software

Message: Internal check error # x: Contact NamoSoft
Wrong license-check for SOSET Typeset. Thess errors might indicate serious checksum-problems in various 
Soset initializing and licensing files. It is recommended to check your harddisk with the Windows System Agent 
for data-errors.Please contact NamoSoft if you need further assistance.

Message: "No SOSET license path" or "No SOSET data path"
In the SOSET folder you can view the properties per program (in Windows95). Click the right mouse button and 
select Properties'. Select Shortcut' and view the target line': from left to right it should read the SOSET program 
path (drive\DATA\SOSET\programname.EXE), the SOSET DataPath (drive\DATA\SOSET) and the SOSET 
LicensePath (drive\DATA\LICENSE).
You can specify the SOSET DataPath also in the Preferences from the File menu in Namokey. The SOSET 
Path refers to where the Namokey software will find license information. 

Message: "Unable to open license table"
This message refers to the linkage between the license control and the Namokey software program. You should 
start Namokey at the security station and keep it running for as long as you want to work in any SOSET 
program. Make sure the software protection key is connected to this computer.

Message: "No license available"
You have exceeded the total number of licensed users. This can be caused also by abnormal program-
termination, where the Namokey program did not get any log-off information and did not release the user. You 
can clear this by using the option: File, Current connections, Clear all. (Namokey is designed in such a way that 
you may always clear users, even if, in a network, other users are still working in Soset; Namokey will register 
the users again.) Another explanation here is that your license has been expired. If that is the case you can 
check the software protection key option from the File menu in Namokey.
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Message: "Too few filehandles"
While working in SOSET OrderEntry some 50 files are opened to ensure immediate access to the SOSET 
Database tables. SOSET checks the file-capacity and will warn if this is too low. If this problem occurs when 
working with a Windows NT server and Windows95 clients, here is your solution: In your CONFIG.SYS the 
number of files is stated. Increase the default value here, e.g. FILES=125. In case you are working in a Novell 
network with 3.1x Windows clients, the solution is: In your SHELL.CFG the number of files is stated. Increase 
the default value here, e.g. FILES=125.

Compatibility error
Recently NamoSoft BV has started selling the SOSET software programs not only on disk, but also on CD-
ROM. The SOSET CD-ROM is compatible with any CD-ROM player up until 12th speed. This means that the 
SOSET CD-ROM cannot be read by CD-ROM players with a speed over 12. If this problem occurs, please 
contact NamoSoft BV to work out a solution.

Installation error:
As a result of an installation error, is it possible that the Typeset button on the toolbar in SOSET Order Entry 
does not function properly. This button facilitates switching between SOSET Typeset and Order Entry. If that is 
the case, you should do the following:In the Windows directory you search for the file TYPESET.INI. This 
Windows directory could be, e.g. C:\WINDOWS. You double-click the file to open it. in this file the defaults are 
summed up. The SOSET ProgramPath should be referring to the directory where the TYPESET.EXE is saved. 
An example is: C:\APPS\SOSET\. You can view the ProgramPath in the Preference settings from the File menu 
in SOSET Typeset. Besides in Windows95 you can see the ProgramPath when you right-click on the Typeset 
icon in the SOSET folder and select Properties. Then you choose 'Shortcut' and in the Target line you can view 
the SOSET ProgramPath, the SOSET DataPath and the SOSET LicensePath.

WindowsNT server and Windows95 stations error 
Windows NT network error:
Message: "Codebase Error
Error #: -200
Error #: 83805
File is not a datafile
database corruption detected
drive:\...\...\PAGE.DBF
drive:\...\...\PAGE.DBF"
"SOSET detected a fatal error during initializing: Error code."

"General Protection Fault Error"
Please refer to sections in previous readme versions (on CD-ROM) or contact NamoSoft.

Problems with user connections In case of an abnormal program termination, e.g. a power outage, or program 
crash, the following situation can occur. There are still active users according to SOSET, although there are 
actually no users currently connected. (You can view all active users in the Current connections option from the 
File menu in Namokey.) As a result Namokey cannot be closed and the SOSET software cannot be exited 
properly.

Message: "Unable to terminate NamoKey. X SOSET user(s) connected".
Use the Clear all-button in the Current connections option from the File menu in Namokey. SOSET will 
disconnect all users that were still connected, according to the SOSET system.
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Message: "ISGDI9.DLL error or no images in Soset typeset"
As a result of an installation error you might not see imported images anymore in Soset typeset. The following 
message can appear on starting Typeset: "ISGDI9.DLL not in specified directory." This file is set by default on 
installing SOSET. Follow the next instructions to solve the problem. In the Windows System directory (e.g. 
\WINDOWS\SYSTEM) you locate the file, named: ISVB.INI. The last line of this file contains the following:

[ImageStream Graphics Filters - Interface]
Interface=Drive:\APPS\SOSET\FILTERS\isgdi9.dll

Check the datapath. When you have changed something during installation, like the default path, this could 
mean that the *.DLL file can not be found. You have to locate this isgdi9.DLL file (use the Find file Windows 
option). Then write down the correct path to this file in the last line of the ISVB.INI file in the Windows System 
directory. Save the changes made to the ISVB.INI file.

Message: "Codebase Error -920"
Message: "Codebase Error 95905"
Message: "Out of memory"
In case one of these messages appears on your screen, you should check the free diskspace on the Server or 
the Datapath drive.

SOFTWARE PROTECTION KEY ERRORS
Message: "Insert security key in one of the parallel ports" or "Image Read Error"
You need a Software protection key per program to legalize the use of the SOSET software.This key must be 
connected to one of the parallel ports of your computer in case you have a single user version of the software. 
A multi user version of the SOSET software requires just as the single user version, only one Software 
Protection Key per SOSET application connected to the network server in a Windows network. In case of 
abnormal program termination, e.g. power problems, licenses may be limited. Use the Clear all-option from the 
Current Connections File menu option in the Namokey program to free all licenses and clear all users. All 
SOSET users should have enough rights to read, write, delete and create directories in the specified directory.

22 DRIVER FOR LASER ENGRAVER 

 

23 SUPPORT CENTER FOR USA AND CANADA
For support and training on Soset please contact: 

mr. Bruce Hale at GRANITE STATE STAMPS, INC.
566 Harvey Road, PO Box 5252
Manchester, New Hampshire 03108
Phone: (603) 669-9322
Fax: (603) 624-9199
E-mail: rbhale@aol.com 
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You can always call, fax or E-mail directly to NamoSoft B.V. (Venlo, The Netherlands).

24 COMMUNICATION SOFTWARE and MODEM SUPPORT
We advise you to have the PC AnyWhere32 (latest version) from Norton for communication and modem-
support with NamoSoft.
Install the PC-AnyWhere32 software at your PC.To enable NamoSoft support first call or fax NamoSoft to make 
sure that a modem-line is available.

-start PC-AnyWhere
-select Be a host PC
-select the Modem icon
-make sure that the setting: Launch Host is activated-from the menu you select : Action, Connect and enter 
NamoSoft Modem Phone-number: +31-77-3518942(or ISDN-digital modem: +31-77-3514836)
-NamoSoft will take over control of your PC and can do support, file transfer andother required activities.
-NamoSoft will end the connection.Be advised that, in accordance to our terms and conditions, NamoSoft does 
not accept any liability for damage resulting from the use of products and/or support delivered by NamoSoft 
B.V.Please read the terms and conditions to know more about this.

We also recommend to have Windows Terminal Services or MS-Netmeeting installed. These services use 
existing Internet connections. In this way an optimum, cost-efficient and fast support possible.

MANUAL and ON-LINE HELP
As the use of help-files becomes more and more popular and usefull, we have decided that we will only include 
a Getting started and Tutorial manual in the SOSET software package. This also reduces environmental 
pollution
You can find further documents in the sub-directory DOCUMENT on the SOSET CD-rom. Most of this 
information may be opened, modified and printed from Wordpad or MS Word 6.X and higher version.

You can download the latest and most up-to-date help file in ftp.namosoft.nl/download/soset98.chm  
Click here for a PDF-version of the SOSET help.
See the NewHelp page for more information.

26 DOWNLOADING FILES FROM E-MAIL
When you download files form E-mail there might be a file connected to the mail. If this is the case be sure that 
the settings of your Internet- browser is set as follows: Attachments as Link (in Netscape you can find this 
option in the View menu in the Netscape Mail windows). This setting present the attached file as a icon. Double 
click this icon to save the file.In case our e-mail is split in separate parts; you need to change a setting in your e-
mail properties, in the send section you will find an option: Break apart messages larger than. 
The value needs to be at least 100Kb.
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27 IMPROVED PIN-CODE LEVEL PROTECTION
All users of the SOSET-software need a pin-code in order to get access to several functions.These pin-codes 
enable you to track user-information and to protect the SOSET-data with restricted use. In the NamoSys 
program you will find the browse user table option. This allows a SOSET-supervisor to add, edit or delete users 
for the Soset program. The level attached to the pin-code can vary from 0 to 9. A higher level (of course) gives 
access to more critical functions and can be used to overrule a low-level pin-code. These functions can be 
specified as follows:

level 9 allows unrestricted access to ALL Soset functions
level 8 Access to Maintain functions, access to Namosys functions, Restore Shipment run, Restore Invoice run, 
Exit NamoKey, edit of global preferences
level 7 reserved for future use
level 6 allows invoicing,history and sales reports
level 5 allows editing Order, Customer and Product-data
level 4 allows Shipping options,Typeset delete, PageWizard functions
level 3 access to all Typeset options
level 2 view options in Typeset options
level 1 reserved for future use

28 DIFFERENCES BETWEEN SOSET Silver/Gold OVERVIEW
This item has been moved to the readme-archive

29 Packing option disabled
No more packing of SOSET tables!
Wrong usage of this option might cause corrupted database tables or massive loss of data.
The packing option in the NamoSys program has been disabled. This option is originally designed to reorganize 
files and to delete records with deletion marks to create space. Packing takes away the option to check 
deleted records and restore deleted data in order to solve occurred problems.
Instead we recommend to contact NamoSoft for help with reorganizing files and records.

30 Fix for Open Logo Dialog
In some circumstances the Open Logo Dialog in Typeset does not function properly. This occurs under 
Window98 and using the Preview option. Till now we are unable to find the real cause of the problem.

If you experience a lot of problems using this dialog you can use the standard windows dialog instead to set 
logos into stamps. You do so by entering the next line in the Typeset.ini under the Default Settings section: 
Use Preview Dialog=0 

31 Information about engraving Logos on the RSX Laser
Engraving logos on the RSX Laser sometimes results in the full logo area being engraved. This despite the fact 
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that the stamps show up properly on screen and when send to a printer.

Below is a checklist of the issues you have to take under consideration if this error appears: 

●     Use the cable shipped with the machine. This cable has a built-in ferrite for noise suppression both to & 
from the engraver. 

●     See if your computer terminates the printer port according to IEEE1284 spec.
Some cheap parallel port cards or motherboards without proper termination may develop errors as the 
cable gets longer, because of reflections or capacitive coupling in the cable between adjacent data lines. 

●     Make sure the parallel port is set to "compatible" mode in the bios (on some motherboards, this may 
adjust the electrical termination of the parallel port to prevent reflections & bad data.) 

●     Buy an expensive cable, one that is shielded if you have to use a longer cable. A properly shielded 
cable can go farther. 

●     With any printer cable, try keeping it away from power cords if possible.
If you bring the cable near a monitor or a power supply cord data starts getting scrambled. 

●     A cable company named BELKIN makes many types of cables, and some more expensive ones that 
are 20' or 40' using low-capacitance cable. You might be able to find them on www.necx.com. Another 
company is DATA-SPEC. 

ULS manual excerpt:

32 SOSET order entry and typeset combination can now automatically generate an e-mail or fax to send 
a proof of a stamp-design
In the customer-group and the customer-data screen you will find the option: 'Send proof'. The setting is copied 
into each order. If this setting has been checked, SOSET will automatically send a proof of the stamp as soon 
as the status is changed into 'Corrected'.  The (typeset-) status is changed into: 'Proof' and the order-item is on 
hold. Also if the (typeset-) status is changed into 'Proof' manually, an e-mail or fax will be generated. If the e-
mail field is specified SOSET will send the JPEG-image by e-mail, otherwise the proof is faxed.
Note: this option requires support for the fax and e-mail option.

33 Copying SOSET files from CD-ROM to Harddisk
When copying files from CD-ROM to harddisk please note that those files are READ ONLY. In order to prevent 
SOSET errors, you should remove this attribute. This is done by opening the Explorer, select all copied files 
and/or directories (or go to the Edit menu> select all) in the right window of the Explorer, then rightclick (or go to 
the File menu> properties) and view the properties of the files and/or directories. Then uncheck the Read-only 
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Attribute. Click OK. 

34 FoxPro errors.
When Visual FoxPro pops up the following error message: Cannot locate the Microsoft Visual Foxpro support 
library, we advise to copy the new dynamics libraries (dll-files) into your windows\system directory.
You can download these DLL-files via from our ftp site
Note: For the installation of the latest NamoUtil.exe vs 7.2 new dynamics libraries (dll-files) are required. 

35 System requirements

To use the NamoSoft SOSET Software, you need: 

●     Windows 95 or higher or Windows NT system 
●     An IBM-compatible personal computer with Pentium is recommended 
●     A hard disk enough free space for a basic installation 
●     One 3.5" high-density disk drive 
●     A mouse or other compatible pointing device 
●     An VGA or compatible display (VGA or higher is recommended) 
●     64-128 megabytes of memory (RAM) 
●     TrueType version of all fonts to be used in SOSET Typeset 
●     Minimum of one laserprinter or laser engraver as outputdevice 
●     A Software protection key provided with your NamoSoft software package 

36 Correct statistical data from query on SOSET files
SOSET tables contain a lot of information. Some of these are for technical reasons, others for retrieving 
only.The best way to get information out of the SOSET tables is to use the report options from the various 
menus. 
Analysis with the query options offer a lot of flexibility, but might confuse if not correctly specified.There is e.g. 
some confusion about the CustGrp field in the OrderItem table. This field is used to get the correct link between 
the product table and order entry and typeset. It is very likely that the information product in the orderitem has a 
customer-group stored in the orderitem different from the customer. This is done for TECHNICAL reasons. 
However during postings to the history table the customergroup as specified in the customer-file is copied. This 
is done to get correct statistical information. 
Be advised that you use the history-table ONLY, if you want to retrieve statistical data. Contact our customer-
support at support@namosoft.nl for further help. With the latest version of NamoUtil we can prepare customized 
queries for your specific needs.

37 We have reorganized the menu-structure of the SOSET NamoUtil program
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All conversion, repair and clean tools have been moved from the SOSET Utils menu and Tools menu. You will 
find these options now in the SOSET Utils menu via submenu: Conversion and Repair and Clean.
Warning:
All these options have dramatic effect to the functioning of your SOSET system. They should only be used 
under the supervision of NamoSoft. A backup is required before performing any of these options.
For the installation of the latest NamoUtil.exe vs 7.2 new dynamics libraries (dll-files) are required.

38 SOSET Client/Server version. 
For heavy duty environments we recommend the SOSET Client/Server version *.
The definition of "Client/server", two computers having inherent intelligence are networked or inter-connected. 
Each computer runs a distinct portion of the same application. The result being that one computer, the "Server", 
provides a service to the other, the "Client".
In SOSET terms this means that all SOSET programs and tables are opened and used by a server, which in 
turn provides the requested data to the client.
This can dramatically decrease the network traffic.

*(Only for WindowsNT environment. A surcharge is applicable; refer to pricelist 
(http://www.namosoft.nl/pricelis.htm) for pricing.) 

 

39 Download of the SOSET typeset and order-entry 32 bits versions is available via our website 
http://www.namosoft.nl Before installation we recommend to have a backup of your previous setup. 
IMPORTANT if you have a network installation: Make sure you install the new version on all stations. Starting 
version 4.00 of SOSET typeset and version 2.00 of SOSET order-entry can read from earlier versions, but 
earlier versions can not read from these versions. If you have already installed theses versions, feel free to 
update at any moment with the executable-only download via the download pages 

IMPORTANT: SOSET typeset version 3.3 is the latest version for 16-bit environment, 4.0 is next version only 
for 32-bits environment (Windows95, 98 and NT).

 

40-Windows compatibility shortcut-changes!  
We have changed a few shortcut changes, in this way we want to comply with Windows standards.
Shortcuts are now:
-Copy      : Ctrl+C
-Cut        : Ctrl+X
-Paste     : Ctrl+V
-Undo      : Ctrl+Z
-Redo      : Ctrl+Y
-
The various existing links to these shortcuts in SOSET have been been redirected as follows:
-Compression     : Ctrl+Shift+C
-Status               : Ctrl+Shift+X
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-Vertikal align      : Ctrl+Shift+V
-Justify               : Alt+Shift+A or R or C or L or J
                         : Ctrl+Shift+A or R or C or L or J
-Y-position          : Ctrl+Shift+Y 

 

41 WizzKey hardware protection key no longer supported 
We have changed the NamoKey-license procedures and upgrade to a 32-bit version and we cannot longer 
support the hardware key of the type: WizzKey. 
Please check if you are using a so-called "WizzKey" hardware-key*, which is connected to the parallel port of 
your system. 
We recommend to replace this key with a newer version, otherwise you need to keep using the 16-bit version of 
the NamoKey program.
The 16-bit NamoKey version does, however not support all new license options for e.g. SOSET-via-the-web, 
SOSET typeset Quick and SOSET order entry multi company. 
Although there are no serious license problems found during testing, we ask to consider that in some situations 
we might not be able to help you out. Click here for the special orderform. 

*) the "older" type "WizzKey" can be recognised by colour: black and a KeyID>10000
The newer type "Sentinel" keys are white and have ID<10000 

 

42 Preparing the installation of SOSET REMOTE Typeset (Host side)
Create a remote.sos file. You do this in SOSET namosys> utilities> generate remote license file.
Although the min. and max. remote No. are not in use right now, it is required that these fields are filled in (8 
digits). The telephone number must be filled in to.
Copy the remote.sos to a floppy disk.
On the remote location you can now run setup to install the SOSET typeset remote (during setup you can 
choose "Remote Typeset").
Write down the license path which can be specified during setup
After setup you need to copy the remote.sos file from the floppy disk to the license path
When you create the remote.sos SOSET Namosys will automatically copy SOSET tables in the 
\data\soset\remote directory. You need to overwrite the demo tables on the remote side with these tables. This 
way you make sure that both you and the remote user have the same technical information in the database 
(e.g. color data, printset data, etc.).
Keep in mind that a remote version can't be used for production. The output is gray and cannot be recovered.
Per January 1, 2002 order-clicks need to be purchased and loaded into the NamoKey program to enable 
download from remote orders and typesetting. 

 

43 New state-of-the-art tools in SOSET-via-the-web
We are proud to announce that a new version of SosetWWW.exe is ready for download, featuring: 

●     Beta-version of chat-option with inter-active remote typesetting to better serve and assist customers 
●     Multi-language options have been implemented in all SOSET modules, this in order to fully comply with 
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the language options in SOSET-via-the-web. Unlimited use of languages is now possible!
With these options you can easily specify multiple language product-descriptions in your SOSET 
product-table and call the appropriate texts in the language, preferred by the web-visitor. 

●     automatic password by e-mail 
●     automatic registration after non-login session 
●     automatic address-layout depending on country specifications 
●     session control with SOSET-user-PIN to follow customer-activity inter-actively 
●     XML-tools have been added to the NamoUtil.exe, SOSET Options, Webtools. 
●     Web-reports have been added to the NamoUtil.exe, SOSET Options, Reports. Various reports will 

specify the amount and type of web-orders, stamps etc. 
●     Improved error and error-registration system 
●     There is a tool, which will allow you to automatically pick-up and use e.g. currency- and other data from 

3rd party web-sites fully automatically linked to your own SOSET-via-the-web-site. Please contact 
Namosoft for more information. 

●     Besides a few new features your special attention for the following:
This requires a few changes to your static htm-page data.
The pages Login.htm and Email.htm will become obsolete with the next update .
The required functionality plus extras have been built in into the SosetWWW-engine.
These changes will simplify the login and registration procedures for the user.
Advice to change links to the above pages accordingly. 

●     Login can now be called by: sosetwww.exe?PAGE=LOGIN 
●     Registration/email by the command: sosetwww.exe?PAGE=REGISTRATION 
●     Session by the command: sosetwww.exe?PAGE=SESSION 
●     Chat by the command: sosetwww.exe?PAGE=CHAT 
●     Pin login on web-site with SOSET PINcode by the command: sosetwww.exe?PAGE=PINLOGIN

Make sure to have the latest detailed instructions from the SOSET via the web document (available upon 
request)
We are convinced that these options will be another contribution to state-of-the-art performance of SOSET-via-
the-web. 

 

  43 Setting up a remote connection for help support

Netmeeting support requires the following  preliminaries: 

1.  Netmeeting 3.0 or higher needs to be installed (Please refer to 
http://www.microsoft.com/windows/netmeeting/ for the latest information about Netmeeting).
Also "Remote desktop sharing" needs to be installed and active (Tools > Remote desktop sharing).

2.  For Windows95/98/ME users: you need to supply us the password used for Netmeeting
For WindowsNT/2000/XP users: you need to create a user account. E.g. namosoft,  password: soset23

3.  A direct internet connection (NO firewall as we need a public IP number).
4.  You need to supply us with your IP address of your connection. You'll find the IP of the current 

connection in the Dailup connection properties of the active connection.

End of SOSET Readme Information.
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Help New

New help for SOSET software:

We offer now improved on-line help information.

The new SOSET-help is now completely HTML-based and offers more flexibility: 

●     Simply click on any of the menu's or icons in displayed screendumps and you get 
information about that item

●     Direct link to the NamoSoft web-site for the latest information
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Help New

Coming up: 

●     HTML help installation by the setup program.
●     Context-sensitive help enabling you to jump immediately to the subject you 

specified in the SOSET program.

Follow these steps for easy installation and setup: 

●     IMPORTANT: The Help Viewer requires that Microsoft Internet Explorer (version 
3.02 or later) is installed on your computer. However, it is not required that Internet 
Explorer is actually in use as the system's default browser, or that the Internet 
Explorer icon is visible on the user's desktop.
Click here to get the newest Microsoft Internet Explorer, 

●     You also need to install the HTML Help Viewer. To do so you can download the 
HTML Installation and Update package, Hhupd.exe from our ftp-site. The package 
consists of a self-extracting executable program that will set up the Help Viewer on 
a your computer or update an existing setup of the Help Viewer. 

●     Download the SOSET.chm help file.
●     SOSET HELP in PDF-format in downloadable and printable version

  
●     You can also view the SOSET help from our website. Note that this will only work 

with Internet Explorer 4.0 or higher.
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